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Working with Actuate BIRT Viewers provides users with information about using
Actuate BIRT Viewer and Actuate BIRT Interactive Viewer. This document
explains how to generate, view, and customize reports.

m  About Working with Actuate BIRT Viewers. This chapter provides an overview of
this document.

m  Part 1. Using Actuate BIRT Viewers. This part contains information about using
Actuate BIRT Viewer and Actuate BIRT Interactive Viewer.

m  Chapter 1. Introducing Actuate BIRT Viewers. This chapter introduces the
viewing environments for BIRT reports, and lists the modification capabilities
each environment provides. The chapter also compares Actuate BIRT Viewer
and Actuate BIRT Interactive Viewer.

m  Chapter 2. Navigating a report. This chapter describes how you can begin
working with reports by navigating a report page using the paging tool. The
chapter also explains how to use a table of contents, display parameter values,
work with hyperlinks, save a report, and print a report.

m  Chapter 3. Editing and formatting a report. This chapter describes the formatting
options in Interactive Viewer: formatting data columns and static text,
formatting various types of data, and applying conditional formatting.

m  Chapter 4. Exporting report data and content. This chapter describes the exporting
options in Interactive Viewer: exporting report data to various flat file formats,
and exporting report content to various formats such as AFP, Word,
PowerPoint, Excel, PostScript, PDF, or Extensible HTML.

m  Chapter 5. Organizing data in a report. This chapter discusses the functionality
Interactive Viewer provides for organizing data, such as sorting data, moving
columns, removing duplicate values, creating data groups, and so on. The
chapter also describes how you can perform aggregate calculations, and set
page breaks in a report.
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m  Chapter 6. Performing calculations in a report. This chapter describes how you
can insert calculated columns in a report and explains how to build
expressions and create custom expressions to create new computed columns.

m  Chapter 7. Filtering report data. This chapter discusses how you can use
Interactive Viewer to specify viewing parameter values, and create filters for
data in a report.

m  Chapter 8. Modifying charts. This chapter describes the types of charts in a
report and explains how you can modify them using Interactive Viewer. The
chapter provides procedures for changing the subtype and formatting of a
chart, and also explains how to drill up and down through data hierarchies,
drill through hyperlinks, and switch views between a chart and table or
cross-tab view of data. The chapter also describes Flash charts and gadgets,
and HTMLS5 charts, and explains how you can modify them.

m  Chapter 9. Modifying cross tabs. This chapter describes cross tabs and explains
how you can use Interactive Viewer to modify the formatting properties of
data in a cross tab. The chapter also describes how you can analyze cross-tab
data, modify charts in a cross tab, and export, print, and save a cross tab.

m  Chapter 10. Modifying summary tables. This chapter describes summary tables,
and explains how you can use Interactive Viewer to modify data in a
summary table. The chapter also describes modifying a chart in a summary
table, and saving a summary table.

m  Chapter 11. Functions and operators. This chapter is a reference for all the
functions available in Interactive Viewer. The chapter also describes the
operators you can use when creating expressions for calculations.

m Part 2. Actuate BIRT Viewer Reference. This part contains information about
configuring the Actuate BIRT viewers and accessing a BIRT viewer using a
URL

m  Chapter 12. Configuring Actuate BIRT Viewer. This chapter describes how to
configure the Actuate BIRT viewers.

m  Chapter 13. Actuate BIRT Viewer URIs. This chapter describes how to access a
BIRT viewer using a URI.
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Introducing
Actuate BIRT Viewers

This chapter contains the following topics:

m Introduction to the viewing environments
m Using Actuate BIRT Viewer

m Using Interactive Viewer

m  Comparing the viewers
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Introduction to the viewing environments

You can view BIRT (Business Intelligence Reporting Tools) reports using two
web-based viewing environments, Actuate BIRT Viewer and Actuate BIRT
Interactive Viewer. In this document, the term, viewers, refers to both Actuate
BIRT Viewer and Actuate BIRT Interactive Viewer (Interactive Viewer). A report
is a category of documents that presents formatted and structured content from
one or more data sources, such as a database, a spreadsheet, or a text file.

Figure 1-1 shows a simple listing report displaying credit limit information for
customers, sorted by country.

/Report column label

Report column

-] Australia
Australian Collectors, Co. Ferguson Peter 03 9520 4555 Melbourne 3004 117300
Anna's Decorations, Ltd O’'Hara Anna 029936 8555  North Sydney 2060 107500
Souveniers And Things Co. Huxley Adrian  +61 2 9495 8555 Chatswood 2067 93300
Australian Gift Network, Co Calaghan Ben 61-7-3844-6555 South Brisbane 4101 51600
Australian Collectables, Ltd Clenahan Sean 61-9-3844-6555  Glen Waverly 3150 60300

S Austria
Salzburg Collectables Pipps Georg 6562-9555 Salzburg 5020 71700
Mini Auto Werke Mendel Roland 7675-3555 Graz 8010 45300

] Belgium
Petit Auto Dewey Catherine (02) 5554 67 Bruxelles B-1180 79900
Royale Belge Cartrain Pascale  (071) 23 67 2555 Charleroi B-6000 23500

Figure 1-1 An example report

This section describes the viewers and highlights the capabilities and functions of
Actuate BIRT Viewer and Interactive Viewer. You use the viewers to navigate a
report, print report data, and export the report and report data to several other
formats. In addition, Interactive Viewer, as its name suggests, provides a high
degree of interactivity. Users can easily modify the layout and formatting of
reports, organize report data by sorting, filtering and grouping, perform
calculations and compute report data, and edit graphical representations of
report data by modifying charts in a report. In addition, you can modify cross
tabs, and summary tables in a report. You can then save the modified reports
using Interactive Viewer. Detailed information about performing each of these
tasks is available in later sections of this document. In cases where you do not see
a specific option that is described, upgrade to Interactive Viewer in order to
access additional functionality.

A BIRT report can consist of several report components. At the very least, a BIRT
report contains a table which holds data. In addition, a report can contain other
elements such as charts, Flash charts and gadgets, HTML5 charts, a cross tab, or a
summary table.

Users, working with BIRT dashboards to interact with gadgets, such as report
gadgets, chart gadgets, Flash gadgets, cross-tab gadgets, or summary-table
gadgets, can access most menu options described in this document by first
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maximizing each gadget. For more information on working with dashboards, see
Building BIRT Dashboards.

Using Actuate BIRT Viewer

To begin using Actuate BIRT Viewer, you must first generate a report. The
primary interface in which you view the report is Actuate BIRT Viewer. You can
launch Actuate BIRT Viewer from any of the following applications:

Actuate Information Console
Actuate BIRT iServer

Actuate BIRT Studio

Actuate BIRT Designer Professional
Actuate Deployment Kit

The Actuate BIRT Viewer interface consists of a main toolbar with several icons
that include the main menu with options, and the page navigation tool.The report
itself occupies the remaining portion of the Viewer, as shown in Figure 1-2.

E~ 1/4 [ |
Australia
Australian Collectors, Co. Ferguson Peter 03 9520 4555 Melbourne
Anna's Decorations, Ltd O'Hara Anna 029936 8555  North Sydney
Souveniers And Things Co. Huxley Adrian +61 2 9495 8555 Chatswood

Australian Gift Network, Co Calaghan Ben 61-7-3844-6555 South Brisbane
Australian Collectables, Ltd Clenahan Sean 61-9-3844-6555  Glen Waverly

Austria
Salzburg Collectables Pipps Georg 6562-9555 Salzburg
Mini Auto \Werke Mendel Roland 7675-3555 Graz
Figure 1-2 Viewing a report in Actuate BIRT Viewer

You use Actuate BIRT Viewer to perform the following tasks:

View the table of contents.
Navigate pages in a multipage report.
Export data to several flat file formats.

Export content to AFP, Excel, PostScript, PDF, Word, PowerPoint, or Extensible
HTML formats.

Link to the report page.
Print reports.

Show or hide report margins in the browser.
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m Specify viewing parameters.
m  Use hyperlinks in a report to view data in other reports or external web sites.

m Drill up and down hierarchical data to view summary or detail information.

Using Interactive Viewer

This section describes the additional functions available using Interactive Viewer.
Interactive Viewer provides users with complete access to the features available
in Actuate BIRT Viewer. In addition, Interactive Viewer enables users to easily
customize reports based on individual needs and preferences. Using Interactive
Viewer, users can modify the layout of the report, compute data, move or delete
columns, create aggregate data, modify tables displaying summary information,
modify charts and graphs, modify data in cross tabs, and rearrange data using
simple menu options. You can view and modify a report containing up to 200
pages in Interactive Viewer.

When you purchase the Actuate BIRT viewers, you have immediate access to
Actuate BIRT Viewer. To access Interactive Viewer, your system administrator
must enable this option on your system, for which you must purchase the
Interactive Viewer license.

To view a BIRT report in Interactive Viewer, first view the report using Actuate
BIRT Viewer. From the main menu, choose Enable Interactivity to launch
Interactive Viewer.

The change in the name of the viewing pane to Actuate Interactive Viewer
indicates that you are in Interactive Viewer mode. Also, notice the appearance of
the undo and redo buttons on the Viewer toolbar, as shown in Figure 1-3.

Undo
Redo

1/4 | ey

11}
4

] Australia
Australian Collecters, Co. Ferguson Peter 03 9520 4555 Melbourne
Anna's Decorations, Ltd O'Hara Anna 02 95936 8555 North Sydney
Souveniers And Things Co. Huxley Adrian +61 2 9495 8555 Chatswood
Australian Gift Network, Co Calaghan Ben 61-7-3844-6555  South Brisbane
Australian Collectables, Ltd Clenahan Sean  61-9-3844-6555 Glen Waverly
] Austria
Salzburg Collectables Pipps Georg 6562-9555 Salzburg
Mini Auto Werke Mendel Roland 7675-3555 Graz
Figure 1-3 Viewing a report in Interactive Viewer

When you choose Disable Interactivity from the main menu, the Undo and Redo
buttons disappear, and the name of the viewing pane changes to Actuate Viewer.
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After launching Interactive Viewer, you can select any column in the report to
highlight it. Notice the appearance of a toolbar on the top of the selected column
providing a column menu, Sort, and Filter buttons, as shown in Figure 1-4.

Figure 1-4 Column toolbar

To modify the column, select the column menu, then choose an option from the
menu that appears. You can also display the options that appear in the column
menu by right-clicking the selected column to display a context menu. This
document uses the context menu to select modification options. The example
shown in Figure 1-5 displays a typical context menu.

Header 3
Group 3
Column 3
|| Aggregation
Filter 3
Sort 3
Alignment [3
Format 3

|2 Export Content

Figure 1-5 Column menu

You can use Interactive Viewer to perform the following additional tasks:
m  Undo and redo the most recent action.

m  Modify font properties of report data and report elements.

m  Apply conditional formatting and format data strings.

m Sort, group, and filter report data.

m Perform calculations and compute data.

m  Modify graphs and charts.

m  Modify Flash charts and Flash gadgets.

m  Modify HTML5 charts.

m Rearrange, move, hide, and delete columns.

m Create aggregate data.

m Add page breaks in a multipage report.

m  Save a modified BIRT report design or document file.

m  Modify cross tabs and analyze cross-tab data in Actuate BIRT Data Analyzer.
m  Modify summary tables.

Chapter 1, Introducing Actuate BIRT Viewers 7



Comparing the viewers

In this section, Table 1-1 compares tasks you can perform using the viewers and
highlights tasks you can exclusively perform using Interactive Viewer.

Table 1-1 Comparing the Actuate BIRT Viewers

Actuate BIRT Interactive
Task Viewer Viewer

AN

Add computed columns.

Add page breaks in a report.

Apply conditions and format data strings.
Create aggregate data in a report table.
Display the table of contents.

Display viewing parameters.

Export content.

NN NS

Export data.

Hide or show report items.

AN

Link to the report page.

Modify charts and graphs.

Modify cross tabs.

Modify Flash charts and gadgets.

Modify HTMLS5 charts.

Modify summary tables.

Modify text attributes and alignment.

Move, hide, show, and delete report columns.
Navigate a multipage report. v
Print a report. v
Save a modified report.

Save a BIRT report design.

Sort, group, and filter report data.
Undo and redo tasks.

Use hyperlinks present in the report.
View Flash charts and gadgets.
View HTMLS5 charts.

View summary tables.

NN AN RNERNREREEERENEERENENSNANSNSNSNSNSSNSNSSANNS

NN NS
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This chapter contains the following topics:

Navigating a report

About navigation options
Paging through a report
Opening the table of contents
Displaying parameter values
Displaying margins

Working with hyperlinks
Saving a report

Printing a report

Chapter 2, Navigating a report
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About navigation options

The previous section introduced the viewers, and described the tasks you can
perform using them. You can use Actuate BIRT Viewer to open and view the table
of contents, navigate to specific sections in the report using the table of contents,
view each page of the report, go directly to a specific page, and specify parameter
values to view specific content in large reports. You can also obtain a unique URL
for the report to link to it from other documents. In addition to these navigation
options, you can use Interactive Viewer to save a modified report, and print
reports. The following section describes how to navigate a generated report in the
viewers, to enable you to modify or customize the report.

Paging through areport

The viewer toolbar consists of a main menu with additional options and a page
navigation tool, as shown in Figure 2-1. You can view pages in a multipage report
using the paging tool. The tool consists of a set of arrows that enable users to view
the first or last page in a report, and to move forward or backward, page by page,
through the report.

Main menu

Page number

First page
Previous page

Next page

Last page

=~ 1/4 > |

Figure 2-1 Actuate BIRT Viewer toolbar

To navigate directly to a specific page, type the page number in the Page number
field, then press Enter. In Actuate 11 and later releases, Actuate BIRT Viewer
supports progressive viewing for multipage reports. The progressive viewing
feature provides efficiency by enabling users to view each page of the report as it
is generated, without requiring the user to wait until the entire report is
generated.

Opening the table of contents

A table of contents can be defined as a list of sections, that provides you with
information about where each section begins. In the viewers, you can open a table
of contents to view the report structure and navigate to specific sections of the
report. To view the table of contents, choose TOC from the main menu. If the
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report contains a table of contents, the TOC panel displaying the entries appears
on the left of the viewer, as shown in Figure 2-2.

= /4 [ ey
TOC %
o Australia Z= Australia
. Australian Collectors, Co. Ferguson Peter 03 9520 4555
° Austria Anna's Decorations, Ltd Q'Hara Anna 02 9935 8555
= Belgium Souveniers And Things Co. Huxley Adrian  +61 2 9495 3555
Australian Gift Network, Co Calaghan Ben 61-7-3844-6555
» Canada Australian Collectables, Ltd Clenahan Sean  61-9-3844-6555
» Denmark = Austria
. Salzburg Collectables Pipps Georg 6562-9555
e Finland Mini Auto Werke Mendel Roland 7675-3555
= France = Belgium
Petit Auto Dewey Catherine (02) b5b4 67
= Germany Royale Belge Cartrain Pascale  (071) 23 67 2555
Figure 2-2 Displaying the table of contents

Because each entry in the table of contents is a link to a section in the report,
selecting an entry in the table of contents displays the related section in the report.
If you have a multipage report containing sections and subsections, you can
expand the entries in the table of contents panel to navigate directly to the
appropriate subsection.

To close the table of contents, choose Close from the top corner of the TOC panel.

Displaying parameter values

A parameter value is a way of limiting the report data retrieved when you run a
report. For example, in a report that displays customer information, you can use
parameter values to display sales history for a specific customer, or view the
details of specific orders. If a report requires you to enter parameter values, you
are prompted to type the value when you generate the report. Specifying
parameter values enables you to navigate a report more effectively, and display
only the information you need.

If the report requires you to enter parameter values to determine what data to
display, you can modify these values to view other data, by choosing Parameters
from the main menu. If you choose this option, and parameter values are not
needed, a message appears informing you that the report contains no parameters.
You learn more about using parameters later in this document.

Displaying margins

The viewers also provide the option to display or hide margins for any report
design you are viewing. Selecting or deselecting this option displays or hides
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margins in the browser window, and does not impact page margins when
printing a report design or exporting a report design to other formats.

To display a margin, choose Show Margin from the main menu.

To hide a margin, choose Hide Margin from the main menu.

Working with hyperlinks

Sometimes report developers add interactive viewing features in reports using
BIRT Designer Professional or BIRT Studio. Interactive viewing features such as
hyperlinks enable a user to navigate a lengthy multipage report more efficiently.

For example, the shipping schedule report shown in Figure 2-3, links each order
number to the corresponding invoice. You can view the details of each invoice for
orders that were shipped, canceled, in process, or on hold. Select an order number
for which you want to view the invoice. Interactive Viewer displays the invoice
for the order number selected in Figure 2-3, as shown in Figure 2-4.

Shipping schedule

Shipped Date Order Status  Order Number Customer Number|

Contact: Martha
Akergatan 24
Bracke, 5-844 6

Cancallad Select order number
10167 44
10248 131
10260 357
10262 141
In Process
10420 282
10421 124
10422 157]
10423 314
Figure 2-3 Drilling through the order number field
Classic Models, Inc
2207 Bridgepointe Parkwa -
San uate;‘f CPA 94404 v Customer Order Histo ry

Scandinavian Gift Ideas
Larsson Sales Representative: Barry Jones

7

Sweden
 code [ mvoice
! displayed for

Order Number: 10167 Order Date: Oct 23, 2003 the selected
S10_4757 1972 Alfa Romeo GTA 44 $123.76 $5,445.44 order number
S18_1662 1980s Black Hawk 43 $141.92 $6,102.56

Helicopter
S18_3029 1999 Yamaha Speed 46 $69.68 $3,205.28

Boat
Figure 2-4 Invoice linked from each order number

12 Working

If the report you are viewing contains hyperlinks, choose the link to view the
associated content. For example, in a report listing customers and their web sites,
choose a URL in the report to visit the corresponding web site. The content the
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link references, opens in a new browser tab or window. If the hyperlink is
associated with an e-mail address, your default e-mail client launches a new
message window. The linked address, appears in the To field. For example, to
contact the customer, choose the e-mail address in the report to send the customer
an e-mail. Some hyperlinks can link elements within the same report. For
example, a hyperlink created in a report element such as a summary table, cross
tab, or chart can link to another chart, within the same report. Hyperlinks can also
link to external reports stored in the iServer Encyclopedia volume. These
hyperlinks are called drill-through hyperlinks. When you choose the link, the
report launches in a new browser tab or window.

You can also use the Link To This Page option to share the currently viewed
report with other users. When you share the report, the viewer generates a link to
the report and makes this available to other designated users.

How to link to the current report page

Choose Link To This Page from the main menu. On Link To This Page, you can
either copy the absolute link and paste it in an e-mail or instant messenger
window, or you can copy the HTML code, as shown in Figure 2-5, and paste it in
the required location. Choose OK to close the window.

Link To This Page X
Paste link in email or IM:
http://localhost:8900/iportal {executereport.do?__locale=en_US&__vp=urupfcose
Paste HTML to embed in website:
<script type="text/javascript’ language="JavaScript’ src="http://localhest:8900/ipor
’
Figure 2-5 Linking to the current report

Saving a report

Many of the tasks you can perform in Interactive Viewer, such as sorting data,
using conditional formatting, creating aggregate data, and inserting computed
columns, are similar to tasks a report developer performs in the report design
environment. Sometimes you need to modify the report and save it, so you can
use it later, or make it available for other users to view and modify.

In Interactive Viewer, you can save a modified report as a BIRT report design or a
BIRT report document file. To enable users to open the modified report in Actuate
BIRT Studio, or Actuate BIRT Designer Professional, and to provide them with
the ability to modify the report extensively, save the report as a BIRT report
design (.rptdesign) file. To enable users to open the modified report in the
viewers, and to limit the extent of the changes they can make to the report, save
the report as a BIRT report document (.rptdocument) file. You cannot open a
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report document file using Actuate BIRT Studio or Actuate BIRT Designer
Professional. To edit a BIRT report document (.rptdocument) file in either report
design tool, you must first save the file as a BIRT report design (.rptdesign) file
using Interactive Viewer. The following section describes how to save a report

using Interactive Viewer.

How to save a BIRT report design

You can save a modified BIRT report design file, or BIRT report document file, as

a BIRT report design.

1 From the main menu, choose Enable Interactivity. You are now in Interactive

Viewer.

2 Choose Save Design from the main menu. Save displays the default location
where the report is saved, as shown in Figure 2-6. You have the following

options:

= You can choose to save the report in the default location, which is the user’s
home directory (/Home/username), where username is the name of the

user logged in to the application.

m To save the file in a different directory, select (/) to display a list of available
directories from the path in Choose a Folder. Navigate to a new location

from the path.

Save Report Design
Look in:

=) administrator

Name

x

x| E———Home folder

||

{53 BubbleChart

5 column_duplicate_values

15 CrosstabSampleRevenueModified
{53 Customer Order History

4 |

File name:

Actuate Bd
Actuate B.
Actuate Bl

Actuate_Bi;|
»

Find |———Type a string from an existing
file name

Description:

File type: | Actuate BIRT Report Design (*.rptdesign)

———Type a file name

|

——Choose a file type

Figure 2-6

Saving a BIRT report design

3 Choose a file name for the report design.

m To overwrite an older version of the report, in Find, type the name of the
report or a string of characters from the name. Then, press Enter, or choose
Find. Save Report Design displays the reports that match the string you
provided. Choose the file name from the menu that appears.
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m To save the new report without overwriting an older version, type a new
name in File name.

Choose OK. You save the report design as a BIRT report design (.rptdesign)
file. To verify that your report has been saved, start your application server
and navigate to the directory containing the report design file.

How to save a BIRT report document

1 From the main menu, choose Enable Interactivity, then choose Save

Document. Save displays the default location where the report is saved, as
shown in Figure 2-7. You have the following options:

®  You can save the file in the default location, which is the user’s home
directory (/Home/username), where username is the name of the user
logged in to the application.

= You can save the file in a different directory. To save the file in a different
directory, select (/) to display a list of available directories from the path in
Choose a Folder. Navigate to a new location from the path.

Save Report Document x
Look in:
=) administrator LI @
Name I Type I Date Modified
| Find

File name:

Description:

File type: | Actuate BIRT Report Document (*.rptdocument) j

Figure 2-7 Saving a modified report

Choose a file name for the report.

m To overwrite an older version of the report, in Find, type the name of the
report or a string of characters from the name. Then, press Enter, or choose
Find. Save displays the reports that match the string you provided. Choose
the file name from the menu that appears.

m To save the new report without overwriting an older version, type a new
name in File name.

The report is saved as a BIRT report document (.rptdocument) file. To verify
that your report has been saved, start your application server and navigate to
the directory containing the report document file.
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Printing a report

After viewing a report, you can print it in HTML or PDF format. In Interactive
Viewer, you can print either the original report or the modified report. You can

A=k

print a maximum of 200 pages.

How to print a report

1 From the main menu, choose Print.

2 On Print, complete the following tasks:

1 In Format, select HTML or PDF.

o If you select HTML, the report is formatted for printing as a continuous
document in the browser window. Any page headers and footers
appear in the body of the document, often multiple times, depending
on how many pages the report contains. A multipage report does not
retain its pagination properties when you choose to print it in HTML

format.

o If you select PDF, you can specify page style options for a multipage
report. Select a page format from the list, as shown in Figure 2-8.

o Auto is the default option. When you choose Auto, Interactive
Viewer lays out the data such that the report content fits the width of
the PDF page. If the report uses headers and footers, each header
and footer are displayed in the appropriate location. Because the
content is optimized in terms of font, and space, a single page in the
report often displays on multiple pages in the PDF file. When you
use the Auto option, existing pagination properties in the report are
not retained in the PDF file, but the PDF output is paginated.

Print x
Format
©) HTML
@ POF |Auto
Auto
pages Actual size
Scale to page size
Al
@ Current page
(7) Pages:
(eg.1,3,5-12)
Print Limit: first 200 Pages.
’
Figure 2-8 Printing a report

o Choosing Actual Size retains existing pagination properties from the
original report. When you choose this option, the font size in the
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printed report is often significantly smaller than in the original
report, to allow the content to fit within specified page boundaries.
After you send the document to a printer, further modify options on
the printer dialog box as needed, so that the printed report is legible.

o Choosing Scale to page size retains the existing pagination
properties from the original report in the PDF output. Interactive
Viewer shrinks report content such as fonts, and images, to fit each
current report page on each page in the PDF output.

2 In Pages, indicate which pages to print. You can print all the pages in the
report, only the current page, or a specific set of pages. To print specific
pages, use commas to separate the page numbers. To print a range of
pages, enter the start and end page, separating the two entries with a
hyphen. To print from a specific page to the end of the document, enter the
start page followed by a hyphen.

Choose OK.
3 Depending on your format selection in Print, you have the following options:

m If you selected HTML format, Print appears. Specify your printer options
on Print.

m If you selected PDF format, the report appears in your web browser using a
PDF viewer plug-in. You can preview the report, then choose Print to
specify printer options. Review the options on the printer dialog box to
make sure that the report content is legible.

Your report is sent to the printer you specify.
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Editing and formatting
areport

This chapter contains the following topics:

About editing and formatting options
Changing font properties and alignment
Formatting report data based on conditions
Formatting data strings

Reverting to default formats

Copying a format to other columns

Editing column and group headers

Chapter 3, Editing and formatting a report
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About editing and formatting options

Interactive Viewer provides you with the flexibility to modify the presentation
properties of reports. This section discusses the editing and formatting options
available to you.

How to select an element for formatting

In a report table, you can format column headers as well as data in the columns.
Select the element, then choose the formatting option from the menu that
appears.

Choose a column header to highlight it. To select data for formatting, select the
entire column by clicking in the column area. A box appears, highlighting the
selected element.

Formatting a column

You can use Interactive Viewer to define new font properties and change text
alignment for a selected report column, or for the report table. You can also
specify these style properties for one column, and copy the style to other
columns. You can highlight report data based on certain defined conditions and
format data strings depending on the type of data in a column. For example, you
can format data strings into currency, telephone number, postal code,
date-and-time, or decimal formats.

Formatting data in a merged column

Sometimes reports contain data that can be presented more effectively when you
merge one or more report columns. For example, a report listing customers and
their addresses is easier to read when the address, city, state, and postal code
items are merged to present this information in a single column. Interactive
Viewer does not allow you to merge columns, but you can modify data in existing
merged columns using Interactive Viewer. You can change font properties, create
conditional formatting rules, and format data in merged columns.

When working with a merged column, if you choose Format>Font, or
Format>Conditional Formatting, from the context menu, Select Data Item
appears, providing a list of data items, or columns, in the merged column, as
shown in Figure 3-1.

Select Data Ttem x
Iy i
?
Figure 3-1 Selecting a data item
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From the list, select a data item on which to perform an action. Choose OK.

You can now modify font properties, format data strings, and so on, for the
selected column, as described in the following sections of this document.

To modify all the data rows in the merged column, you must repeat this step for
each data item, and implement the change in format, font, and so on, each time.

Changing font properties and alignment

In Interactive Viewer, you can change the font properties and alignment of
editable labels, column headers, and data in a report column. The properties you
can modify include the font type, size, color, and background color. You can also
display the font in bold, italic, or underlined style. As you modify these
properties, you can view the appearance of the data in the column, in the Preview
field.

You can choose to apply these properties to a single column, the entire table, or
share the properties with other columns, without reapplying the style to each
column.

How to change font properties

1 Select the item, such as table label, column header, or column to highlight it.
Choose Format>Font from the context menu. Font displays the current font
property values, as shown in Figure 3-2. A value of Auto indicates that the
default value is used.

Font X
Font: Size:
Arial ¥ 8 b
Color: Background Color:
BLACK v Auto b
B I u
() Apply to table
@ Apply to column
AaBbCcYyZz
’
Figure 3-2 Defining font properties

2 Use the drop-down lists to change the font properties for the selected element.
1 Select a font type and size.

2 Select a font color.
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3 To set a color, complete the following steps:

o Accept the default value of Auto, or select a different color in Basic
Colors, as shown in Figure 3-3.

Font X
Font: Size:
Arial v| B v
Calor: Background Color:
BLACK. v | Auto v
|| suto
‘- Basic Colors
[ EEEEENENR
[ EENNEER
RN |
EEEN | hryzz
E
Cancel 2
| |%5#| Custom Colors -
Figure 3-3 Selecting an available color

o Select Custom Colors, and use the spectrum bar to specify a color
group. Then, select a shade in the gradient square, and choose Pick
Color, as shown in Figure 3-4.

Auto Gradient selector
Basic Colors ——Color preview box
EEEEEEN Reeg 7
EEEEEEN
EEN o G204 Red, green, blue values
EEEN N B: 204
o. # 330c0c ——— Hexadecimal value
————————— Spectrum bar
% | [Custom Calors N = [PikCoor] | 5radient box
Figure 3-4 Selecting a custom color

The RGB value of the selected color appears in Color.

4 To apply the selected properties to the entire report table, select Apply to
table.

5 To apply the selected properties to the selected column, select Apply to
column.

Choose OK.

How to change the alignment of text

In Interactive Viewer, select the table label, column header, or column to highlight
the element. From the context menu, choose Alignment, then choose Left, Center,
or Right.
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How to copy font and alignment properties to other columns

1 Select the column from which you want to copy font and alignment
properties. From the context menu, choose Format>Copy Style.

Copy Style appears, as shown in Figure 3-5.

Copy Style x

Country
Customer
Phone

City

Zip Code
Credit Limit

Coc (o] @

Figure 3-5 Sharing font and alignment properties with other columns

2 Select a column to which you want to copy the font and alignment properties.
To select multiple columns, press Ctrl, then select each column.

Choose OK. The report displays the copied style properties in the specified
columns.

Formatting report data based on conditions

When you format data in a selected column, the format applies to all the values.
Often, it is useful to change the format of data when a certain condition is true.
For example, you can display sales numbers in red if the value is a negative
number and in black if the value is a positive number. Conditional formatting is
the formatting of data according to defined conditions.

You also can change the format of data in a column according to the values in
another column. For example, in a report showing customer names and the
number of days each customer’s invoice is past due, you can highlight in blue
any customer name that has an invoice past-due value between 60 and 90 days.
Then, you can highlight in red and bold any customer name that has an invoice
past-due value greater than 90 days.

To apply conditional formatting, you create a rule defining when and how to
change the appearance of data. You can apply conditional formats only to data in
columns. The rule consists of the condition that must be true, and the text
attributes to apply to column entries that satisfy the condition. You can define up
to three conditions or rules for a single column and remove or modify conditional
formatting for a column.

You can also influence the formatting of one column based on values in another
column. For example, in a sales inventory report, when you apply conditional
formatting to the Product column, you can define the condition based on the
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Quantity in Stock column, such that conditional formatting is applied to the
Product column if the quantity in stock is below a specified value. After you
create the condition, you define the format in which to display data that satisfies
the condition. The formatting appears on the selected column and not on the
column on which you based the condition.

How to set conditional formats

1 To define the condition, select the data column on which to display
conditional formatting. From the context menu, choose Format>Conditional
Formatting. Conditional Formatting appears, as shown in Figure 3-6. The
example shown in Figure 3-6, highlights all customers with a credit limit of
less than $100,000. The report in Figure 3-7 displays conditional formatting for
the data fields in the Credit Limit column that satisfy the defined conditions.

Conditional Formatting

selected Column: CREDITLIMIT

x

Delete Rule

Format

FPraview

Column Name: CREDITLIMIT

Condition: Less Than or Equal to ht
Value: 100000 Change Value
Add Rule
E
Figure 3-6 Defining conditional formatting

Select formatting options

Preview of the selected format

The condition to meet to apply the
format

Australia

Australian Collectors, Co.

Ferguson Peter

Anna's Decorations, Ltd O'Hara Anna
Souveniers And Things Co. Huxley Adrian [INNEENISSE0N
Australian Gift Network, Co Calaghan Ben [INNEGEGSIENN
Australian Collectables, Ltd Clenahan Sean [INEGSIENN
= Austria

Salzburg Collectables Pipps Georg NG
Mini Auto Werke Mendel Roland [INEGEGSEN

Figure 3-7 Customers with credit limits below $100,000

2 On Conditional Formatting, create a rule specifying the following information,

then choose OK:

m The format to apply, such as bold style. Choose Format to select formatting

options.

m The condition that must be true to apply the format, such as Credit Limit
Less than or Equal to 100000.
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Specifying a format for the data

To define text attributes for the selected data column, complete the following

steps:

1 Choose Format>Conditional Formatting from the context menu. On
Conditional Formatting the Selected Column field contains the name of the
column that displays the conditional format.

2 Choose Format and select the text attributes to display for the Credit Limit
column. As you define the format, you can view how the data in the column
appears in the Preview field, as shown in Figure 3-8. Choose OK.

Font x
Font: Size:
Auto ¥ Auto v
Color: Background Color:
Auto > |Auto i
B I u

Pevvion \
2
Figure 3-8 Defining the format

Specifying a condition

The condition in a conditional formatting rule is an If expression that must

evaluate

If the
If the
If the
If the

to True. For example:

order total is less than 1000

customer credit limit is between 100000 and 200000
sales office is Tokyo

order date is 7/21/2008

The Conditional Formatting dialog box helps you construct the If expression by
breaking it down into its logical parts. In Figure 3-6, the expression consists of
three parts. In Figure 3-9, the expression has four parts.

In Column Name, select a column. This column contains the value that
determines when conditional formatting takes effect. The column you select here
does not have to be the same as the column that you selected for formatting in the
report. For example, if Product Name is the column selected for formatting, you
can select Profit in this field to indicate that for a certain profit amount,
conditional formatting applies to the product name.
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Conditional Formatting x
Selected Column: CREDITLIMIT
Delete Rule

Format Praview

Column Name: CREDITLIMIT -7

Condition: Befween e

Value: 100000 Change Value

Value: 200000 Change Value

Add Ruls
:
Figure 3-9 Selecting data fields between two values

In Condition, select the comparison test, or operator, to apply to the column you
selected. You can select Equal to, Less than, Less than or Equal to, and so on. If
you select Is Null, Is Not Null, Is True, or Is False, the If expression does not
require additional information.

If you select an operator that requires a comparison to one or more values, one or
more additional fields appear. For example, if you select Less than or Equal to, a
third field appears. In this field, type the comparison value. If you select Between
or Not Between, a third and fourth field appear. In these fields, type the lower
and upper values, respectively, as shown in Figure 3-9.

Comparing to a literal value

The conditional expression, as shown in Figure 3-9 in the previous section,
evaluates the Credit Limit column and compares each value to determine if it
matches a value between 100000 and 200000. The 100000 and 200000 values are
literal values that you type.

Alternatively, you can select a value from the list of values in the Credit Limit
column. Selecting from a list of values is useful if the comparison value is a
customer name and you do not know the exact customer names, or if the
comparison value is a date and you do not know the date format to type. If the
comparison value is a date, Interactive Viewer also provides a calendar tool,
which you can use to select a date.

How to select a comparison value from a list of values
1 On Conditional Formatting, choose Change Value, below the Condition field.

Select values appears. Choose Specify literal value, then choose Select Values.
The values in the selected column appear. Figure 3-10 shows an example of the
values in the credit limit column.
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Select Values

(@ Specify literal value () Use value from data field

Value: 100000

° 4
11000

21000
23000
23500

Select Values

34800 j
previous | mext
2
Figure 3-10 Selecting values

2 Select a value from the list, then choose OK. The value appears in the
comparison value field on Conditional Formatting.

Comparing to a value in another column

In a conditional expression, you can compare the values of one column with the
values of another column. For example, in a report that displays products, sales
prices, and MSRP (manufacturer suggested retail price), you can create a
conditional formatting rule that compares the sale price and MSRP of each
product, and highlight the names of the products whose sales price is greater than

MSRP.

How to compare to a value in another column

1 On Conditional Formatting, choose Change Value, below the Condition field.

2 On Select values, select Use value from data field. A list of columns used in the

report appears.

3 Select a column from the list, then choose OK. The column name appears in
the comparison value field on Conditional Formatting.

Figure 3-11 shows a condition that compares the sales price with the MSRP
value. If the sale price value is greater, the product name displays in bold.

Conditional Formatting

selected Column: Price

Delete Rule

x

Format Praview

Column Name: Price ..

Condition: Greater Than or Equal to ht

Value: [MSRP] Change Value
Add Rule

?

Figure 3-11
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You can now define up to two additional rules for the report column on
Conditional Formatting. Choose OK. Figure 3-12 shows the conditional
formatting applied to the report column.

Product Line Product Name Sale Price MSRP
1962 LanciaA Delta 16V 514183 $147.74]
1969 Dodge Super Bee S66.74 580.41
2002 Chevy Corvette $107.08 $107.08|
1970 Triumph Spitfire 5126.39 $143.62
1976 Ford Gran Torino $146.99 $146.99)
1970 Triumph Spitfire §127.82 5143262
1963 Ford Mustang $173.17 $194.57|
1968 Ford Mustang §171.22 5194.57|
1957 Corvetie Convertible §122.02 $148.80
1968 Dodge Charger §110.39 S117.44]
1972 Alfa Romeo GTA $136.00 $136.00
1982 Lamborghini Diablo 53059 537.76|
1870 Plymouth Hemi Cuda 57262 579.80
1870 Plymouth Hemi $79.80 §79.80
Cuda

Figure 3-12 Report displaying conditional formatting

Specifying multiple conditional formatting rules

You can create up to three conditional formatting rules for a single column. You
can, for example, create three rules to set the values of a profit column to one of
three colors, depending on its value. Figure 3-13 shows this example.

Sales Office: Boston
Product Line Product Name Total Profit
Classic Cars
1548 Porsche 356-A Roadster £1,841.84
1948 Porsche 356-A Roadster £3,187.80
1948 Porsche 356-A Roadster £2,735.04
1548 Porsche Type 356 Roadster £5,658.30
1548 Porsche Type 356 Roadster £3,6876.60
1549 Jaguar XK 120 £3,971.18
1549 Jaguar XK 120 £2,235.30
1552 Alpine Renault 1300 £6,214.70 £3,355.88
1552 Alpine Renault 1300 £4,140.23 €1,872.89
1552 Alpine Renault 1300 £7,995.41 £3,953.63
1552 Alpine Renault 1300 £7,200.40 £3,257.20
1552 Citroen-15CY £2,593.02
1556 Porsche 3564 Coupe 52,842.34
1556 Porsche 356A Coupe £5,055.30
1556 Porsche 3564 Coupe £3,578.12 €1,022.32
1357 Corvette Convertible £5,785.44 £2,428.80
1957 Corvette Convertible £2,499.80 £1,101.20
1958 Chevy Corvette Limited £1,291.92
Edition
1558 Chevy Corvette Limited $675.00
Edition
1958 Chevy Corvette Limited £1,476.48
Edition
1561 Chevrolet Impala £3,220.80
1561 Chevrolet Impala £2,255.56

Figure 3-13 A report with multiple conditional formatting rule

For each row of data in the report, Interactive Viewer evaluates the rules in the
order in which they appear in the list of rules. As it evaluates each rule,
Interactive Viewer applies the specified format properties if the condition is met.
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When creating multiple rules for a column, be careful that the conditions do not
cover overlapping values. Consider the following scenario:

m The first rule sets a profit value to blue if the value exceeds 5000.
m The second rule sets the profit value to green if the value exceeds 1000.

If the profit value is 6000, the value appears in green, not blue as you expect,
because the condition in both rules is true (6000 exceeds 5000 and 1000), and the
second rule supersedes the first rule. For the rules to make sense, the second rule
should set the profit value to green if the value is between 1001 and 5000.

Deleting a conditional formatting rule

This section describes how you can delete conditional formatting rules from a
report column.

How to delete conditional formats

1 Select the column, then from the context menu, choose Format>Conditional
Formatting.

2 On Conditional Formatting, choose Delete Rule for each conditional
formatting rule that you want to remove. Choose OK.

Formatting data strings

Interactive Viewer provides common formats to change how numbers appear.
You can, for example, display numbers with or without decimal values, in
scientific notation, as a percentage, or as currency with the appropriate symbol.
Sometimes, even though a column displays numbers, the data can have a string
data type. Postal codes, for example, are frequently stored as string data. Numeric
formats do not apply to numbers of string type. To help you understand what
format you can apply to a report column, when you select a column for
formatting the title of the formatting dialog box identifies the type of data in the
column. This section discusses numeric data formats, date-and-time formats, and
string data formats, and describes how you can apply these formats to data in a
report. When you work with merged columns, select each column from the
drop-down list of columns in the merged column, and define a new format each
time, based on the column’s data type.

When working with multiple columns containing the same data type, you can
use Interactive Viewer to specify a format for the data in one column, and copy
the format to other columns. This section also explains how to copy formatting
properties.
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About data formats

Data types are types of values—numbers, strings, and Booleans, for
example—that you can manipulate in any programming language. Every element
of report data has a certain data type, and every expression that you create
returns a value of a particular data type.

This concept is important because, if the expression you type does not handle
data types properly, you do not obtain the expected results. For example, you
cannot perform mathematical calculations on numbers if they are of string type,
and you cannot convert values in a date field to uppercase characters.

If you type an expression to manipulate a data field, make sure you verify its
type, particularly if the data consists of numbers. Numbers can be of string type
or numeric type. For example, databases typically store postal codes and
telephone numbers as strings. Item quantities or prices are always of numeric
type so that you can manipulate the data mathematically. IDs such as customer
IDs, or order IDs are usually of numeric type so that the application can store
them in numeric order, such as 1, 2, 3, 10, 11, rather than in alphanumeric order,
such as 1,10, 11, 2, 3.

To view the data type of a column, select the column and choose Format>Format
Data from the context menu. The name of the dialog box that appears tells you
the type of data in the column. For example, if you select the credit limit column,
the dialog box that appears is called Number column format.

Applying a number format

This section describes how to format numeric data by applying a standard
number format or a custom number format.

How to apply a number format
1 Select a column that contains numeric data.

2 From the context menu, choose Format>Format Data. Number column
format appears, as shown in Figure 3-14.

Number column format 2
Format Mumber as: Currency shis
Symbol: 5 A

Symbol Position: Before >

Decimal Places: 2 o

| Use 1000s Separator:
Negative Numbers: -1234.56 -

2
Figure 3-14 Setting number column format

30 Working with Actuate BIRT Viewers



3  On Number column format, in Format Number as, select a format. For
example, you can format the credit limit column as currency in dollars ($) as
shown in Figure 3-14. Select the appropriate options from the remaining
drop-down lists on Number column format. Choose OK.

You can select a standard format or define a custom format. Standard and
custom formats are described in the next sections.

Selecting a standard number format

Table 3-1 shows the standard number formats that Interactive Viewer supports.
The examples in the table reflect the English (United States) locale. If you work in
a different locale, the data displays differently. For example, a number that
appears as 1352.45 in the English (United States) locale appears as 1352,45 in the
French (France) locale.

Table 3-1 Standard number formats

Format Example of data display

General Number 6066.45 or 6066.5 or 6067, depending on the original
value. This format displays up to two decimal places.
Whole numbers and numbers with one or two decimal
places appear in their original format.

Currency $6,067.45 or ¥6067 or 6067€, depending on the symbol,
symbol position, decimal place, and thousands separator
values that you set.

Fixed 6067 or 6067.5 or 6,067.45, depending on the decimal
place and thousands separator values that you set.

Percent 45% or 45.8% or %45, depending on the symbol position
and decimal place values that you set. This format
multiplies the original value by 100 and adds the percent
(%) symbol.

Scientific 2E04 or 2.67E04, depending on the decimal place value
you set. The number after the E represents the exponent
of 10. For example, 2.67E04 means 2.67 multiplied by 10
raised to the fourth power.

Defining a custom number format

You can define a custom number format using special symbols to construct a
format pattern. A format pattern shows where to place currency symbols,
thousands separators, decimal points, or commas. Table 3-2 shows examples of
custom format patterns and their effects on numeric data.
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Table 3-2 Results of custom number formats

Format pattern Data in the database Result of formatting
0000.00 12.5 0012.50
124.5 0124.50
1240.553 1240.55
#.000 100 100.000
100.25 100.250
100.2567 100.257
S 2000.00 $2,000
20000.00 $20,000
ID # 15 ID 15

Applying a date-and-time format

You can choose from several common formats to display date-and-time data. You
can, for example, display dates as January 19, 2008 11:00:00 AM PST; Jan 19, 2008;
or 1/19/08, and so on. This section describes how to select standard and custom
date-and-time formats.

How to apply a date-and-time format
1 Select a column that contains date-and-time data.
2 From the context menu, choose Format>Format Data.

3  On Date column format, select one of the formats from the list. You can select a
standard format or define a custom format. The standard and custom formats
are described in the next sections.

m If you select a standard format, proceed to step 4.

m If you select a custom format, specify a format code in the next drop-down
list, then proceed to step 4.

4 Select a locale from the next drop-down list.
Choose OK.

Selecting a standard date-and-time format

Table 3-3 shows the supported standard date-and-time formats. The examples in
the table reflect the English (United States) locale. If you work in a different
locale, the date displays differently. For example, a date that appears as March 5,
2008 in the English (United States) locale appears as 5 mars 2008 in the French
(France) locale.
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Table 3-3

Standard date-and-time formats

Format

Example of data display

General Date
Long Date
Medium Date
Short Date
Long Time
Medium Time
Short Time

March 5, 2008 4:42:00 PM PDT

March 5, 2008
Mar 5, 2008

3/5/08

4:42:00 PM PDT

4:42:00 PM
16:42

Defining a custom date-and-time format

You can define a custom date-and-time format using special symbols, shown in
Table 3-4, to construct a format pattern. Use custom date formatting only for
reports viewed in a single locale. Custom formats always display dates in the
format you set, which can be inappropriate in other locales. For example, if you
use the format MM-dd-yy, the date January 10, 2006 always appears as 01-10-06,
regardless of the locale in which you view the report. For locales that customarily
display dates in date-month-year format, Interactive Viewer interprets the date
01-10-06 as October 1, 2006.

Table 3-4 Symbols for defining custom date-and-time formats
Symbol Description Example
vy Short year 08
VYYY Long year 2008
MM Month as a number 07
MMM Short month name Jul
MMMM Full month name July
d Day in month 10
\ Week in month 2
w Week in year 28
DD Day in year 192
E Short day of week Thu
EEEE Long day of week Thursday
H Hour in day (0 - 23) 0

(continues)
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Table 3-4 Symbols for defining custom date-and-time formats (continued)

Symbol Description Example

k Hour in day (1 - 24) 24

K Hour in AM/PM (0 - 11) 0

h Hour in AM/PM (1 - 12) 12

a AM/PM 12:00:00AM
mm Minutes 30

ss Seconds 55

Table 3-5 shows examples of custom formats and their effects on a date stored as
April 15, 2006 12:15:30 PM in the database.

Table 3-5 Results of custom date formats
Format pattern Result of formatting
MM-dd-yy 04-15-06
E, M/d/yyyy Fri, 4/15/2006
MMM d Apr15
MMMM April
yyyy 2006
\W 3 (the week in the month)
w 15 (the week in the year)
DD 105 (the day in the year)
h:mm:ss 12:15:30

Applying a Boolean format

A Boolean expression evaluates to True or False. For example, consider a
calculated column displaying values for the following expression:

ActualShipDate <= TargetShipDate

If the actual ship date is before or on the target ship date, the expression evaluates
to True. If the actual ship date is after the target ship date, the expression
evaluates to False. If you do not format a column of Boolean data type, the
column displays the values True and False. To specify different labels, select the
column, and from the context menu, choose Format->Format Data. Type the new
labels on Boolean column format, as shown in Figure 3-15.
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Boolean column format x
Faor "True”, show: on Time

For "False", show:
Delayed

g
Figure 3-15 Specifying display values for True and False

Applying a string format

You can format string data to correct text that contains inconsistent capitalization,
or to include characters, such as a space or a punctuation mark, at a specific place
in the string. For example, you can display United States telephone numbers in
one of the following formats:

(415) 555-2121
415.555.2121
415-555-2121

This section describes how you can select a standard string format, and how you
can define a custom string format for data in a report.

How to apply a string format
1 Select a column that contains string data.
2 From the context menu, choose Format>Format Data.

3 On String column format, select one of the formats from the list. You can select
a standard format or define a custom format. Standard and custom formats
are described in the next sections.

Choose OK.

Selecting a standard string format

Table 3-6 describes the string formats that you can choose and illustrates how the
formatted data appears.

Table 3-6 Standard string formats
Format Description
Lowercase The string displays in all lowercase, for example:

john smith

Uppercase The string displays in all uppercase, for example:
JOHN SMITH
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Defining a custom string format

You can define a custom string format using special symbols to construct a format
pattern. Table 3-7 describes these symbols.

Table 3-7 Symbols for defining custom string formats
Symbol Description
@ Character placeholder. Each @ character displays a character in

the string. If the string has fewer characters than the number of
@ symbols that appear in the format pattern, spaces appear.
Placeholders are filled from right to left, unless you specify an
exclamation point (!) at the beginning of the format pattern.
See Table 3-8 for examples.

& Same as @, except that if the string has fewer characters, spaces
do not appear. See Table 3-8 for examples.

! Specifies that placeholders are to be filled from left to right. See
Table 3-8 for examples.

Converts string characters to uppercase.

Converts string characters to lowercase.

Table 3-8 shows examples of custom string format patterns and their effects on

string data.
Table 3-8 Results of custom string formats
Format pattern Data in the data source Results of formatting
(0eR) cer-ecere 6175551007 (617) 555-1007
5551007 () 555-1007
(&&&) &&&-&&&& 6175551007 (617) 555-1007
5551007 () 555-1007
(Qee) cee-cree 6175551007 (617) 555-1007
5551007 (555) 100-7
N(&&&) &&&-&&&& 6175551007 (617) 555-1007
5551007 (555) 100-7
(@ee) @@@-@RA@ + ext9 5551007 (655) 100-7 +ext9
((&&&) &&&-&&&& + ext9 5551007 (555) 100-7 + ext 9
>& & &-& & & & &-&& D1234567xy D12-34567-XY
<&&&-&&&&&-&& D1234567xy d12-34567-xy
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Reverting to default formats

To revert a data column back to its default font formats, select the column. From
the context menu, choose Format>Font. Select Auto from each drop-down list.
To reset text alignment, select the element, and choose the appropriate alignment
option.

If you applied a number, date-and-time, or string format to a column of data, you
can restore these formats to those in the original report. Select the column. From
the context menu choose Format>Format Data. Then, select Unformatted from
the drop-down list.

Copying a format to other columns

When working with columns of similar data types, you can apply a format to
data in one column, and copy the format to data in other columns. For example,
consider a simple report that lists price of each (sale price), profit, and revenue for
products sold in a region. If you format the price of each column as currency in
US dollars, you can copy this format for data in the profit and revenue columns,
so that all amounts are formatted as currency in US dollars, in one simple step.

How to copy a data format

-

w=| 1 Select the column containing the formatting properties you want to share.
From the context menu, choose Format>Copy Format.

Copy Format appears, as shown in Figure 3-16.

Copy Format x

Customer
Phone
City

Zip Code

Coc (o] @

Figure 3-16 Sharing font and alignment properties with other columns

2 Select the column to which you want to copy the current formatting
properties. To select multiple columns, press Ctrl, then select each column.

Choose OK. The report displays the copied formatting properties in the
specified columns.
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Editing column and group headers

Column and group headers are label elements that contain static text. In a typical
report, some labels are editable, while others are not. Examples of labels you can
edit include report titles or author names. Examples of non-editable labels
include standard copyright or confidentiality statements.

You can change the content of the column header by choosing the Header option
from the context menu. You can modify properties such as the font, the font size,
the background color, and so on. You can also edit the text of the label.

How to edit a header

1 Select the column. To delete existing text, choose Header>Change Text from
the column menu, as shown in Figure 3-17. Type the text to display and press
Enter. The edited text appears on the header.

|_'/£_'| Change Text
Alignment 3

A Font

Figure 3-17 Modifying column labels

2 Select the column. From the column menu, choose Header>Alignment, or
Header>Font and modify the properties as needed.
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Exporting report data
and content

This chapter contains the following topics:
m About exporting options
m Exporting report data

m Exporting content
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About exporting options

The BIRT Viewers enable you to export report data, report content, and elements,
such as charts, cross tabs, or summary tables, to various formats. You can export
data to several flat file formats that can be read by Excel. In addition, the BIRT
Viewers use various emitters to enable you to export content, as well as elements
to formats such as Excel, Word, PowerPoint, PostScript, and PDF.

When you export content, or elements to other formats, each emitter such as the
PDF emitter or the Excel emitter provides several options that you can select to
maintain the existing properties of the exported content, enabling users to easily
perform additional analysis on the exported output. For example, when you
export an element such as a cross tab to Excel, the Excel emitter supports
exporting the content as a pivot table. This feature is specifically useful for
sharing content with users without access to the BIRT Viewers, who can still
analyze the output in Excel. You can also export a Flash chart to PDF format. The
PDF emitter embeds the chart in the output file, retaining existing animation
properties. You can modify the output file, based on the options available in that
application. This section discusses the exporting options available when
exporting report data or report content using the BIRT Viewers.

Exporting report data

You export report data to extract some or all of the data from a report, to use the
data in another document, or format. For example, you can export customer sales
data from a previous quarter, then use the numbers in a spreadsheet to create a
forecast for an upcoming quarter.

The viewers support the ability to export report data as a comma-separated
values (.csv) file, a pipe-separated values (.psv) file, a tab-separated values (.tsv)
file, or a semicolon-separated values (.ssv) file. These files store data in a flat file
format, which Excel can read. The difference between these formats is the
character used as the data delimiter, which can be a comma, pipe, tab, or
semicolon. You choose a format to export report data based on the requirements
of the application to which you export the data, and the purpose for which you
plan to use the exported data. You can also export data from BIRT Dashboard
gadgets to these flat file formats.

L

Once you choose a format to export the data, Excel displays the exported data in a
spreadsheet. You can now resize columns and format the data as you would do
for any other spreadsheet.

When you export data, you cannot export a table or chart element, but you can
export the data displayed in both these elements.
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How to export datain comma-separated values file (.csv) format

1 From the main menu, as shown in Figure 4-1, choose Export Data.

| Enable Interactivity

Save Design
Save Document
(=) Print
|2 Export Content

| = Export Data

|=| Parameters

|&| Toc

Hide/Show Item

f/ Link to this page

2| Help

Figure 4-1 Exporting report data

2 On Export Data, Available ResultSets lists the report elements, such as tables,
charts, cross tabs, Flash charts and gadgets, and so on, that contain data. Select
an element from which to export data. The names on the list are internal
names. For example, a report table element begins with the prefix ELEMENT,
and is listed as ELEMENT_50, ELEMENT_65, and so on.

3 Available Columns lists the columns you can export from the specified table.
You can export any of the data the report uses, including the data in aggregate
rows and calculated columns. In Available Columns, select the columns to
export one by one and choose the single right arrow after each selection, as
shown in Figure 4-2. To select all columns, choose the double right arrow.

To deselect a column, choose a column from Selected Columns, then choose
the single left arrow. To deselect all the selected columns, choose the double
left arrow.

4 In Encoding Style, select UTF-8, or specify a style in Other. If you do not
specify a style, Actuate BIRT Viewer uses the local encoding style.

5 In Miscellaneous, specify the following information:

»  In Maximum Rows, type the maximum number of data rows to export. To
export all the data rows in the report, accept the default value of No Limit.

m In Values Separator, choose the Comma (CSV) delimiter.
= In Localize Column Name, select an option from the following;:

o Select Export Column Name to export the column name specified in the
data source.

o Select Export Column Display Name to export the column name
specified in the report design.
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Export Data X

Available ResultSets: ELEMENT_65 7

Available Columns: Selected Columns:
CITY
CONTACTFIRSTNAME
CONTACTLASTNAME
COUNTRY
CREDITLIMIT
CUSTOMERNAME
PHOMNE

POSTALCODE

a v

Encoding Style
@ UTF-38
() Other
{if blank, use the local encoding)
Miscellaneous
Maximum Rows Ne Limit
Values Separator Comma { C5V ) hd

Localize Column Mame Export Column Name hd

[ Export Column Data type [ Export Locale Meutral format

Export Column Header [7] Export Data with Carriage return
2
Figure 4-2 Exporting report data

o Select Export Column Name and Display Name to export the column
names specified in the data source as well as the one specified in the
report design.

6 You can select the following additional options to export column data type,
export the data in locale neutral format, and export the column header.

= When you export report data to a flat file format, such as comma-separated
values (.csv) format, tab-separated values (.tsv) format, pipe-separated
values (.psv) format, or semicolon-separated values format, select Export
Column Data Type to include the data type information in the flat file. In
the following example, the second line identifies the type of data in the file:

FirstName, LastName, AccountID
STRING, STRING, INT
"Doe", Jane", 1234 ..

= When you export report data that contains date-and-time values, the
Actuate BIRT Viewers format these values according to the syntax in the
current locale, by default. If no locale is configured, then the viewers use
the US locale as the default. For example, if you export the date
01/10/2009 in the original format, it can be interpreted as January 10, 2009
or October 1, 2009, depending on whether the locale is US or France. On
Export Data, select Export Locale Neutral Format to export report data
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without considering locale information, so that the date is interpreted
correctly in every locale.

m  When you select Export Column Header, Actuate BIRT Viewer exports the
column header in addition to the data in the column. The spreadsheet
displays each exported column below the corresponding column header.

m  When you select Export Data With Carriage Return, the BIRT Viewers
export the data using a Carriage Return (CR) character for each line break.

Choose OK.

On File Download, the default name and the file extension of the spreadsheet
file appear.

Choose Save.
On Save As, complete the following tasks:
1 In Save in, navigate to the folder in which you want to save the file.

2 In File name, change the name of the file. Choose Save. The
comma-separated values (.csv) file appears in the new location.

When you open the file, the output data appears as an editable Microsoft Excel
worksheet. You can expand the columns to view all the data.

Use the same process to export data to pipe-separated values (.psv) files,
tab-separated values (.tsv) files, and semicolon-separated values (.ssv) files.

Exporting content

You can export an entire report, as well as each individual report element, such as
a chart, summary table, or cross tab, to several different formats. Exporting
content to one of these formats creates a file that can be used by applications other
than the viewers.

In the BIRT Viewers, you can export report content to the following file formats:

Advanced Function Printing (.afp)
Microsoft Excel (.xls)

Microsoft Excel (.xIsx)

PDF (.pdf)

PostScript (.ps)

Microsoft Word (.doc)

Microsoft Word (.docx)
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m  Microsoft PowerPoint (.ppt)
m  Microsoft PowerPoint (.pptx)

The following sections describe the available formats, as well as the options
available when exporting content to each format.

Exporting content to AFP format

You can use the BIRT Viewers to export a BIRT report, selected pages of a BIRT
report, or a specific report element such as a chart, or cross tab, to Advanced
Function Printing (AFP) format. AFP is a print stream technology that supports
high-volume printing on high-capacity, and high-speed printers. If your
enterprise generates large reports that require hard-copy printing, using AFP is a
significantly more efficient option than exporting the report to PDF, or Word
format, and then printing the report.

The AFP emitter enables you to specify several layout options as well as image
rendering options for the exported content using the Export Content dialog box.
You can set the following layout and resolution options:

m DPagerange

Specify the number of pages to export if you are working with a multipage
report design or document file.

m Chart DPI
Specify the DPI at which the chart engine exports the chart component.

m  Plex Mode
Enables you to specify the sides of the page on which to print.

= Simplex
Selecting this option prints on a single side of the page

m  Duplex
Selecting this option prints on both sides of a page.

= Tumble

Selecting this option prints the file as a continuous document. To navigate a
printed document that uses this option, flip each page over longitudinally
such that the end of the previous page becomes the top of the next page.

The AFP emitter provides several color options to optimize the quality of the
exported images based on the native image format supported by the printer in
use. You can select any of the following color options depending on the native
image format supported by the printer you are using:

m  Allow black and white images
Selecting this option, exports existing black and white images.
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= Allow single color images
Selecting this option, exports existing single-color images.

m  Allow grayscale images
Selecting this option, exports existing grayscale images.

m  Allow full color RGB images
Selecting this option, exports existing full-color RGB images.

= Allow full color CMYK images
Selecting this option exports existing full-color CMYK images.

The AFP emitter’s available image format options enable users to closely control
how images are rendered in the exported output. All images are transcoded to the
closest format that corresponds to the options selected by the user. To preview the
exported output before it is sent to a printer, download the AFP Viewer plug-in
and view the resulting output in your web browser.

How to export a report or report element to AFP format

1 To export a report, or report element, such as a cross tab, or a chart, choose
Export Content from the main menu, as shown in Figure 4-3. Export Content
appears.

BT | Enable Interactivity

= Print
[ Bxport Content
|2 Export Data

|=] Paramaters

[E] Toc

Hide/Show Ttem

55'/ Link to this page
17 Help
Figure 4-3 Exporting a report

On Export Content, in Export Format, select Advanced Function Printing
(AFP) from the list, as shown in Figure 4-4.

2 Select Page Settings. In Page Settings, specify which of the following options
to apply to the exported AFP file:

s Pagerange

If you do not specify a value in this field, the BIRT Viewers export all the
pages in the current report design. If you are exporting a report
component, leaving this field blank exports only the selected component.
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m Chart DPI

If exporting a chart, specify the export resolution DPI. If you do not specify
a value, the BIRT Viewers export the chart using the value 192 DPL

m Page DPI
Select an option from the list. if you do not specify a value, the BIRT
Viewers use the value 240 DPL

m Plex Mode
Specify one of the following plex modes for the exported file:

o Simplex
o Duplex

o Tumble
m Allow black and white images
= Allow single color images
= Allow grayscale images
= Allow full color RGB images

= Allow color CMYK images
Choose OK.

Export Content x

Export Format: Advanced Function Printing (AF v
« Page Settings

Page range

Chart DPL 192
Page DPI 240 >
Plex Mode Simplex v

Allow black and
white images

Allow single color
images

=l

Allow grayscale
images

=l

Allow full color RGB
images

Allow color CMYK
images

g =

g
Figure 4-4 Selecting the AFP option

3 File Download appears. The default name assigned to the file and file
extension are visible, as shown in Figure 4-5.
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Do you want to open o save Example_1.afp from localhost? Open | Save | vl Cancel

Figure 4-5 Downloading the exported file
Choose Open or Save.

When you open the file, the content is displayed in your web browser using the
AFP Viewer plug-in, with the options you specified, as shown in Figure 4-6.
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Figure 4-6 Previewing the exported report design in a web browser

Exporting content to Microsoft Excel

You can use the BIRT Viewers to export a BIRT report, selected pages of a BIRT
report, or a specific report element such as a chart, or cross tab, to Microsoft Excel,
Excel 2007, and Excel 2010. When exporting content to Excel 2010, we recommend
that you use the XLSX format in order to avail several features supported only in
XLSX format, and to avoid compatibility issues that occur when using Microsoft
Oftfice 2010. The exported content in either version of Excel has exactly the same
layout as the HTML page. In addition, all versions of Excel support the following
properties:

m Formulas used in computed columns and aggregations in the existing report
or report element are maintained in Excel format. When exporting a BIRT
report created in Actuate BIRT Designer Professional that contains expressions
that use EasyScript, you can also export live formulas for the expressions to
Excel.
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m Regular BIRT charts with a single series are exported to Excel as editable Excel
charts.

m Exported images are displayed in Excel.
m Cross tabs are exported to pivot tables in Excel.

Each output Excel document contains one content sheet, and one or more data
sheets. If you are exporting a report containing a table view, and a chart view of
data, exporting the chart view of the report to Excel results in the exported output
displaying the chart. Similarly, if you export the table view to Excel, Excel
displays tabular data.

You can set the following additional options:

m Export regular BIRT charts in the report as an image. If you select this option
the Excel emitter does not allow you to edit the chart in Excel. To allow users
to edit the chart as needed, deselect this option. When deselected, the chart
appears in Excel, as shown in Figure 4-7, and can be edited.

A| B C D E F G H 1 i8 L I O PCRT U
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5 EMEA $1,019,987 $808,717 -219% O

& Austria $49,234  $52,420 6% [
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8 salzhurg $49,234 £52,420 6% [
Figure 4-7 Exporting a chart to Excel

m Specify the output DPI for regular charts, to view the exported image in
higher resolution. Increasing the DPI value can result in a larger output file
size. If you do not modify this field, the BIRT Viewers export the chart at
192 DPL

m Specify exporting live formulas for BIRT reports containing expressions
created using EasyScript.
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To hide grid lines in the resulting spreadsheet, select hide grid lines. Hiding
grid lines modifies the appearance of the output data in such a way that it
resembles the report viewed in the BIRT Viewers more than it does a
spreadsheet.

To view report output on multiple sheets, select this option. Selecting this
option does not maintain pagination properties when you export a multipage
report.

Select Enable Pivot table, when you export a cross tab to Excel. When selected,
this option enables Excel to display cross-tab data as a pivot table providing
the user with the ability to further analyze the data. Figure 4-8 shows a cross
tab exported to Excel.

A B c D E F G H | J =

1 Breakdown of annual sales by quarter by geography E
2 Year |v | Data

3 2003 2004 2005 Total ORDERED Total TotalSales

4 |GOUNTRY v | GITY ORDERED TotalSales ORDERED TotalSales ORDERED TotalSales

5 | = Australia Ghatswood 266 24013.521 803 67642.094 532 4225151 1601 $133,907.13

3 Glen WavErlv 447 35505.631 94 941513 16 10945.26 705 $55,866.02
Il Melbourne 591 53429.114. 1335 127155.965 1926 $180,585.08

8 North Sydney 874 80101.925 595 56932.302 1469 $137,034.23

3 South Brisbane 336 33757851 209 21432.312 545 455,190.16
10 | Australia Total 2514 226808.042 2232 204213.189 1500 131561.384 6246 $562,582.62
11 | = Austria Graz 430 42252.872 10z 8807 .12 532 $51,059.99
12 Salzhurg 442 35626.33 491 49233.672 509 52420.071 1442 $137,480.07
13 | Austria Total 872 78079.202 491 49233.672 611 61227.191 1974 $188,540.07
14| = Belgium Bruxelles 685 62253.853 111 8597.73 796 $70,851.58 v
H 4 F M| Report K [ ] vl
Figure 4-8 Excel displaying an exported cross tab

This feature is useful when you need to share the cross tab with users using
applications other than the BIRT Viewers. More information about cross tabs is
available in later sections of this document.

How to export a report or report element to Excel

1

To export a report, or report element, such as a cross tab, or a chart, choose
Export Content from the main menu, as shown in Figure 4-9. Export Content
appears.

On Export Content in Export Format, select Excel, as shown in Figure 4-10.
Select Page Settings. In Page Settings, provide the following information:
1 Select the page range, or specify the page numbers that you want to export.

2 Select Text wrapping to eliminate the need for horizontal scrolling in the
exported report.

3 Select Enable pivot table to export the report as a pivot table, to facilitate
data analysis in Excel.

4 Select Auto adjustment for pivot table, to enable the BIRT Viewers to
automatically adjust the content for display in a pivot table.
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5 If exporting a regular BIRT chart:

Specify the DPI at which the chart is exported. If you do not specify a
value, the BIRT Viewers export the chart at 192 DPL

To export each chart as an image, select this option.

6 Select Enable live formulas, to export live formulas when exporting content
from a BIRT report that contains expressions created using EasyScript.

7 Select Hide grid lines.
8 To export the output to multiple sheets, select this option.
Choose OK.

BT | Enable Interactivity

Save Design
Save Document
(=) Print
i Export Content
|2 Export Data

|=] Paramaters

[E] Toc

Hide/Show Item

55'/ Link to this page

|i| Help
Figure 4-9 Exporting a report
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Export Format: Excel (XL5) v

+ Page Settings
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Output to multiple
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Figure 4-10 Exporting content to Excel
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4 File Download appears. The default name assigned to the file and file
extension are visible. Choose Open or Save.

When you open the file, the report displays in Excel, and can be edited as
needed.

Exporting content to PDF format

You can export report content or report elements, such as charts, or cross tabs, to
PDF format. The PDF emitter in the BIRT Viewers provide consistent layout, and
pagination properties between PDF and HTML output formats. The PDF emitter
also produces a high-quality PDF file, with a small file size. In addition it
provides high quality images for charts, and scalable vector graphics (SVG)
format in PDF output. The available customization options are described in the
following section.

You can also export Flash charts and Flash gadgets to PDF format. When you
export Flash charts and gadgets to PDF format, the BIRT Viewers support
embedding the exported element in the PDF file, enabling you to easily interact
with the Flash elements. Flash charts and gadgets retain their animation
properties when exported to PDF format.

When you print an exported Flash chart or gadget, the embedded file in the PDF
document, must be viewed in order for it to appear on the printed page. In a
multipage report with Flash content on several pages, view each page, so that the
embedded Flash elements are loaded, and then print the required pages for the
Flash content to be visible in the printed output. If you do not view the pages
before printing the file, the Flash content is not visible in the printed output, for
pages that were not viewed.

More information about charts, Flash charts and Flash gadgets is available in later
sections of this document.

How to export a report or report element to PDF format
1 Choose Export Content from the main menu. Export Content appears.
2 On Export Content in Export Format, select PDF.
Export content appears, as shown in Figure 4-11.
3 Select Page Settings. In Page Settings, complete the following steps:
1 Select the page range, or specify the page numbers that you want to export.
2 Select a layout for the exported file from the Page style menu.

3 When a report contains languages that are read from left to right, such as
English or French, and those that are read from right to left, such as
Hebrew or Arabic, the text from both languages can be presented in the
same report in the appropriate direction. This text is called bidirectional
(BIDI) text. Select BIDI processing if you have a report in two or more such
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languages and need the data to be correctly presented in the PDF or

PostScript output.
Export Content xX
Export Format: POF hd

+ Page Settings

Page range

Fage style Auto —
BIDI processing

Text wrapping

Text hyphenation  [7]

Font substitution

Embedded font

Chart DPL 192

Render chart in

vector graphics

.

Figure 4-11 Selecting options to export a report

4 Select Text wrapping to eliminate the need for horizontal scrolling in the
exported report.

5 Select Text hyphenation, if necessary.

6 Select Font substitution to substitute any fonts that the application cannot
interpret. Font substitution is the process of using one font in place of
another when the original font is not available. The classification of fonts
into families enables the process of font substitution. For example, it
ensures that only a sans serif font replaces another sans serif font.

7 Select Embedded font to embed a font currently being used, in the
exported output.

8 Enter a value in Chart DPI, specifying the resolution at which to display
the chart, if the report you are exporting contains one or more charts. A
higher DPI results in a larger file size. If you do not specify a DPI, the chart
engine exports the image with a DPI value of 192.

9 Select Render chart as vector graphics for existing charts in SVG format.
This option for SVG images improves the resolution of the exported image,
while maintaining a smaller file size.

Choose OK.

File Download appears, as shown in Figure 4-12. The default name assigned to
the file and the file extension are visible. Choose Open or Save.
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Figure 4-12 Exporting data
When you open the file, the report displays as a PDF document.

Exporting content to PostScript format

When you export content to PostScript format, the PostScript emitter displays the
content in the output file, almost exactly the same way as it will appear when
printed. The PostScript emitter provides the same options as the PDF emitter,
with two exceptions:

m The option to export SVG images as vector graphics is not supported.

m The option to embed fonts from the report being exported is not supported.

How to export areport or report element to PostScript format

1 Choose Export Content from the main menu. Export Content appears.

2 On Export Content in Export Format, select PostScript.

3 Select Page Settings. In Page Settings, specify the following information:
Page range.

Page style.

Enable BIDI processing.

Enable text wrapping.

Enable font substitution.

oS 01 A WON P

If exporting a chart, specify the export DPL If you do not specify a value,
the BIRT Viewers export the chart at 192 DPI.

7 Select Fit to Paper to enable the PostScript emitter to format the report
according to the size of the paper in use.

Choose OK.

4 File Download appears. The default name assigned to the file and file
extension are visible. Choose Open or Save.

When you open the file, the report displays in the format you specified.

Exporting content to Microsoft Word

The BIRT Viewers support exporting content to Microsoft Word, Word 2007, and
Word 2010. When exporting content to Word 2010, we recommend that you use
the DOCX format in order to avail several features supported only in DOCX
format, and to avoid compatibility issues that occur when using Microsoft
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Office 2010. To export content to either version of Word, on Export Content,
specify the following information:

m Page range for the content you want to export

m If exporting a chart element, the DPI or resolution

How to export a report or report element to Word format
1 Choose Export Content from the main menu. Export Content appears.
2 On Export Content in Export Format, select Word or Word 2007.
3 Select Page Settings. In Page Settings, specify the following options:
1 A page range.

2 If exporting a chart, specify the export DPL. If you do not specify a value,
The BIRT Viewers export the chart at 192 DPIL

Choose OK.

4 File Download appears. The default name assigned to the file and file
extension are visible. Choose Open or Save.

When you open the file, the report displays in the Word format you specified.

Exporting content to Microsoft PowerPoint

The BIRT Viewers support exporting content to PowerPoint, PowerPoint 2007,
and PowerPoint 2010 formats. When exporting content to PowerPoint 2010, we
recommend that you use the PPTX format in order to avail several features
supported only in PPTX format, and to avoid compatibility issues that occur
when using Microsoft Office 2010. To export content, or a report element to either
PowerPoint version, specify the following information on Export Content:

m Pagerange

m Page style

= BIDI processing
m Text wrapping

= Font substitution
m Chart DPI

How to export areport or report element to PowerPoint format
1 Choose Export Content from the main menu. Export Content appears.

2 On Export Content in Export Format, select PowerPoint or PowerPoint 2007.
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3 Select Page Settings. In Page Settings, specify the following information:

1

o 01~ WN

Page range.

Page style.

Enable BIDI processing.
Enable text wrapping.
Enable font substitution.

If exporting a chart, specify the export DPL If you do not specify a value,
the BIRT Viewers export the chart at 192 DPI.

Choose OK.

4 File Download appears. The default name assigned to the file and file
extension are visible. Choose Open or Save.

When you open the file, the report displays in the PowerPoint format you
specified.
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Organizing data
In areport

This chapter contains the following topics:

About displaying and organizing report data
Modifying the width of a column

Managing a column

Sorting data

Organizing data in groups

Aggregating data

Hiding and displaying report elements
Specifying page breaks

Chapter 5, Organizing data in a report
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About displaying and organizing report data

Interactive Viewer enables you to organize report data in several ways. You can
change the width of columns, and move and remove columns to improve
presentation or change the order of data in a report.

You can sort data in a column in ascending or descending order, organize data
columns into groups, and create aggregate data values. You can create aggregate
data, at the end of a customer group, for example, by displaying the total amount
of a customer’s purchases or the average amount of each order. You can also
create calculations, such as sums, standard deviations, rankings, and differences.

You can also use Interactive Viewer to change group and column headers, and to
customize pagination in a multipage report by defining page breaks before or
after groups. A group displays all the information about an item category in one
place. For example, you can display all the information about one customer, then
all the information about the next customer, and so on. You can display the
information for customers and their orders by grouping the information by
product, or you can display a company’s sales by geographical region.

You can hide columns, as well as report elements based on your needs. You can
also hide duplicate data rows in a column, or a group. This document describes
these tasks in more detail.

Modifying the width of a column

In addition to modifying the alignment and text properties of column data, you
can optimize the layout of a report by adjusting the width of report columns
according to the space occupied by column data.

For example, Figure 5-1 and Figure 5-2 show two reports. In Figure 5-1, the report
uses the default column width. In Figure 5-2, the same report is modified to
optimize its column width. As the example shows, the report in Figure 5-2 looks
neater, and eliminates wasted space when you print, or export the content to
other formats.

-] Australia
Australian Collectors, Co. Ferguson Peter
Anna's Decorations, Ltd O'Hara Anna
Souveniers And Things Co. Huxley Adrian
Australian Gift Network, Co Calaghan Ben
Australian Collectables, Ltd Clenahan Sean
S Austria
Salzburg Collectables Pipps Georg
Mini Auto Werke Mendel Roland
Figure 5-1 Viewing a report with the default column width
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-] Australia
Australian Collectors, Co. Ferguson Peter
Anna's Decorations, Ltd O'Hara Anna
Souveniers And Things Co. Huxley Adrian
Australian Gift Metwork, Co Calaghan Ben
Australian Collectables, Lid Clenahan Sean
] Austria
Salzburg Collectables Pipps Georg
Mini Auto Werke Mendel Roland
Figure 5-2 Viewing a report with the modified column width

How to modify column width

Select the column. Place the cursor on the right or left border of the highlighted
column. Using the cursor, drag the border inwards or outwards to increase or
decrease the width of the selected column.

Managing a column

This section describes how to use Interactive Viewer to change the order of
columns in a report, delete report columns that are not necessary, hide existing
columns, and display hidden columns. When you delete a column from the
report, you cannot insert it back into the report design at a later time. If you might
have a need for data in the column later on, you can hide the column, and display
it whenever necessary.

How to reorder columns

You can move columns to change the order of columns in a report table in one of
the following ways:

m  Choose the column to select it, then drag the column from its original location,
and drop it in a new location, whose position is indicated by an arrow that
appears on the top of the column label.

m  Choose Column>Move To Left from the context menu to move the column to
the left of the previous column.

m  Choose Column>Move To Right from the context menu to move the column
to the right of the column next to it.

m Alternatively, complete the following steps to move a column:

1 Select the column. From the context menu on the column toolbar, choose
Column~>Reorder Columns. Arrange Columns appears, as shown in
Figure 5-3.
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Figure 5-3 Arranging columns in Interactive Viewer

2 In Available Columns, select the column to move. Choose the up or down
arrow on the right until the column is in the correct position. Moving a
column up in the list, moves it to the left in the report. Moving a column
down in the list, moves it to the right in the report. Choose OK.

How to remove one or more columns from the report

@ To remove a column, select the column and press Delete. You can also select the
column, then choose Column->Delete Column from the context menu.

To remove multiple columns, press Ctrl when selecting columns. Then, use the
previously described method to delete the columns from the report.

How to hide a column

Select a column. From the context menu choose Column>Hide Column.
Interactive Viewer displays the report without the selected column.

How to display a hidden column

Iﬂ Select a column. From the context menu, choose Column>Show Column. Show
columns appears listing the hidden columns. In Pick Hidden Column, select the
column to display. Choose OK. The column appears in the report.

Sorting data

Sorting data is an important task in creating a useful report. A customer phone
list, for example, is easier to use if it is in alphabetical order. A sales report is more
useful if it presents sales figures from highest to lowest, or the reverse, if you
want to see lowest to highest performers.

You use sorting to display report content in a more meaningful order. For
example, reports often display data in a seemingly random order depending on
the report design. You can sort data in ascending or descending order, and you
can sort by as many fields as needed. For example, you can sort a list of customers
by credit rank, then by customer name.
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Compare the reports in Figure 5-4. The report on the left displays data as in the
original report. The report on the right displays the same data, sorted by country.

France Atelier graphigue: Australia Australian Collectors, Go. 117300
UsA Signal Gifi Stores Australia Anna's Decorations, Ltd 107800
Australia Australian Collectors, Co. Australia Souveniers And Things Co. 93300
France La Rechelle Gifts Australia Australian Gift Metwork, Co 51600
MNorway Baane Mini Imports Australia Australian Collectables, Lid 50300
UsA Iini Gifts Distributors Lid Austria Salzburg Collectables 71700
Poland Havel & Zbyszek Co Austria Mini Auto VWerke 45300
Germany Blauer See Auto, Co. Belgium Petit Auto 79900
USA Mini Wheels Co. Belgium Royale Belge 23500
Figure 5-4 Comparing reports with sorted and unsorted data

You can sort data in ascending or descending order, and you can sort data by
multiple columns. For example, you can sort the data in a report by country, and
then by customer name. Figure 5-5 shows a sample of the results of this sort
action. Countries appear in ascending alphabetical order. For each country, the
customer names appear in alphabetical order.

Anna's Decorations, Lid 107200
Australian Collectables, Lid 60300
Australian Collectors, Co. 117300
Ausiralian Gift Metwork, Co 51600
Souveniers And Things Co. 93300
Mini Auto Werke 45300
Salzburg Collectables 71700
Petit Auto 79900
Royale Belge 23500
Figure 5-5 Customer names sorted in alphabetical order

Sorting on a single column

To sort data on a single column, select the column. Choose the appropriate arrows
to Sort Ascending or Sort Descending from the column toolbar. You can also
choose Sort>Sort Ascending or Sort Descending from the context menu.

Sorting on multiple columns

You can sort data by up to three columns. When you sort by multiple columns,
you use the Advanced Sort option, shown in Figure 5-6. It is important to
understand the order of precedence for a multiple sort action. On Advanced Sort,
select the columns on which to sort, in the order in which you want to sort the
data. For example, to sort data by country first, and then by customer name
within each country, select the columns in that order on Advanced Sort.

How to sort data on multiple columns

1 Select a column. From the context menu, choose Sort>Advanced Sort.

2 On Advanced Sort, in Sort By, select a column from the list, then choose either
Ascending or Descending, as shown in Figure 5-6.

3 Select a second column from the next drop-down list. Choose the sort order.

You can also select a third column on which to sort. Choose OK.
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Advanced Sort x
Sort By:
Customer Country £Ys @ Ascending
() Descending
Then By:
Select a Column » @ Ascending
() Descending
Then By:
Select a Column v @ Ascending
() Descending
)
Figure 5-6 Sorting data on multiple columns

Sorting data in a merged column

When working with merged columns, if you choose Sort from the context menu,
Select Data Item appears, as shown in Figure 5-7, providing a drop-down list of
data items in the merged column.

Select Data Ttem x
Iy i
?
Figure 5-7 Selecting a data item

From the drop-down list, select the item on which to sort data. Choose OK.

You can now sort data in each of the columns, as described in the previous
sections of this document. To modify each line of data in the merged column, you
must repeat this step for each data item, then define the sort order, each time.

Reverting data to its original order

To revert data to its original unsorted order, select a column. From the context
menu, choose Sort>Advanced Sort. On Advanced Sort, for each column specified
for a sort action, choose Select a Column from the drop-down list. Choose OK.

Organizing data in groups

Sorting data makes a report more readable and useful. Sorting is typically only
one of the tasks you perform when organizing data in a report. It is common for
reports to present data that is organized into meaningful groups, especially
reports that contain large amounts of data. Consider the task of listing every item
a corporation owns, along with information such as the category, purchase price,
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purchase date, inventory code, location, and supplier. If a report presents all these
items in an unorganized list or sorted list, it is not possible to determine how
much the corporation spends, for example, on office furniture or computer
hardware because this information cannot be easily calculated. The report cannot
provide information such as which year had the most purchases, or which items
are located in a field office and which items are in the warehouse.

To organize all this information into a useful inventory report, you create data
groups. Data groups contain related data rows. For example, you can create a
report that lists items by category—all office furniture in one group, all computer
hardware in another group, all computer software in a third group, and so on. For
each group, you can calculate aggregate data, such as the total purchase price or
count of items in a group. Organizing data in groups makes it easier to compare
and analyze information.

Compare the reports in Figure 5-8 and Figure 5-9. The report in Figure 5-8
displays customer information in a simple list. The data rows are sorted by
country. Notice the repeated country names in the first column.

Australia Australian Collectors, Co. Ferguson Peter 03 9520 4555
Australia Anna's Decorations, Ltd O'Hara Anna 02 9936 8555
Australia Souveniers And Things Co. Huxley Adrian  +61 2 9495 8555
Australia Australian Gift Network, Co Calaghan Ben 61-7-3844-6555
Australia Australian Collectables, Ltd Clenahan Sean 61-9-3844-6555

Austria Salzburg Collectables Pipps Georg 6562-9555

Austria Mini Auto Werke Mendel Roland 7675-3555
Belgium Petit Auto  Dewey Catherine (02) 5554 67
Belgium Royale Belge Cartrain Pascale  (071) 23 67 2555

Figure 5-8 Report with data sorted by country

The report in Figure 5-9 shows the same data. Unlike the previous report, this
report groups the rows by country, removing the repeated entries.

= Australia
Australian Collectors, Co Ferguson Peter 03 9520 4555
Anna's Decorations, Ltd O'Hara Anna 02 9936 8555
Souveniers And Things Co Huxley Adrian +61 2 9495 8555
Australian Gift Network, Co Calaghan Ben  61-7-3844-6555
Australian Collectables, Ltd Clenahan Sean  61-9-3844-6555
= Austria
Salzburg Collectables Pipps Georg 6562-9555
Mini Auto Werke Mendel Roland T675-3555
= Belgium
Petit Auto  Dewey Catherine (02) 5554 67
Royale Belge  Carirain Pascale (071)23 67 2555
Figure 5-9 Report with data grouped by country

A report that groups data provides a more effective way to view data. When you
group data, you can:

m Add subtotals, counts, averages, or other aggregate information at the
beginning or end of each group.
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m Insert a page break before or after each group to start each data group on a
new page.

m Hide the details of each group to view a summary report.

In addition, Interactive Viewer performs the following actions when you group
data:

m  Removes duplicate values for each group.

m Sorts the values of each group. For example, a country group displays the
countries in alphabetical order, as shown in Figure 5-9.

m  Generates a table of contents that displays the values of every group when you
view the finished report in the viewers. The table of contents allows you to
navigate to specific locations in the report. This feature is particularly useful
when a report contains many pages.

How to group data

=8l Select the column that contains the values to group. From the context menu
choose Group>Add Group.

If the column you selected contains string or numeric data, Interactive Viewer
groups the data by each unique value in the column. If the column you selected
contains date-and-time data, additional grouping options appear.

Grouping data on a date-and-time column

When you group data on a date-and-time column, you have two options. You can
show every individual date or time value, or you can group the data by a specific
time interval, which is the typical option. You can organize a shipping report, for
example, showing shipment data by month or by quarter, rather than by date.

Figure 5-10 shows three reports that contain the same data.

Shipment Date Order Shipped To
Jan 10, 2002 10100 Online Diecast Creations Co.
Jan 11, 2003 QLIRS LRe:  Shipment Date  Order

Shipped To

Jan 14, 2003 10102 Vitachrome Inc. SUan 10, 2003
?: ; gggg :31 E; E“m" fr_c‘!’lp'”g E; 10100  Online Diecast Creations Co.
= ) aane inl impaol =] 11, 2003
Feb 12, 2003 10105  Danish Wholesale I " {101 Blaver See Aufo. Go
Feb 21, 2003 10106 Rovell Gifts -
Feb 26, 2003 10107 Land of Toys Inc, | —Jan 14,2002
10102 Vitachrome Inc.
EFeb 1, 2003
10104  Euro+ Shepping Channel
EFeb 2, 2003 Shipment Date Order Shipped To
10103 Baane Mini [ o 003
EFeb 12, 2003 10100 Online Diecast Creations Co
10105 Danish Wh 10101 Blauer See Auto, Co
=Feb 21, 2003 10102 Vitachrome Inc
10105 Rovelli Gifts| Spepryary, 2003
=Feb 26, 2003 10104  Euro+ Shopping Channel
10107 Land of Toy: 10103 Baane Mini Imports
10105 Danish Wholesale Imports
10106  Rovelli Gifts
10107 Land of Toys Inc.

Figure 5-10 Comparing reports with grouped and ungrouped data
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The report on the left displays data that has not been grouped, the second report
groups shipment dates using individual date values, and the third report groups
shipment dates by month.

How to group date-and-time data

1 Select the column that contains the date-and-time data. From the context
menu, choose Group>Add Group.

2 On Group Detail, select one of the group options. If you opt to group by
interval:

= Select an interval type, such as weeks, months, or quarters, from the
drop-down list.

m  Type a number to indicate the grouping for the selected interval type. For
example, if you selected Weeks, type 2 to group data in two-week periods.

Figure 5-11 shows grouping the Shipped Date column by month.

Group Detail x
Group On: SHIPPEDDATE
Group Options:

() Group using individual values

(@) Group every 1 Months d

’
Figure 5-11 Grouping by shipping date

Grouping on multiple columns

When you group data on multiple columns, consider the order of precedence
before you create the groups. To group customer data by state, then by city, create
the groups in that order. The order in which grouped columns appear in a report
indicates the order in which the groups were created. The first group appears as
the leftmost column in the table, the second group appears next to it, and so on.

Changing the grouping order

After you create groups, you can change their order. Evaluate the effect of
changing the grouping order. For example, changing the order of the state or
province and city groups to city and state or province produces a report that
organizes data illogically. On the other hand, changing the order of the sales office
and product line groups to product line and sales office provides you with a
different perspective on the sales data. The focus shifts from sales office
performance to product line performance.
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How to change the grouping order

1 Select a column. From the context menu, choose Column~>Reorder Columns.
Arrange Columns, as shown in Figure 5-12, shows the columns in the order in
which the report currently displays the data.

Arrange Columns x

Available Columns:

Sales Office

Product Line

Product Name

Tatal v
Profit

(o) [cme] @

Figure 5-12 Reordering grouped columns

2 On Arrange Columns, select the grouped column from Available Columns.

Use the up or down arrow buttons to move the column up or down the list.
Choose OK.

Aggregating data

One of the useful features in a report is the ability to display summary, or
aggregate, data. Many example reports in the previous sections of this document
contain aggregate data. For example, a sales report can show the overall sales
total; sales subtotals by product type, region, or sales representatives; average
sales figures; or the highest and lowest sales figures.

Aggregating data involves performing a calculation on a set of values. For a
simple listing report that does not organize data in groups, you can perform
aggregate calculations on values in a selected column, across all the data rows ina
table.

For example, consider a report that has a column calculating price*quantity. You
can use the sum of the calculations in this column to obtain the total price of all
items. You can create up to three aggregations for each report column.

When you aggregate data, you choose whether the aggregation appears in the
table header or footer. If the column is grouped, you can display the aggregate
value in the group header or footer. The report in Figure 5-13 displays aggregate
data for the Total and the Profit columns at the end, or footer, of the table.

In a report that organizes data into groups, you can display aggregate data for a
selected column or columns. You can also perform aggregations for each group of
data rows, and for all the data rows in the table. In the example report shown in
Figure 5-14, the aggregate data appears at the footer of each group.
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Product Name

1992 Porsche Cayenne Turbo Silver
1970 Dodge Coronet

1952 Alpine Renault 1300

1961 Chevrolet Impala

1992 Porsche Cayenne Turbo Silver
1992 Porsche Cayenne Turbo Silver
1970 Dodge Coronet

1970 Triumph Spitfire

1993 Chrysler Plymouth Prowler
1965 Ford Mustang

1992 Ferrari 360 Spider red

1957 Ford Thunderbird

1970 Plymouth Hemi Cuda

1968 Ford Mustang

1969 Ford Falcon

1952 Camaro 228

1970 Triumph Spitfire

1970 Chevy Chevelle S5 454

1969 Dodge Charger

1965 Dodge Charger

Total

52557
1,706
510,286
52121
54471
3782
31441
54,006
53,389
36,317
52,980
52,463
51,570
56,009
54,069
1,977
54,623
53615
5,643
3,371
$10,286.

14
.40
.40
28
20
61
59
.03
28
80
34
12
56

2
44
54
15

60
.00
83

40

Max
$3,929.20 Avr
$78,564.03 Sum

Profit|
$952.20
$541.08|
§5,554.56)
§1.086.72
§1.331.10
51,061.19|

$502.56|
§1.246.51
51,054.55|
54.027.50
51.266.54|
§1,231.56|

$204.48]
§2.953.50
52,076.24)

$907.35|
§1.222.11

5661.20
52,706.50
51,192.19|

35,554.56
$1,619.00
$32,379.94

Aggregate data

Figure 5-13 Report displaying aggregate data

~Product Line Classic Cars
Product Price of Quantity Total
Name each ordered
1963 Ford 2153.44 64 510,460
Mustang
1969 Dedge £115.18 a7 11,171
Charger
2001 Ferrari 5207.80 43 59,974
Enzo
1932 Alpine 3201.44 30 510,072
Renault 1200
1952 Alpine 221430 43 510,286
Renault 1300

Total £51,063

Aggregate data for the product line

Maxi 811,171 °
S group, Classic Cars

Average §10,393

~Product Line Vintage Cars

Product Price of Quantity Total
Name each ordered
1917 Grand 314110 78 510,724

Touring Sadan
Total §10.724
Maximum $10,724

Aversae $10.724

Aggregate data by product line group

Aggregate data for the product line
group, Vintage Cars

Figure 5-14

Adding and removing an aggregate value
When you aggregate data in a column, you specify the following information:

m The type of aggregate calculation. The report in Figure 5-14 displays, for the
Total column, the sum of the values, the highest (max) value, and the average
value. Interactive Viewer supports other types of aggregate functions,
described later in this document. Each aggregation appears on a separate row.

Whether to perform the aggregate calculation across all the data rows in the
table, or across the data rows in each group, or both. Aggregating data for
groups applies only to reports that organize data in groups.
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m  Whether to display the aggregate data in the footer or header of the table or
the groups. The previous examples show aggregate data in the footers, which
is typical. Choose header to display the aggregate data at the beginning of the
table or group.

How to aggregate data

[£] 1 Selectthe column containing the data to aggregate. From the context menu,
choose Aggregation. Aggregation appears. The syntax of the selected function
appears in the lower part of Aggregation, as shown in Figure 5-15. From the
Select Function menu, select the aggregate function to use.

Aggregation X

Column
name
Selected Column: Total
Delete Aggreqation
Select Function:  Average v Sort direction:
Aggregate on:
] table level () header @ footer
group level )
AVE(Total) Enter Label: Average Format
Add Aggregation .
Function
syntax
2| ¥

Figure 5-15 Aggregating the Total column as an average

2 Specify a sort direction for the resulting aggregation. If you select Ascending
or Descending from the Sort direction list, the groups appear, in ascending or
descending order in the report. Select none if you do not want to sort the
groups in any order.

3 In Aggregate on:

m  Select table level to aggregate data across all the rows in the table. Select
either header or footer as the location in which to display the aggregate
data.

m  Select a group from the next list to aggregate data at the group level. Select
either header or footer as the location in which to display the aggregate
data.

4 In Enter Label, enter a name for the label. Optionally, set a font for the
aggregation label, by choosing Format.

5 To create a second aggregation, choose Add Aggregation. In Select Function,
select a function from the list. Repeat step 2 to step 4 to define the aggregation.
Choose OK. Figure 5-16 shows two aggregations defined for the report.
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]

Aggregation

Selected Column:

Select Function:

Aggregate on:
table level
[ group level

AVE(Total)

Select Function:

Aggregate on:
table level
[ group level

SUM(Tatal)

Select Function:

Agaregate on:
table level

[ group level

Total

Average

Sum

- Sort direction:

() header @ footer
G

Enter Label: Average

v Sort direction:
() header @) footer
&)

Enter Label: |SUM

w Sort direction:

(©) header @ footer

)

Enter Label:

Add Aggreqation

x

Delete Aggreqation

Format

Delete Aggreqation

Format

Delete Aggreqation

Format

?

— Create a new aggregate row
in this section

Figure 5-16

Adding an aggregate row for a column

How to add additional aggregate rows to a column

After you create a single aggregate value for a column, you can add up to two
more aggregate values for the same column. For an order total column, for
example, you can create a sum of all the values, count all the values, and get the
average order total.

1 To add an aggregate value, select a column that contains an aggregate value.
Choose Aggregation from the context menu.

2 On Aggregation, choose Add Aggregation.

An additional section appears on Aggregation, shown in Figure 5-16.

3 Create the second aggregate value and choose OK.
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How to aggregate data in a merged column

1 When working with merged columns, if you choose Aggregation from the
context menu, Select Data Item appears.

2 Select the data item or column on which to perform an aggregation, from the
drop-down list. Choose OK.

You can now create aggregations for each of the columns, as described in the
previous sections of this document. To modify each line of data in the merged
column, you must repeat this step for each data item, then define the aggregation,
each time.

How to delete an aggregate value

[£] 1 Selectthe column that contains the aggregation to remove. From the context
menu, choose Aggregation.

2 Aggregation appears, displaying all the aggregations for the column. Choose
Delete Aggregation for the aggregation you want to remove. Choose OK.

Types of aggregate calculations

The aggregate calculations you can perform on a column depend on the type of
data in the column. You can perform functions only on numeric data, that enable
a mathematical calculation, such as SUM and AVERAGE.

The most common aggregate functions used for string data are Count and Count
Value. Count returns the number of values in a column, including duplicate
values. Count Value returns the number of distinct values in the column. You can
use Count Value, for example, on a customer name column to get a count of the
number of customers.

For date-and-time data, you can use the MIN and MAX functions to get the
earliest and the latest date, respectively, from an order date column.

For a description of the aggregate functions available, see Chapter 11, “Functions
and operators.”

Hiding and displaying report elements

This section describes how to use Interactive Viewer to hide or display elements
in a report, such as a column or table header, a report table, a chart, a Flash chart
or object, and an image in the report.

How to hide or display report items

1 Choose Hide/Show Items from the main menu. Hide or Show Items appears,
as shown in Figure 5-17.
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Hide/Show Items x
Check Item(s) to Show

| Report Header

| Table Header

+ V] Table
cl

’
Figure 5-17 Hiding or displaying report items

2 Select the items to display. Deselect the items to hide. To hide all items, choose
Clear. Then, choose OK.

Hiding group details

In a report containing multiple groups, it is sometimes useful to hide the details
for a specific group if you do not want to display all the information at the same
time. For example, in a sales report that groups orders by state and product, you
can display only the state totals, by choosing the top-level group, state, and then
selecting the Hide Detail option. Hiding the details from the state group
recursively hides all data within the state group; the report hides product groups
and the order details within each product group.

When you work with a report that organizes data in groups, you can change the
report to a summary report by hiding the group details. Hiding details,
particularly for a report that runs into hundreds of pages, helps you display key
information at a glance.

Figure 5-18 shows two reports that contain the same data. The report on the left
shows all details. The report on the right hides the details within each product
line group.

-IProduct Line Classic Cars +Product Line Classic Cars

Product Price of Quantity Total Product Name Price  Quantity Total
Name each ordered of each ordered

1963 Ford 5163.44 64 510,460 Total £51,963
Mustang .

1968 Dodgs $115.16 a7 F11,171 Maximum $11,171
Charger Average $10,393
2001 Ferrari 5207.80 43 59,974 TIProduct Line Motorcycles

Enzo

1952 Alpine 5201.44 50 510,072 Product Name  Price Quantity Total
Renault 1300 of each ordered

1952 Alpine 521430 48 510,288 Total €30, 107

Renault 1200
Maximum §11,503

Total §51,963
Average 870066

Maximum §11, 171

Average $10,393 [broduct Line : Vintage Cars
. Product Name Price Quantity Total
_ProductLine i agEiCars of each ordered
Product Price of Quantity Total Total 10 724
Name each ordered Vo o 0« o
1917 Grand S141.10 75 510,724 SR g

Touring Sadan

Average §70.724

Total $10,724 Total $92 884
Maximum §10,724 Maximum §11,503
Average §10.724 Average $10,320

Figure 5-18 Comparing reports showing and hiding product details
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How to hide group details

Select the grouped column whose details you want to hide. From the context
menu, choose Group>Hide Detail.

How to redisplay group details

Select the grouped column, then from the context menu choose Group~>Show
Detail.

Suppressing duplicate values

Frequently, you find that you do not need to display all the data present in a
report. For example, sometimes a report column displays duplicate values in
consecutive data rows. When the duplication is unnecessary or makes the report
difficult to read, you can suppress consecutive duplicate values. In addition, as
you modify a report, you can collapse groups to display only the column
headings and summary data, such as aggregate data rows.

You can also use Interactive Viewer to suppress duplicate values that appear in a
grouped column. For example, a report that lists customer orders, grouped by
customer, shows some data values such as the address, contact information,
customer number, and so on, multiple times for every order placed by the
customer. You can prevent the duplicate occurrence of these values by moving
data rows from the column to the group header.

Avoiding repeated values in a column

In the report shown in Figure 5-19, the Location column shows the city name each
time the name occurs.

customerName ] state salesRepEmployeeNumber|
Diecast Classics Inc. Allentown PA 1218|
Diecast Colleciables Boston MA 1188|
Gifts4AllAges.com Eoston Ma 1218
Collectables For Less Inc. Brickhaven Ma 1188|
Online Mini Collectables Erickhaven Ma 1188|
Auto-Moto Classics Inc Brickhaven Ma 1218|
Gift Depot Inc. Bridgewater CcT 1323/
Signal Collectibles Lid Erisbane Ch 1165
West Coast Collectables Co.  Burbank CA 1168|
Technics Stores Inc. Burlingame Ch 1165
Marta's Replicas Co C MA 1218

Figure 5-19 Duplicate values in columns

As Figure 5-20 shows, the report appears neater and more organized when
duplicate values are not repeated.

Using Interactive Viewer, you can suppress consecutive occurrences of duplicate
values. In the Location column in Figure 5-20, the Boston value is suppressed in
the second, third, fourth, and fifth rows. If Boston occurs again after the listing for
NYC, that occurrence of Boston is visible and subsequent consecutive occurrences
are suppressed. The values must be exact duplicates to be suppressed.

72 Working with Actuate BIRT Viewers



customerName i state salesRepEmployeeNumber

Digcast Classics Inc Allentown PA 12186|
Diecast Collectables Eoston M2 1188|
Gifts4AllAges.com 1218
Collectables For Less Inc. Brickhaven 1183|
Online Mini Collectables

Auto-Moto Classics Inc. 1218|
Gift Depot Inc. Bridgewater CT 1323
Signal Collectibles Lid Brisbane Ch 1165|
West Coast Collectables Co.  Burbank 1166|
Technics Stores Inc. Burlingame 1165
Marta's Replicas Co C i MA 1218

Figure 5-20 A report suppressing duplicate values

If a column extends across multiple pages, the first row on each page displays a
value, even if duplicate values are suppressed for that column.

How to suppress duplicate values in a column

Select the column containing duplicate values. From the context menu, choose
Column~>Do Not Repeat Values.

How to show hidden duplicate values in a column

Select a column that does not repeat duplicate values. From the context menu,
choose Column->Repeat Values.

E

Avoiding repeated values in a group

The example report in Figure 5-21 displays the values for Customer Number,
E-mail, and Credit Limit multiple times for the same customer. By moving the
data row values to the group header, you limit the appearance of these fields of
data so that they only appear once.

Customer Country Customer Name  Customer Number Credit Limit Product Line Product Name
-Anna's 276 107800
Decorations, Ltd

Classic Cars 1993 Mazda RX-7

Classic Cars 1965 Aston Martin
DBS

Classic Cars 1995 Honda Civic

Classic Cars 1999 Indy 500 Monte
Cario 55

Classic Cars 1992 Ferrari 360
Spider red

Figure 5-21 A report displaying duplicate values in a group

How to suppress duplicate values in a grouped column

1 Select the column with the duplicate values. From the context menu, choose
Column>Move to Group Header.

2 On Move to Group Header, as shown in Figure 5-22, perform the following
tasks:

m  Select the group to which you want to move the data values, if the report
contains more than one group.

m  Select the header row to which Interactive Viewer can move the data
values.
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Move to Group Header x

Move to group: customerMame b

Header row: |y =

’
Figure 5-22 Selecting a group header

Repeat this step for each report column for which you want to move data rows
to the group header. Choose OK. The value from the first data row in each
group appears in each group header. The Credit Limit, E-mail, and Customer
Number columns display a single data row for each Customer Name group
header, as shown in Figure 5-23.

Customer Country Customer Name Customer Number Credit Limit Product Line Product Name

-Anna's 276 107800
Decorations, Lid
Classic Cars 1993 Mazda RX-T
1965 Aston Martin
DB5

1995 Honda Givic
1999 Indy 500 Monte
Carlo 8%

1992 Ferrari 360

Spider red

1948 Porsche Type

356 Roadster
Vintage 1932 Alfa Romeo
Cars 52300 Spider Sport

Figure 5-23 Displaying a report showing suppressed duplicate values

Specifying page breaks

=:| Using Interactive Viewer, you can set page breaks after a preset number of rows
in a data column and you can start each group on a new page by specifying a
page break before or after grouped data.
How to set and remove a page break on a report column

1 Select a column. From the context menu, choose Group>Page Break.

2 On Page Break, define an interval by typing the number of rows you want to
display on each page, as shown in Figure 5-24. Choose OK.

Page Break b 4

Interval: 4p

2
Figure 5-24 Setting a page break on a data column

3 To delete an existing page break, type 0 in the Interval field. Choose OK.
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How to set and remove a page break on a grouped column

1 Select a grouped column. From the context menu, choose Group->-Page Break.

Page Break appears, as shown in Figure 5-25.

Page Break x
Before group: After group:
© Always () Always
() Always except () Always except
~ the first ~ the last
(@) Mene @ Hone
.
Figure 5-25

Setting a page break before or after groups

2 You can set a page break for every group, or for every group except the first or
last groups. Choose OK.

3 To delete an existing page break, select None in Before group or After group.

Choose OK.
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Performing calculations
In areport

This chapter contains the following topics:
m  About calculated data
m Building an expression

m Creating a custom expression
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About calculated data

Most BIRT reports require calculations to track sales, finances, inventory, and
other critical business activities. You can use Interactive Viewer to create
calculations to count items in a warehouse or provide more complex financial
data, such as tracking stock portfolio performance over time.

|;| To display calculated data in a report, you create a computed column, such as the
Total column in the report shown in Figure 6-1. In the example, you need to
calculate the Total because the original report does not provide this data.

Customer Order Price of each Quantity Total
Hame Number Ordered
=lAV Stores, Co. 10110
118.22 37 54,374
153 42 56,426
51.46 32 51,647
115.69 33 33,818
163.69 31 55,074
31.91 28 52293
62 42 52,604
72.02 36 52,593
4327 29 51,255
28.38 20 3578
4077 3 51,590
Figure 6-1 Report with computed column

Interactive Viewer provides a convenient expression builder wizard to create
computed data. You use Expression Builder to do one of the following:

m Enable Interactive Viewer to build an expression.

Select a function to use, then select one or more columns across which
Interactive Viewer performs the calculation.

m Create a custom expression.

Select a function, then create an expression and validate it, after which
Interactive Viewer performs the calculation.

About expressions

When you create a computed column, you build or create an expression that
indicates how to calculate data. When you build an expression to create a
computed column, first select a category, then select a function to use to compute
the data. Interactive Viewer provides an expression builder containing categories
with functions and operators that you use to create, modify, and view
expressions. You can select the columns across which to perform the calculation.
Figure 6-2 shows an example of building an expression to calculate the extended
price, which is not included in the report.
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Column Label:

New Computed Column x

Extended price

————Type a label for the column

Select Category:  Math = Select a category
Select Function: Advanced... =
ADD
ABS
CEILING
DIFFERENCE
MOD .
PRODUCT ———Select a function
PRODUCT, Column1 * Column2
Calculates the product, number 1 * number 2.
Calumn: PRICEEACH = . Select a column
Calumn: QUANTITYORDERED ~————Select the next column
’
Figure 6-2 Building an expression

If you are already familiar with writing expressions, you can create custom
expressions to insert computed columns in a report. In the example, as shown in
Figure 6-3, you multiply each value in the QUANTITYORDERED field with the
corresponding value in the PRICEEACH field, to obtain the value in the Total
column. The following expression calculates the Total:

[PRICEEACH] * [QUANTITYORDERED]

Column Label:

Select Category:

Select Function:

New Computed Column b 4

Enter Expression:

Tatal
Math

4

Advanced... =
ADD

ABS

CEILING

DIFFEREMCE

MOD

PRODUCT hd|
This option enables you to customize a function expression,
Examples

[LastName]&", "&[Firstame]

[price]*0.10

To learn more, dlick the link to operators or functions.
[PRICEEACHT™[

[ORDERMUMBER] - Order Number

[PRICEEACH] - Price of each

[Total] 2
[CUSTOMERNAME] - Customer Name

Figure 6-3

Performing a calculation

When you use a data field in an expression, you must enclose the field name
within brackets ([ ]).
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Interactive Viewer supports typical mathematical operations, such as addition,
subtraction, multiplication, and division. In addition to mathematical
calculations, Interactive Viewer supports functions for processing date-and-time
and string data.

You can create a computed column to display data that is not displayed in the
report, or if you want to display data differently from its appearance in the report.
For example, if a customer name field contains values with leading or trailing
blank characters, you can remove the blank characters by using the TRIM( )
function as follows:

TRIM( [CustomerName] )

Creating and editing a computed column

In Interactive Viewer, you can use the expression builder to enable the viewer to
construct an expression for you, or you can construct a custom expression by
selecting Advanced in the Category field. The expression you create is used to
compute the new calculated column that appears in the report.

This section describes how to create and edit computed columns in a report.

How to build an expression for a new computed column

1 Select the column to the left of where you want to place the new computed
column. From the context menu, choose Column>New Computed Column.
New Computed Column appears.

2 In Column Label, type a name for the new computed column. The name you
specify appears in the column header.

3 In Select Category, select an option from the following categories:
» Financial
= Math
m Date and time
= Logical
»  Comparison
m Text
A list of functions appears in Select Function.
4 In Select Function, do one of the following;:
m  Select a function from the list, then go to step 5.

m  Select Advanced to manually create an expression. Then perform the steps
listed in “How to create a custom expression for a new computed column,”
later in this chapter.
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5 Based on the function you select, one or more column fields appears. In each
Column field that appears, select a column from the list.

Choose OK. The new computed column based on the expression you built,
appears in the report.

How to create a custom expression for a new computed column

1 In Enter Expression, type the expression that performs the calculation:

m To use a data field in the expression, type the left bracket ([), then select the
required field from the list that appears. The list displays only fields in the
report.

m To use a function, type the first letter of the function, then select the
function from the list that appears. The functions indicate the arguments, if
any, that you need to specify.

2 After you complete typing the expression, choose Validate. If the expression is
syntactically correct, Information appears informing you that the expression is
valid, as shown in Figure 6-4.

Information x

The expression is valid.
x)

Figure 6-4 Expression valid confirmation message

If the expression contains an error, Information displays an error message.
Choose OK.

3 On New Computed Column, choose OK. The computed column appears in
the report.

How to edit a computed column

Select the computed column. From the context menu, choose Column~>Edit
Computed Column. New Computed Column appears. To modify the expression,
continue as described in the previous section.

Building an expression

The expression builder in Interactive Viewer supports typical mathematical
functions, such as percent of total, running sum, and percent of difference. It also
supports a range of financial, logical, date-and-time, text, and comparison
functions.

Table 6-1 lists the functions available in each category of the expression builder.
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Table 6-1 Categories and functions for creating a computed measure

Category Function

Logical m IF

Financial m %OF

% OF DIFFERENCE
RUNNINGSUM
FIND

LEFT

LEN

LOWER
RIGHT
SEARCH
TRIM
TRIMLEFT
TRIMRIGHT
UPPER

ABS

ADD
CEILING
DIFFERENCE
MOD
PRODUCT
RANK
RATIO
ROUND
ROUNDDOWN
ROUNDUP
SQRT
BETWEEN

IS

ISNULL
LIKE

NOT NULL
NOW
TODAY

Text

Math

Comparison

Date-and-time

82 Working with Actuate BIRT Viewers



A detailed description of all functions is available in a later section of this
document.

Creating a custom expression

An expression is a statement that produces a value. An expression can be a literal
value, such as:

1.23
"Hello, World!"

An expression can contain any combination of literal values, operators, functions,
and references to data fields, as shown in the following examples. For detailed
descriptions of the functions that Interactive Viewer supports, refer to a later
section of this document.

The following expression displays a customer’s first and last names, which
the database entry stores in two fields. The & operator concatenates string
values.

[FirstName] & [LastNamel

The following expression displays a full address by concatenating values from
four data fields and adding commas as appropriate:

[Addressl] & ", " & [City] & ", " & [State] & " " & [Zipcode]

The following expression calculates a gain or loss percentage. The expression
uses the mathematical subtraction, division, and multiplication operators, -, /,
and *.

([SalePrice] - [UnitPricel])/[UnitPrice] * 100

The following expression uses the DIFF_DAY function to calculate the number of
days it took to process an order for shipping:

DIFF DAY ([OrderDate], [ShippedDate])

The following expression uses the ADD_DAY function to calculate a payment
due date when the payment term is net 30:

ADD DAY ([InvoiceDate], 30)

The following expression uses the IF function to evaluate if the value in the
country column is UK. If the condition is true, the function replaces the value
with United Kingdom. If the condition is false, the country values are displayed
as stored.

IF(([Country] ="UK"), "United Kingdom", [Country])
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Using numbers and dates in a custom expression

When you create an expression that contains a literal number, type the number
according to the conventions of the US English locale. In other words, use a
period (.), not a comma (,) as the decimal separator, even if you are working in, for
example, the French locale. For example:

Correct: ([Quantity] * [Price]) * 1.5
Incorrect: ([Quantity] * [Price]) * 1,5

Similarly, when you create an expression that contains a literal date, type the date
according to the conventions of the US English locale. For example, if you are
working in the French locale, type 03/12/2007 to represent March 12, 2007. Do
not type 12/03/2007, which is the convention for the French locale. You must
enclose literal date values in double quotation marks(" "), as shown in the
following expression that calculates the number of days from the order date to
Christmas:

DIFF DAY ([OrderDate], "12/25/08™")

How to add days to an existing date value

To create a column that displays date values that are greater than the date values
in another column, complete the following steps.

|;| 1 Select a column. From the context menu, choose Column>Choose New
Computed Column. New Computed Column appears.

2 In Column Label, type a name for the calculated column. For example, type
Forecast Shipping Date.

3 In Enter Expression, type the letter A. A list appears, displaying functions that
begin with A.

Choose ADD_DAY (date, daysToAdd).

For the first argument, type a left bracket ([) and select the date column from
the list. For example, select Order Date.

6 For the second argument, type the number of days to add. In this case, type 7.

Validate the expression and choose OK. The calculated column appears in the
report. For every value in the Order Date column, the calculated column
displays a date seven days later than the order date.

How to subtract date values in a calculated column

The following section describes how to display the difference between two date
values.

|;| 1 Select a column. From the context menu, choose Column~>Choose New
Computed Column. New Computed Column appears.

84 Working with Actuate BIRT Viewers



2 In Column Label, type a name for the calculated column. For example, for a
calculation that subtracts the actual shipping date from the date requested,
type Shipping Delay.

3 In Enter Expression, type the letter d. A list appears, displaying functions that
begin with d.

Choose DIFF_DAY(datel, date2).

For the first argument, type a left bracket ([) and select the first date column
from the list. For example, select Date Requested.

6 For the second argument, type a left bracket ([) and select the second date
column from the list. For example, select Actual Shipping Date.

7 Validate the expression and choose OK. The calculated column appears in the
report, displaying the difference between the two dates.

Using reserved characters in a custom expression

Some characters are reserved for internal use and have a special meaning. For
example, as described in the examples in previous sections, Interactive Viewer
uses brackets to denote a data field. The following characters are reserved in
Interactive Viewer:

[
1

?

' (single quotation mark)

If the name of a data field contains reserved characters, Interactive Viewer
removes the reserved characters when you select the data field to use in an
expression. For example, if the name of a data field is OBSOLETE?, Interactive
Viewer changes it to [OBSOLETE'?'] in the expression. If you type [OBSOLETE?]
in the expression, an error message appears. To avoid syntax errors, always select
the field and let the application construct the correct expression.

Figure 6-5 shows an example of a list of data fields, having reserved characters in
the names of three fields. The following fields show both versions of the names,
the changed name, enclosed in brackets, and the original name showing reserved
characters:

[ORDER''S STATUS] - ORDER'S STATUS
[PRODUCTCODE' ['4digit'] '] - PRODUCTCODE [4-digit]
[OBSOLETE'?'] - OBSOLETE?
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New Computed Column x

Column Label: Product Description
Select Category: Text

4

Select Function: e sz, =
ADD

ABS

CEILING

DIFFERENCE

MoD

PRODUCT x|
This option enables you to customize a function expression.
Examples

[LastName]&","&[FirstMame]
[price]*0.10

To learn more, click the link to operators or functions.
[PRODUCTCON

Enter Expression:

[FRODUCTNAME]

[ORDER™S STATUS]
[OBSOLETE?] )
[PRODUCTLINE] -

Figure 6-5 Data fields having reserved characters
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Filtering report data

This chapter contains the following topics:
m  About data filtering

m Providing parameter values

m Creating a filter

m Defining multiple filter conditions
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About data filtering

A report or report element often provides more information than you need. You
can display specific rows of a report by using a filter. For example, instead of
listing all customer sales, you can create a filter to list only the sales data for a
particular week or a specific region.

Filtering data helps you work effectively with large amounts of data. It enables
you to present the information that answers specific business questions, such as
which sales representatives generated the top ten sales accounts, which products
generated the highest profit in the last quarter, which customers have not made a
purchase in the past 90 days, and so on.

Using Interactive Viewer, you can filter data at the report table level to narrow the
scope of data in a table, and also to remove unwanted fields of data that show too
much information. You can also filter data for report elements such as charts.

Sometimes when you view a report with existing filters, the report requires you to
enter parameter values to determine which data to display, each time you run the
report. You can view specific data in the report by modifying these parameter
values, as described in this document.

Providing parameter values

If a report design already uses filters, and requires you to enter values to display
data, you are prompted to enter these values before a report is run. The prompt
value is called a parameter. Parameters enable users to control displayed content,
without editing the report. You can modify the parameter values at any time by
choosing the parameter option from the main menu. For example, in a report that
displays sales data by sales office, you can use parameter values to select which
sales office data to view in the report. Even if you are the only person reading the
report, a parameter value enables you to view specific content in the report.

If you save a report design file containing parameters as a report document file,
the user can no longer specify parameter values to view specific data. The
viewers display data based on parameter values specified when the report design
was saved as a report document file.

Reports using dynamic filters, require you to first select an operator, and then
supply one or more parameter values for which the viewers display data.
Supplying specific parameter values in such reports is often optional, and you
can select the No Condition operator to view all the data in the report. You cannot
create dynamic filters using the viewers.
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How to enter parameter values at run time

1 Run the report from the list of available reports. If the report contains filters,
and requires parameter values, the Parameters dialog box appears requiring
you to enter or choose specific values, based on which data is retrieved and
displayed.

2 Choose the field for which you want to view data, or enter a value. For
example, in a report containing customer order history data, to view a specific
customer’s order history, choose the customer’s name from the list, as shown
in Figure 7-1.

Choose Finish to view the report. The report in the example displays the order
history for Boards & Toys Co.

Parameters U
Customer -
Figure 7-1 Entering parameter values

How to modify parameter values in the viewers
1 From the main menu, choose Parameters.
2 A Parameters section appears in the lower pane of the viewer. The example in

Figure 7-2 shows the details for Boards & Toys Co. Choose another customer
from the list. Then choose Run report from the Parameters toolbar.

Customer Order History
—_— Report
Coda e rip o it Uit Price Order Tatsl

Wirder Humber: iais4a rder Date: Ot 3, 3000
[S24_J1%1 ¥912 Ford Hodal T n #73.12 #1.33%.8]

vy Wagon
[r03_ha1D The USS Comatitution 14 3937 #1072

shig Yo Run report
i i nesmm x| Close

: . 5 -
JRCI [ — = Parameters section
=

Figure 7-2 Viewer displaying report and the Parameters section

The report showing new data for the selected customer appears in the upper
part of the viewer. To view all the data on the current page, use the scroll bar in
the report section, or close the Parameters section.

You can only modify parameter values for reports that already contain filters and
require the use of parameter values to view data. If the report you generate does
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not use parameters, when you choose the Parameters option from the main
menu, a message appears informing you that the report contains no parameters.

How to select an operator and specify one or more parameter values

1 Run the report from the list of available reports. If the report contains filters,
and requires parameter values to display data, Parameters appears as shown
in Figure 7-3.

Parameters ©
Customer |N0 Condition
City [In
Credit Limnit |Greater than or Equal =] |IDDDDD
Figure 7-3 Specifying operators and parameter values

2 Select an operator in the first field, customer. To view data for all customers,
select No Condition, as shown in Figure 7-3.

3 Select an operator from the drop-down list in the next field, City, and specify
one or more values from the list of values that appears. To select more than
one value, press Ctrl while selecting each additional value. To select a range of
values select the first value, press Ctrl+Shift and select the last value in the
range.

4 Select an operator from the drop-down list in the next field, Credit Limit, and
type a value in the associated field that appears. To view all credit limits, select
No Condition.

Choose Finish. The report displays data for the parameter values you
specified.

Creating a filter

To create a filter, you define a condition specifying which data rows to display. A
filter condition is an If expression that must evaluate to True for a data row to be
included. The following list shows examples of possible filter conditions:

If the credit limit is greater than 100000
If the sales office is San Francisco
If the order date is between 4/1/2008 and 6/30/2008

90 Working with Actuate BIRT Viewers



Figure 7-4 shows an example of a filter condition. When defining a filter
condition, you can break it down into the following parts, as shown in Figure 7-4:

The column to evaluate, such as credit limit

The comparison operator specifying the type of comparison test, such as
Equal To

The value to which all values in the column are compared, such as 100000

The column to evaluate
The comparison operator
The value to which to compare

Filter x

Filter By: CREDITLIMIT

Condition: Equal To oA

Value: 100000 Select Values

Advanced Filter | Clear Filter

?

Figure 7-4 Creating a filter

How to create a filter

1

Select the column containing the data values to evaluate. For example, to
create a filter that displays data rows based on specific values in the credit
limit column, select the credit limit column.

From the Column toolbar, choose Filter. Filter appears.

In Condition, select the comparison test, or operator, to apply to the selected
column. Depending on the operator you select, Filter displays either one or
two additional fields, or a completed filter condition.

If you select an operator that requires a comparison value, you can specify the
value in one of the following ways:

m  Type the value.

m  Choose Select Values to select from a list of existing data values. Figure 7-5
shows how you can select a credit limit value of 11000 from the list of
possible credit limit values. Use the Previous and Next buttons to navigate
the list of values that appears.

Choose OK to apply the filter. If the report or report element such as chart,
contains no data that matches the filter condition, Interactive Viewer does not
display any data. Make sure you test the filter by applying it and viewing the
resulting report.
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Filter x
Filter By: CREDITLIMIT
Condition: Equal To -

Value: 11000 Select Values

c =
11000

21000
23000
23500

34800 LI
previous | next
Advanced Filter | Clear Filter
2
Figure 7-5 Selecting a value for the filter condition

Selecting multiple values for a filter condition

Sometimes you need to view a wider range of data, such as, sales details for
several sales offices, not only for a single office. To select more than one
comparison value, select the In operator, choose List Values, then select each
value. Use the previous and next buttons to navigate the list of values that
appears in the Find area. Figure 7-6 shows the selection of London and Paris from
a list of sales office values. Choose OK.

Filter b4
Filter By: Sales Office
Condition: In b
Boston -
Value: Paris )
NYc |
List Values | Delete Values
Find Value:
Boston =
London
NYC
Paris _
san Francisco
Svdney j
previous | next
Clear Filter
’
Figure 7-6 Selecting multiple values for a filter condition

Excluding data

When formulating a filter condition, you can use comparison operators, such as
Equal to, Greater Than, or Less Than, to determine which data rows to view.
Sometimes it is more efficient to specify a condition that excludes a small set of
data. For example, you need sales data for all countries except USA. Instead of
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selecting all the available countries except USA, and listing them in the filter
condition, it is simpler to use the Not Equal To operator. Similarly, use the Not
Between operator to exclude data in a specific range, and the Not Like operator to
exclude data that matches a string pattern.

For example, the following filter condition excludes orders with amounts that are
between 1000 and 5000:

OrderAmount Not Between 1000 and 5000

The filter condition in the next example excludes products with codes that start
with MS:

ProductCode Not Like MS%

Filtering empty or null values

Sometimes report columns have blank data rows. Consider a customer database
that contains an e-mail field. For customers who did not supply an e-mail
address, the e-mail field in the column is empty or blank. An empty value, also
called a null value, means that no value is available. Null values apply to all data
types.

You can create a filter to exclude data rows when a specific column has null
values. When filtering to exclude rows containing null values, use the Is Not Null
operator. If you want to only view rows with null values in a particular column,

use the Is Null operator. For example, the following filter condition excludes
customer data where the e-mail column contains null values:

Email Is Not Null

The following filter condition displays only rows where the e-mail column
contains null values:

Email Is Null

Displaying top or bottom values

For a report or report element that presents a large amount of numeric data, it is
useful to view a snapshot of the highest or lowest values, such as the top 100
order totals or the counties whose median home prices are in the bottom 10
percent.

Select the column to highlight it, and choose Filter>Top/Bottom N from the
context menu. Top/Bottom N appears, as shown in Figure 7-7.

On Top/Bottom N, select Top N, Bottom N, Top Percent, or Bottom Percent to
specify the condition. Enter a number in the next field, and choose OK.
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Top/Bottom N x

Filter: Top N 5
Bottom N
Top Percent
Bottom Percent
Mo Condition

2
Figure 7-7 Filtering data using Top/Bottom N values

Specifying a date as a comparison value

When you create a filter condition that compares the date-and-time values in a
column to a specific date, the date value must be in one of the following formats,
regardless of your locale:

3/26/2008
3/26/2008 2:30:00 PM

Interactive Viewer provides a calendar you can use to conveniently select a date.
Figure 7-8 shows how to access the calendar.

Advanced Filter =
Filter By: ORDERDATE -
Condition: Equal To -
@ Speciy literal value () Use valug from data field —— Choose to open
@ Specify literal value (7) Use value from data fiel /— the calendar
Date: [ select values

* Please enter date values like: 2012-08-21
Add Condition Chanae Condition

Filters:

—

and

L=
@
i

H-l]

’
Figure 7-8 Selecting filter condition values using the calendar

The calendar appears displaying the current date, month, and year. The current
date is highlighted by default, as shown in Figure 7-9.

To accept the current date, choose Today. To choose another date, select it.

The selected date value appears in Date, in Filter. Choose OK for the filter
condition to take effect.
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Advanced Filter x

Filter By: ORDERDATE ¥
Condition: Equal To b
@ Specify literal value () Use value from data field
Date: 4 select Values

* Please enter date values like: 2012-08-21 E hvous 202 L
addcd 5 M T w T F

i
5 6 i 8
12 13 14 15

15 20 22

26 27 28 29

:

Figure 7-9 Selecting a date from the calendar

Filters:

Fa
8 G omow M
-

w

Comparing to a string pattern

For a column that contains string data, you can create a filter condition that
compares each value to a string pattern instead of to a specific value. For
example, to display only customers whose names start with M, use the Like
operator and specify the string pattern, M%, as shown in the following filter
condition:

Customer Like M%
You can use the following special characters in a string pattern:

m % matches zero or more characters. For example, %ace% matches any value
that contains the string ace, such as Ace Corporation, facebook, Kennedy
Space Center, and MySpace.

m _ matches exactly one character. For example, t_n matches tan, ten, tin, and
ton. It does not match teen or tn.

To match the percent sign (%) or the underscore character (_) in a string, precede
the characters with two backslash characters (\\). For example, to match S_10,
use the following string pattern:

S\\_10
To match 50%, use the following string pattern:
50\\%
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Defining multiple filter conditions

When you create a filter, you define at least one filter condition, but you can
create as many filter conditions as you need to display relevant data. Each
condition you add further narrows the scope of displayed data. For example, you
can create a filter that returns rows where the customer’s credit rank is either A or
B and whose open orders total between $250,000 and $500,000. Each additional
condition introduces complexity to the filter. Make sure you design and test filters
with multiple conditions carefully. If you have too many filters that narrow the
scope of the report excessively, no data displays in the report, or report element.

Adding a condition

There are two ways to define multiple filter conditions. You can select a column
and define a filter, then select the next column and define a filter, and so on. Or
you can use the Advanced Filter dialog box, as shown in Figure 7-10. You can use
Advanced Filter to modify or delete existing filter conditions.

Advanced Filter x
Filter By: Product Line - PRODUCTLINE i
Condition: Equal To .
@ Specify literal value () Use value from data fizld
Value: Vintage Cars Select Values
Find Value: Find

Motorcycles
Planes

=
Ships
Trains
Trucks and Buses
Vintage Cars -
previous | next
=

Add Condition Chanae Condition

Filters:

Lo ]
CITY_25 = 5an F 5
or PRDDUCﬂinNErini:inctoage Cars - -

?
Figure 7-10 Adding a filter condition

For example, using the former method, you can define two filters, the first on the
SALES OFFICE column, the second on the PRODUCTLINE column.

When you use this method to define multiple filters, Interactive Viewer
constructs the following filter expression:
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SALES OFFICE = San Francisco
and PRODUCTLINE = Vintage Cars

This filter returns only data rows that meet both conditions. Sometimes, you want
to create a filter that returns data rows when either condition is true, or you want
to create a more complex filter. To accomplish either task, you can use the
Advanced Filter dialog box, as shown in Figure 7-10.

As the example shows, Advanced Filter provides more options for defining a
filter with multiple conditions. It also displays all the filter conditions defined for
the report table, or chart element.

How to define multiple filter conditions

1 Select the report column that contains the values to evaluate, then choose
Filter from the column toolbar.

2 On Filter, choose Advanced Filter. Advanced Filter appears. Filter By displays
the selected column.

3 Define the first filter condition as follows:

1
2

3

In Condition, select a comparison operator.

In Value, select or type the comparison value. For conditions that test
equality and for the Between condition, you can either set a literal value or
you can base the value on another data column by selecting the Use value
from data field option. For example, you can request actual shipping dates
that are greater than the forecast shipping dates, or actual sales that are less
than sales targets.

The conditions that support basing the filter value on another column are
Equal to, Not Equal to, Less Than, Less Than or Equal to, Greater Than,
Greater Than or Equal to, Between, and Not Between.

Choose Add Condition.

The filter condition appears in the Filters area.

4 Define the second filter condition as follows:

1
2
3

4

In Filter By, select another column.
In Condition, select a comparison operator.

In Value, select or type the comparison value. You can select Specify literal
value, or Use value from data field.

Choose Add Condition.

In the Filters area, the second filter condition appears below the first
condition, as shown in Figure 7-11. By default, the second condition is
preceded by the logical operator, AND.
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Advanced Filter x

Filter By: Product Line - PRODUCTLINE i
Condition: Equal To .
@ Specify literal value () Use value from data fizld

Value: Vintage Cars Select Values

Add Condition Chanae Condition

Filters: Filter conditions

— Logical operators

d t
CITY_25 = San Francisco i
and PRODUCTLINE = Vintage Cars
2
Figure 7-11 Adding or modifying a filter condition

Choose a different logical operator, if necessary.
Add additional filter conditions using the previously outlined method.

If you create more than two filter conditions and you use different logical
operators, you can use the parentheses buttons to group conditions and define
the order of evaluation of the filter conditions.

Choose Validate to verify the syntax of the filter conditions, then choose OK.
Verify that the report displays the results you need.

Selecting a logical operator

As you add each filter condition, Interactive Viewer adds the logical operator
And between each filter condition. You can change the operator to OR. The AND
operator means that both filter conditions must be true for a data row to appear in
the report. The OR operator means that only one condition has to be true for a
data row to appear. You also can add the Not operator to either the AND or OR
operators to exclude a small set of data.

For example, the following filter conditions return only sales data for classic car
items sold by the San Francisco office:

Sales Office = San Francisco
And Product Line = Classic Cars

The following filter conditions return all sales data for the San Francisco and
Boston offices:

Sales Office = San Francisco
Or Sales Office = Boston
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The following filter conditions return sales data for all product lines, except
classic cars, sold by the San Francisco office:

Sales Office San Francisco
And Not (Product Line Classic Cars)

Specifying the evaluation order

Interactive Viewer evaluates filter conditions in the order in which they appear. If
you define more than two conditions, use parentheses to group conditions to get
the appropriate results. For example, A And B Or C is evaluated in that order, so
A and B must be true or C must be true for a data row to be included. In A And

(B Or C), B Or C is evaluated first, so A must be true and B Or C must be true for
a data row to be included. To illustrate the benefit of using parentheses, compare
the following examples.

The following filter contains four conditions and none of the conditions are

grouped:

Sales Office
and ProductLine
and Total >=
or Profit >=

San Francisco
Classic Cars

8000
4500

Figure 7-12 shows the generated report. Although the filter specifies the San
Francisco office and the Classic Cars product line, the report displays data for
other sales offices and product lines. Without any grouped conditions, the filter
includes rows that meet either conditions 1, 2, and 3 or just condition 4.

-'Sales Office: London
Product Line Product Name Total Profit
-Motorcycles
2003 Harley-Davidson Eagle Drag $11,503.14 $5,495.82
Bike
London $11,503.14 $3,495.82
-'Sales Office: NYC
Product Line Product Name Total Profit
-Classic Cars
1552 Alpine Renault 1300 $9,568.73 $4,935.47
2001 Ferrari Enzo £9,571.08 $5,078.35
NYC £10,139.81 £10,013.82
-ISales Office: Paris
Product Line Product Name Total Profit
-Classic Cars
1952 Alpine Renault 1300 £10,072.00 $5,143.00
1952 Alpine Renault 1300 £9,467.68 $4,834.42
1569 Dodge Charger £11,170.52 $5,473.71
15892 Ferrari 360 Spider red £9,445.40 $4,775.40
2001 Ferrari Enzo £8,434.52 $4,515.33
2001 Ferrari Enzo £5,974.40 $5,386.08

Figure 7-12

A report having multiple ungrouped filter conditions
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The following filter contains the same four conditions, but this time the third and
fourth conditions are grouped:

Sales Office = San Francisco
and ProductLine = Classic Cars
and (Total >= 8000

or Profit >= 4500)

Figure 7-13 shows the generated report using grouped filter conditions. In this
example, only two rows meet the defined conditions. The Sales Office = San
Francisco and ProductLine = Classic Cars conditions must be true, then either the
Total >= 8000 condition or the Profit >= 4500 condition is true.

-'Sales Office: San Francisco
Product Line Product Name
-Classic Cars

1552 Alpine Renault 1300 $10,286.40
1572 Alfa Romeo GTA £8,616.96

San Francisco $18,903.36
£18,903.326

Figure 7-13 A report having grouped filter conditions

Changing a condition

In the Filters area on Advanced Filter, select the condition to modify, as shown in
Figure 7-14. Modify the condition by changing the values in Filter By, Condition,
or Value fields. Then, choose Change Condition. Choose OK to apply the
modified condition.

Advanced Filter b4
Select the condition
Filter By: Sales Office - CITY_25 S
Condition: Equal To .
® Speciy teral vab€ () Use value from data field — Modify the condition

Value: San Francisco Select Values

Add Condition Change Coxdition
Filters: Choose Change
Condition

CITY_25 = 5an Francisco
and PRODUCTLINE = Vintage Cars

Validate...

?
Figure 7-14 Changing a filter condition
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Deleting a condition

To delete a condition, select the condition on Filter. Then, select Clear Filter.
Choose OK.

To delete an advanced filter condition, in the Filters area on Advanced Filter,
select the condition. Then, select Delete.

Verify that the remaining filter conditions are still valid.

Filtering data in a merged column

You can also filter data in merged columns. When working with merged columns,
if you choose Filter from the context menu, Select Data Item appears, as shown in
Figure 7-15, providing a drop-down list of columns in the merged column.

Select Data Ttem x
Iy i

’
Figure 7-15 Selecting a data item

From the drop-down list, select the data item or column to filter data. Choose OK.

You can now create filters as described in the previous sections of this document.
To modify each line of data in the merged column, repeat this step for each data
item, and create a filter each time.
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This chapter contains the following topics:

Modifying charts

About charts

Types of charts

Modifying charts in Interactive Viewer
Modifying Flash charts and gadgets
Modifying HTMLS5 charts
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About charts

A chart is a graphical representation of data in a report. You use charts to display
complex data in a format that is easily understood. A report can contain a chart
that functions as a report itself, or it can combine a chart with other report
elements to highlight relevant information. This section provides an overview of
the different types of charts you can modify using Interactive Viewer, and
explains how you can filter chart data, change chart subtypes, and format charts
in a report.

A chart displays data as one or more sets of points. Charts are particularly useful
for summarizing numeric data and showing the relationship between sets of
values called series. The two types of series are category series and value series,
typically denoted by the x- and y-axis. For example, a chart can show sales by
region, average temperatures by month, or the price of a stock over three months.

Interactive Viewer also enables you to modify the subtype, formatting, and layout
of Flash charts and Flash gadgets, as well as HTMLS5 charts, all of which are
animated graphical representations of report data. This section describes Flash
charts and Flash gadgets, and HTMLS5 charts, and explains how you can modify
each of these BIRT report elements.

Types of charts

Specific types of data are best depicted with a specific type of chart. This section
describes the common types of charts you can modify in Interactive Viewer.

About bar charts

A bar chart typically displays data values as a set of vertical bars, but you can
transpose the axis to display horizontal bars. When you view report data in a
chart with vertical bars, you can easily compare the values. A bar chart is useful
to show data changes from one time period to another, for example from one year,
or quarter to another, or to illustrate comparisons among items.

Standard bar charts are side-by-side but you can have stacked and percent
stacked bar charts that also show the relationship of individual items to a whole.
Side-by-side bar chart

Side-by-side bar charts show bars from each series, one beside the other. Each of
these bars have the same width. The width depends on the number of series
being plotted. Figure 8-1 shows a side-by-side bar chart that graphically presents
a company’s sales figures by geographical region.
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Sales by Territory
$260K
$240K
$220K
$200K
$180K
$160K
$140K @ current Year
$120K = Prior Year
$100K
$80K
$60K
$40K
$20K
$0K
Australia New Zealand Singapore
Territory Country State Customer Prior Year Current % Change Trend
Year
APAC $415,840 $220,867 -47%@
ElAustralia 477,057 $53,197 -31% (V)
ENSW $67,642 $42,252 -38% o
Souveniers $67,642 £42,252 -38% @
And Things
Co.

Figure 8-1 Side-by-side bar chart

Stacked bar chart

Stacked bar charts show bars stacked one above the other. The stacked bar chart
shows totals for each series as well as the proportion that each series contributes
to the grand total. The example in Figure 8-2 shows the company’s sales figures
for the current year and previous year, in the form of a stacked bar chart.

Sales by Territory

$440K
$400K
$360K
$320K
$260K
$240K P Prior Year
$200K & current Year
$160K
$120K
$80K
$40K

$0K

Australia New Zealand Singapore

Figure 8-2 Stacked bar chart
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Percent stacked bar chart

In a percent stacked bar chart, multiple series are stacked vertically and the
values appear as a percentage of the whole. The example in Figure 8-3 shows the
company’s sales figures by geographical location in terms of a percentage of the
whole. Figure 8-3 displays the sales values in percentages instead of the actual
numbers shown in the previous bar charts.

The percent stacked bar chart is meaningful only when you need to display and
compare multiple series. Do not use this chart subtype if you are displaying only
one series, for example, only sales for Australia.

Sales by Territory

$0K

(=P Prior Year

-Current Year

$0K

Australia New Zealand Singapore

Figure 8-3 Percent stacked bar chart

About tube, cone, and pyramid charts

Tube, cone, and pyramid charts are variations of the bar chart that use tubular,
conical, and pyramid-shaped risers in place of bars. You use a bar, tube, cone, or
pyramid chart when.you want to display data values as a set of vertical or
horizontal columns.

You can use Interactive Viewer to modify the subtype of tube, cone and pyramid
charts to side-by-side, stacked, or percent stacked type depending on which type
best represents the data being used. You can also specify formatting options for
the chart, as described later in this document.

The example chart shown in Figure 8-4, Figure 8-5, and Figure 8-6 uses the same
data, sales of a product line across quarters, to illustrate these different chart

types.
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Figure 8-4 A tube chart showing sales by quarter
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Figure 8-5 A cone chart showing sales by quarter

Product Line Sales by Quarter
8000 o A A A T A R T T 1

]

Units Sold
2 8 & 2 2
g8 8 8 B8 8

=
=]
=

Q142003 Q342003 Q172004 Q342004 Q172005

Figure 8-6 A pyramid chart showing sales by quarter

About area charts

An area chart displays data values as a set of points connected by a line, with the
area shaded below the line. You use an area chart to present data that occurs over
a continuous period of time. For example, you can use an area chart to view the
percentage of orders and the corresponding unit volume for trains, ships, and
planes over three months.
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Stacked area chart

A stacked area chart consists of multiple series stacked vertically, as shown in
Figure 8-7. The example shows that the stacked area chart is suitable for the data
because the chart displays totals for all series as well as the proportion that each
series contributes to the total. The height of the top line shows the total value for
each category, for each quarter in this example. Each shaded area represents the
sales amount for a specific region.
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Figure 8-7 Area chart

Overlay area chart

Overlay area charts show areas from each series independent of each other. The
areas appear by joining the values for the series. In an overlay area chart, the areas
of multiple series overlap, as shown in Figure 8-8. As the example shows, this
chart subtype is not suitable for showing multiple series if the data values
overlap. Use an overlay area chart if you want to show only one series, for
example, only sales for Asia.
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Figure 8-8 Overlay area chart

Percent stacked area chart

In a percent stacked area chart, multiple series are stacked vertically and the
values appear as a percentage of the total. Figure 8-9 shows the sales values in
percentages instead of the actual numbers as shown in the previous area charts.
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The percent stacked area chart is meaningful only when displaying and
comparing multiple series. If displaying only one series, the percent stacked area
chart appears as in the example shown in Figure 8-10. The sales percentage of one
region compared to the whole is 100%.
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Figure 8-9 Percent stacked area chart showing sales figures
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Figure 8-10 Percentage stacked area chart for a single series

About line charts

A line chart displays data values as a set of points connected by a line. You
typically use line charts to present large amounts of data that occur over a
continuous period of time. A line chart is the most basic type of chart in finance.
Figure 8-11 shows an example of a line chart, displaying the value of the Euro
against the US Dollar over 10 days.
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Figure 8-11 Line chart displaying currency exchange rates
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A line chart is similar to an area chart, except that it does not fill in the area below
the line, and it uses a square to mark each data value. There are three subtypes of
line charts.

Overlay line chart

In an overlay line chart, multiple series appear as overlapping lines, as shown in
Figure 8-12. The squares mark each data value. Overlay line charts show lines
from each series independent of the others. The lines appear joining the values for
the series.
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Figure 8-12 Overlay line chart showing sales by quarter across regions

Stacked line chart

In a stacked line chart, multiple series are stacked vertically, as shown in

Figure 8-13. The stacked line chart shows totals for each series as well as the
proportion that each series contributes to the grand total. In the example, the top
line shows the total sales amounts for each quarter. The empty area between each
line represents the sales amount for a region.

0000
#0000
30000
40000
30000
20000

10000

0

Figure 8-13 Stacked line chart

The stacked line chart is not as effective as the stacked area chart for comparing
the amount that each region series contributes to the total because the areas are
not shaded. In a stacked area chart, the shaded areas provide a clear visual cue

that each part is compared to the whole.

In addition, as the example shows, a user can easily misinterpret the data in a
stacked line chart. There is no obvious indication that the top line shows the total
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sales amount for each quarter and that the middle line shows the difference in the
sales amount between Europe and Asia. A user viewing this chart can
misinterpret the top line to represent the sales data for the U.S., the middle line to
represent the sales data for Europe, and the bottom line to represent the sales data
for Asia.

Percent stacked line chart

A percent stacked line chart consists of multiple series stacked vertically and the
values shown as a percentage of the whole. As shown in Figure 8-14, the sales
values appear as percentages instead of numbers. Like the percent stacked area
chart, the percent stacked line chart makes sense only when displaying and
comparing multiple series. Do not use this chart subtype if you are displaying
only one series, for example, only sales for Europe. Like the stacked line chart, the
percent stacked line chart is not as effective as the percent stacked area chart.
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Figure 8-14 Percent stacked line chart

About pie charts

Pie charts show values as slices of a pie. The size of each slice is proportional to
the value it represents. You plot pie charts for multiple series as multiple pies, one
for each series. You use a pie chart to show the relationship of parts to the whole.
For example, Figure 8-15 shows the contribution of each state to the total sales of
a product.
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Figure 8-15 Pie chart
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About meter charts

A meter chart is very effective when showing a small number of values in a
prominent manner. A meter chart displays a value as a needle pointer on a
circular or semicircular dial. You can use a meter chart to create a gauge or
dashboard display. As Figure 8-16 shows, a meter chart resembles a speedometer,
with tick marks and numbers, showing a range of values. In this example, the
meter chart displays two pointers that represent two values, projected sales total
and actual sales total.

You can show multiple dials in a chart, or one dial with multiple needles, by
using a superimposed meter chart. For example, you can use one needle to show
interior temperature, and another to show exterior temperature.

Legend
. Actual Sales
O Projected Sales

Figure 8-16 Meter chart showing projected sales and actual sales

Standard meter chart

A standard meter chart displays multiple values in multiple dials, where each
dial displays a single value. The meter chart shown in Figure 8-17 displays the
same data as the chart in Figure 8-16, by using two dials instead of a single dial.

Legend
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Figure 8-17 Standard meter chart

Superimposed meter chart

A superimposed meter chart displays multiple values in a single dial, as shown in
Figure 8-16. The dials overlap each other so that the chart can represent multiple
needles within a single region.
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About stock charts

A stock chart shows data as points on a time continuum, such as days of the
week. Stock values appear as a candlestick, a box with lines extending up and
down from the ends. Open and close values mark the upper and lower edges of
the box. High and low values mark the upper and lower points of the line.

Although a stock chart typically displays stock price data, you can also use a
stock chart to show scientific data, such as temperature changes over time.

Candlestick stock chart

Candlestick stock charts contain boxes with lines extending up and down from
the ends. The upper and lower edges are the open and close values of the stock.
The upper and lower points of the line are the high and low values of the stock, as
shown in Figure 8-18. The top and bottom of each box indicate the open and close
values. If the close value is higher than the open value, the box is white. If the
open value is higher than the close value, the box is shaded. This style
immediately provides information about whether a stock posted a gain or a loss
for a given day.
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Figure 8-18 Candlestick stock chart
Figure 8-19 displays the data used for the stock charts shown in Figure 8-18 and
Figure 8-20.
Weekly Price Summary
High: $2.98
Low: $2.03
Ave. Open: $2.51
Ave.Close: £2.57
Figure 8-19 Stock chart data

Bar stick stock chart

Bar stick stock charts consist of a vertical line with two horizontal lines called
ticks attached to it. The upper and lower points of the vertical line are the stock
open and close values. The ticks are the high and low values, as shown in

Figure 8-20.
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Figure 8-20 Bar stick stock chart

The chart in Figure 8-18 shows that the stock posted a gain on the fourth and sixth
day in the trading week and a loss on the other five days. The example in

Figure 8-20 shows a stock with moderate fluctuation. When the stock is volatile
on a given day, the two horizontal lines can appear far above or below the vertical
line. As you can see from the examples, the candlestick stock chart shows the gain
or loss pattern more clearly than the bar stick stock chart.

About scatter charts

A scatter chart presents data as x-y coordinates by combining two sets of numeric
values into single data points. A scatter chart typically displays scientific and
statistical data, because it shows if there is a relationship between two sets of
measurements. Use a scatter chart to compare, for example, salaries and years of
experience, weight and body fat, rainfall amounts and pollen levels, or test scores
and hours of study. The greater the number of data values you include in a scatter
chart, the clearer are the trends the data reveals.

A scatter chart shows data as points. Scatter charts display values on both axes.
For example, the chart in Figure 8-21 shows the relationship between salary and
years of experience. Each pair of values, salary and years of experience, is plotted
as a single x-y value. The chart reveals a positive, or direct, relationship between
salary and years of experience. As the number of years increases, the salary also
increases. The chart also displays the salaries earned by men and women. In this
example, the chart reveals that men consistently earn more than women.
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Figure 8-21 A scatter chart displaying the average salaries by years
of experience

114 Working with Actuate BIRT Viewers



About bubble charts

A bubble chart resembles a scatter chart, but uses bubbles instead of data points.
You choose a bubble chart instead of a scatter chart if you have three values per
data point. For example, Figure 8-22 shows a bubble chart that plots the retail
against the wholesale prices of products, calculates the discount, and uses the size
of the bubbles to show the amount of the discount. The color-coding of the bubble
identifies the product type. Bubble charts typically describe financial data. Use a
bubble chart when you want to represent data using more than two values.
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Figure 8-22 Displaying discount percentage for product types

About difference charts

A difference chart typically shows variation between two sets of data by shading
the areas between points of comparison. You use a difference chart when you
want to use shading and multiple graphs to accentuate the deviation between
data variables. The chart shown in Figure 8-23 displays the lead time between the
shipped date and the required date from the order date.
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Figure 8-23 A difference chart displaying the time taken to ship orders
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Modifying charts in Interactive Viewer

The basic characteristics of a chart are determined in the report design. You can
modify the chart in Interactive Viewer in the following ways:

m  Change the chart subtype.
m Filter data.
m Format the chart.

To choose any of these options, select the chart to highlight it, then right-click the
chart area to display the context menu containing these options.

Changing chart subtype

Area charts, bar charts, cone charts, line charts, pyramid charts, and tube charts
have a stacked subtype and a percent stacked subtype. In a stacked chart, the data
points from one value series are arranged on top of the data points of another
series. You can choose the percent stacked subtype to show the contribution of
individual items to the whole.

If a type of chart offers subtypes, you can change the subtype in Interactive
Viewer. Many chart types offer two-dimensional subtypes, in which the chart
shape appears flat against the chart background. You can also display some charts
in two dimensions with depth, or three dimensions. A chart with depth appears
to have added dimension.

How to modify the chart subtype

1 Select the chart to highlight it. From the context menu choose Change
Subtype.

2 On Chart Subtype choose an option from the available subtypes. Choose OK
to apply your selection.

Filtering chart data

You can filter chart data in the same way that you apply filters to data in any
report column. In a chart you can filter data on the x-axis or the y-axis. Select the
chart, then choose Filter from the context menu. Chart Filter appears, as shown in
Figure 8-24. Complete the steps to apply filters that define what data is displayed
on the axes of the chart.
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The column to evaluate
The comparison operator
The value to which to compare

Filter x
Filter By: Sale Amount
Condition: Equal To —
Value: Select Values
Advanced Filter | Clear Filter
’

Figure 8-24 Creating a filter condition for a chart

You can set limitations on the data that the chart displays by applying a filter in
the same way that you would for any report column. You can also change an
existing filter condition or add conditions by choosing Advanced Filter from
Chart Filter, as shown in Figure 8-25.

Advanced Filter x
Filter By: Sale Amount b
Condition: Equal To .
@ Specify literal value () Use value from data fizld
Value: Select Values
Filter conditions
4dd Condition Chanae Condition
Filters:

__Logical operators
L[]

aate...
2
Figure 8-25 Adding and modifying a filter condition for charts

Formatting the chart

Charts include many different visual elements, as shown in Figure 8-26. You can
customize the appearance of many of these elements using Interactive Viewer. To
clarify the presentation of data, or to create a more pleasing composition, you can
rearrange the layout of the chart. Some of the formatting for a chart, such as the
colors of the bars in a bar chart and the background color of the chart, are defined
in the original report, and cannot be modified. When viewing the report you can
modify the fonts and font sizes of the chart title and axis labels, and the height
and width of the chart. You can hide axis labels, place labels at an angle relative to
the axis, and hide the legend or determine where to display the legend in relation
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to the chart. Depending on the type of chart you are working with, you can also
transpose the axes in some cases.

Figure 8-26 displays the elements of a basic bar chart that you can format using
Interactive Viewer. In this example, the category series consists of a set of regions,
and the value series consists of a set of sales figure values.
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Figure 8-26 Elements of a chart

As mentioned in an earlier section, a chart organizes data points into value sets
called series. Series can be of two types—a category series and a value series. The
category series typically determines what text, numbers, or dates you see on the
x-axis. The value series typically determines the text, numbers, or dates on the
y-axis. A value axis positions data relative to the axis marks. The value of a data
point determines where it appears on a value axis. You do not plot text on a value
axis. In most charts with axes, the x-axis is the category axis, and the y-axis is a
value axis.

The plotting options available for the x- and y-axes can differ in name and
function, depending on the chart type. For example, when you modify a meter
chart, which has no axes, you define the position of a needle on the dial instead of
defining the y-axis. When you modify a pie chart, you define the size of the slices
instead of the y-axis.

Using Interactive Viewer, you can change the titles of the axes, modify the scale of
the y-axis, and modify the labels on the x-axis, by changing the way the values are
displayed, and the existing interval. The following section describes how to
perform each of these tasks.
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Formatting the legend, title, and size of a chart

When you modify a chart, you can add a legend title, choose to display or hide
the legend on the chart, and determine the legend position. You can modify the
font, size, color, and style of the legend and in some cases legend items. You can
also choose to display or hide the chart title and modify the appearance of the title
text in the usual ways, by changing its font properties. In addition, you can
modify the chart’s size and the display dimension of a chart.

How to change the title of a chart
1 Select the chart, and choose Format Chart from the context menu.

2 On Format Chart, shown in Figure 8-27, in Chart, in Title, you can type a title
for the chart, or select Auto to enable Interactive Viewer to specify a title. To
specify font properties, select Title Font. On Font, specify the font, size, color,
background color, and style. You can Preview your selection in the next field.
Choose OK.

How to change the size of a chart

On Format Chart, in the Chart area, type the new values in the Width and Height
fields, then choose a unit of measurement from the next drop-down list. The
example shown in Figure 8-27 uses the unit of measurement, inches.

Format Chart X

« Chart
Title:
Width: 7.5 inches ¥ | Height: 3.5 inches v

Dimensien: zp with Depth - Flip Auds

= Legend

/| Show Legend Position: Right »
+ Category (X) Axis

Title: Label Font

| show Labels Labels Angle: 0.0

Stagger Labels Interval: 1

=« Value (Y) Axis

Y Axis: 1 i

Title: Label Font

/| show Labels Labels Angle: 0.0
Stagger Labels Interval: 1

Min: Max: Step Interval:

g
Figure 8-27 Formatting a chart
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How to modify the dimension of a chart

Choose a dimension for the chart from the Dimension list. You can choose one of
the following:

s 2D
m 2D with depth
s 3D

You can select two-dimensional subtypes for all charts. Choosing 2D displays the
chart flat against the chart background. When you choose the 2D dimension for a
column or bar chart, Interactive Viewer highlights the Use Glass Style field by
default. This option displays the chart with rounded edges in a column or bar
chart. Deselect this option to display a column or bar chart with sharp edges.
Choosing 3D displays the chart against an additional axis to the existing x- and
y-axes, providing greater depth. Choosing 2D with depth, also gives the chart an
appearance of depth.

Figure 8-28 shows an example of a bar chart with a dimension setting of 3D on the
left, and the same bar chart using a dimension setting of 2D with depth, on the
right. Three-dimensional charts show how an object on the z-axis changes
according to the x- and y-axes. The bar chart with two-dimensional depth setting
gives the appearance of a three-dimensional object, but is arranged on the x- and

y-axes only.
R T e [rr—
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Figure 8-28 Comparing charts with 3D and 2D with depth settings

How to interchange the axes of a chart

To interchange the x- and y-axes of a chart, select Flip Axis in the Chart area on
Format Chart. You can flip the axes for some chart types. If this feature is
available for the chart type you are using, the Flip Axis box is visible.

How to format the legend of a chart

1 On Format Chart, select Show Legend to display a legend for the chart. If you
do not select this box, the legend does not appear on the chart. In Position,
select an option from the list to place the legend above, below, to the right, left,
or inside the chart.
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2 Type a title for the legend. If you leave this field blank, no legend title appears
on the chart. In some cases, you can also specify font properties for the legend
title and each legend item.

Formatting the x- and y-axes of a chart

You can use Interactive Viewer to modify axes titles of a chart, and the axis labels.
You can also delete axis titles, and suppress labels. Figure 8-29 shows an example
of the Format Chart dialog box.

Changing the axis titles

Charts other than pie charts and meter charts can have x-axis and y-axis titles. To
add and format an axis title, using Format Chart, you can hide tan axis title, or
modify an existing title. On Format Chart, in the y-axis section, type a title in the
Title field. Then modify the font properties by choosing Title Font.

Changing the axis labels of a chart

A chart displays axis labels by default, to the left of the vertical axis, and below a
horizontal axis. Using Interactive Viewer, you can specify whether to hide or
display labels, and modify the position and appearance of labels so that they are
easier to read. For example, you can rotate or stagger the labels on the x-axis so
that they are easier to fit on the chart and read. You can also modify the label font
by selecting Label Font and setting new font properties.

Format Chart x
~ Chart
Title:
Width: ] inches ¥ | Height: 3 inches >

Dimension: 20 With Depth v Flip Axis
= Legend

V| Show Legend Position: Right v

« Category (X) Axis

Title: Label Font

/| Show Labels Labels Angle: 0.0

Stagger Labels Interval: 1
4 Value (Y) Axis

Y Axis: 1 »
Title: Label Font

| show Labels Labels Angle: 0.0
Stagger Labels Interval: 1

Min: g Max: 240000 step Interval:  4ppon

:

Figure 8-29 Formatting the axes
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Sometimes a chart displays so many values on an axis that the label text overlaps
and is not legible. You can rotate the labels at an angle relative to the axis or
stagger the labels, so that they do not overlap, as shown in Figure 8-30. For
example, you can show data points for every third month, every ten days, every
other year, and so on. To change the label properties, navigate to Format Chart
and specify the values in the Category (X) axis title area.

How to modify the axes labels of a chart

On Format Chart, complete the following steps:

1 You can specify the title of value or y-axis for a chart. You can also specify the
title for an additional y-axis, if the chart contains more than one.

To display labels, select Show labels. To hide labels, deselect Show Labels.
To rotate the labels, specify a degree of rotation in the Labels Angle field.
To stagger labels, select Stagger Labels.

a b~ 0N

If label names are too long, or if the chart looks too crowded when you display
all the labels, you can use Interactive Viewer to specify which labels to skip so
that only the other labels appear on the chart. To skip labels, set the Interval
value at which labels should appear. For example, to show every other label,
use an Interval value of 2. To show every fifth label, use an Interval value of 5,
and so on.You can also modify the font properties for labels by choosing Label
Font. The example in Figure 8-30 shows a chart on the left with staggered
labels, and one on the right with rotated labels.
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Figure 8-30

Staggered labels and rotated labels

Modifying scale

You can modify the scale of the value axis using Interactive Viewer to fit the data
that the axis displays. Category axes do not support scale changes. The scale
determines the range of values on a linear, logarithmic, or date-and-time axis. You
can use the axis scale to change the following settings:

m Minimum and maximum values for an axis

m Step interval

Step Interval is the interval between each value on the value axis or the
distance between major grid marks.
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To set the scale of the y-axis, on Format Chart type values for minimum,
maximum, and step interval in the Value (Y) axis area. The chart on the left in
Figure 8-30 uses a scale between 0 and 240000 and a step value of 40000.

Drilling up or down data hierarchies in a chart

In some charts that contain hierarchical data, such as a chart in a cross tab,
Interactive Viewer supports drilling down into category or value series to view
more detailed data, or drilling up to view summary data. In a chart, drill-up or
drill-down capability is available for a category or value series. For example, if the
category axis of a chart displays location in regions, such as North America,
EMEA, APAC, and so on, you can select a region to view detailed data for that
region. You can then select each country in the region to view detailed data for
that country, and select each city to view details about sales, customers, and so on,
in the selected city. Similarly, you can drill up from a city view, to get a
summarized country view of the data, or a broader region view of the data.

In the following example, the category axis displays time in years. By selecting
the label for each year, you can drill down to view detailed data for each quarter
in the year and further to view details for each month in the quarter. Similarly,
you can drill up to view summarized data for the same hierarchies. You can drill
up from a month view, to a quarter view, or directly to a year view of the data in
the chart. This section also explains how you can perform a similar action on
hierarchical data in a value series.

How to drill down through a category series to view detailed information

1 In Interactive Viewer, select the chart. From the chart menu, choose Drill into
"Year', as shown in Figure 8-31.

£l Drill into “year

Filter ’ Chart Title
[11] change Subtype
Li| Format Chart
|L:f> Export Content
3M
2M
1M ‘ ‘
0

2003 2004 2005

Figure 8-31 Drilling into a year category

2 Categories appears listing the years for which data is available. Select a year
from the list, as shown in Figure 8-32. Choose OK.
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2005-01-01 00:00:00.000-0800

Figure 8-32 Selecting a year
The chart displays data for the selected year, as shown in Figure 8-33.
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Figure 8-33 Chart displaying data for two quarters in the year 2005

3 To drill further into subcategories of the data, from the chart menu, choose
Drill into 'Quarter'.

4 Categories appears listing the quarters for which data can be viewed. Select
the quarter for which you want to view detailed data, then choose OK.

The chart displays data for the quarter you selected.

How to drill up through a category series to view summary information

To drill up to a higher level in the data hierarchy, from the context menu, as
shown in Figure 8-34, choose Drill up to 'Year' or Drill up to 'Quarter’.

E

& Drill up to 'Year'
£ Drill up to 'Quarter’
Filter 4

[11] change Subtype
Lj_| Format Chart

|2 Export Content

Figure 8-34 Drill-up menu
The chart in the report displays the data for the selected category.

In the following example, the category axis displays the Product Line, and the
value axis displays sales. The data in the value series is grouped by year. You can
drill down to view sales by product line for each year, or up to a higher level to
view summary information across years.
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How to drill down through a value series to view detailed information

1 In Interactive Viewer, select the chart. From the chart menu, choose Drill into
"Year,' as shown in Figure 8-35.

—
&L Drill into 'PRODUCTLINE

&l Drill into "Year Cha rt Title
Filter 3

hl| Change Subtype
Lj_| Format Chart

- ils 2003
=3 Export Content
s 2004
360K H 1 : H
Classic Cars Planes Trains Vintage Cars
Motorcycles Ships  Trucks and Buses
Figure 8-35 Drilling into time series

2 Series appears listing the years for which data is available. Select a year from
the list, as shown in Figure 8-36. Choose OK.

Series x

Series: 2003 e
2003
2004

2005 &

Figure 8-36 Selecting a series value
The chart displays data for the selected year, 2005, as shown in Figure 8-37.

S00K
400K

300K B 1

200K - ih 2
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Classic Cars Planes Trains Vintage Cars
Motorcycles Ships Trucks and Buses

100K

0

Figure 8-37 Chart displaying sales for each quarter in 2005

3 To drill further into subcategories of the data, from the chart menu, choose
Drill into 'Quarter’.

4 Series appears listing the quarters for which data can be viewed. Select the
quarter for which you want to view detailed data, then choose OK.

The chart displays data for the quarter you selected.
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How to drill up through a value series to view summary information

To drill up to a higher level in the data hierarchy, from the context menu, as
shown in Figure 8-38, choose Drill up to "Year.' The chart in the report displays the
data for the selected series.

b Drill into 'PRODUCTLINE
&1 Drill up to "Year'
&l prill into 'Quarter’
Filter 3

hl| Change Subtype
|4] Format Chart

||_:f> Export Content

Figure 8-38 Selecting an option to view summary data

Interactive Viewer supports drill-up and drill-down capability for the following
types of charts:

m Bar

m Line

m Area

m Pie

m  Scatter

m Bubble

m  Stock

m Difference
m Tube

m Cone

m Pyramid

Switching views between a chart and a report element

If data in a report table or a cross tab is also represented graphically in a chart, in
some cases you can switch between the chart view of the data, and the tabular
view of the data, using Interactive Viewer. The report developer must set this
option when designing the report element and chart, for a user to be able to
switch views in Interactive Viewer.

How to switch between a table and chart view of data

In Interactive Viewer, select the table, and choose Switch View from the main
menu. The chart view of the data appears.
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If you are working with a cross tab, choose Switch View from the context menu.
You can also further Analyze the data in a cross tab, by choosing the Analyze
option from the context menu. The cross tab is appears in BIRT Data Analyzer if
you have purchased this licensed option.

Similarly to switch back to the table view, choose Switch View from the chart
menu, as shown in Figure 8-39. The table or cross-tab view of the data appears.

[11] change Subtype
|4] Format Chart

|2 Export Content

Figure 8-39 Selecting Switch View

Exporting data from a chart

| 2| Youcan export data from a chart to a flat file format, that uses a comma, tab, pipe,
or semicolon delimiter. These file formats can be read by Microsoft Excel.

How to export data from a chart

Select the chart, and choose Export Data from the chart menu. On Export Data,
specify the data to export, and other options, in the same way you did when
exporting report data.

Exporting a chart

.| You can export a chart to Excel, Excel 2007 and 2010, Microsoft Word, Microsoft
Word 2007 and 2010, Microsoft PowerPoint, Microsoft PowerPoint 2007 and 2010,
PDEF, and PostScript formats.
How to export a chart to other formats

Select the chart, and choose Export Content from the chart menu. On Export
Content, specify the options in the same way you did when exporting report
content. Additionally, you can specify:

m Resolution in DPI at which to export the chart

m Exporting the chart as an image

Modifying Flash charts and gadgets

Standard charts display data statically. Flash charts can contain animation or
other features that Flash provides. Flash charts are similar to standard charts, and
are used in the same manner. Flash gadgets are a chart-like set of visualizations
that generally display a single value, such as a meter or a gauge.
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Flash charts and gadgets add animation and other visual elements that display
data in a manner that is easy to understand. Gadgets differ from charts in that
they generally only display a single value or a set of independent values and can
represent less complex sets of data.

If your report contains Flash charts and gadgets, you can use Interactive Viewer
to modify the subtype of the chart or gadget, format the information that the chart
or gadget illustrates, create filters for chart or gadget data, and export chart or
gadget data, in a manner that is similar to performing these actions for standard
chart data.

The example in Figure 8-40 shows a doughnut chart on the left, and a segmented
doughnut chart on the right.

|—2,448.96 S 448 96
658.91—\\\ 658.91—\‘
595.55—/ 395 55—/
1,105.59 1,105.58
423.07'/ ]. |_ 423.0?‘/
13177 610 62 131.?7—’- =619 672
Figure 8-40 Regular and segmented doughnut Flash chart

Sometimes, based on the type of Flash chart or gadget you use, additional options
are available in the context menu. For example, if you use a pie or doughnut
chart, you can enable rotation, or enable slicing-off of the segments of the chart
when you choose each segment. If you use a Flash bar chart, you can move the
labels by dragging them from their original position and dropping them in a new
position.

Using Flash gadgets

You can work with meter, linear gauge, cylinder, thermometer, bullet, and
sparkline gadgets using Interactive Viewer. The following section describes these
gadgets and shows examples of each type of gadget.

Meter gadget

A meter is similar to the speedometer or fuel gauge of a car. It uses a radial scale
to display the data range, and a dial to indicate the data value. A meter displays
the specific data, utilizing an indicator that moves within a circular range to
indicate whether the monitored data is within defined limits. You can select
colors for the data range to suit the application, such as green for satisfactory,
yellow for caution, and red for alarm.
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You can convert meter gadgets into linear gauge gadgets as described later in this
document. The example in Figure 8-41 shows shipped orders illustrated using a

meter gadget.

Shipped Orders

F2M F2.5M F3M

(On Hold Orders |Resc|lvcd Orders ‘TDhl] Orders

Shipped Orders |Cance]1ed Orders |In Process Orders |Disp|1ted Orders
5 39,550.60 $3,273,280.05

$3,032,204.26 $41,44521 513,488 54 S 0.00 5 146,561 44

Figure 8-41 Meter gadget

Linear gauge gadget

A linear gauge is a slider gauge with many additional features. It uses a
horizontal scale to display your data range and fully configured data needles to
indicate data values.

You can convert linear gauge gadgets into meter gadgets. The example in
Figure 8-42 uses a linear gauge to illustrate the amount for resolved orders.

Resolved Orders

1 1
FgFeE ssooKk  s1m $1sM 0 s2m $25Mm 3anFIIWEEM pam $45M gEM

(On Hold Orders |Resolved Orders ‘TDld] Orders

Shipped Orders |Cance]led Orders |In Process Orders ‘Dispnted Orders
IS 146,561 .44 $ 39,580.60 $3,273,2580.05

53,032,204.26 ‘aa 41,4451 513,458 54 ‘s 0.00

Figure 8-42 Linear gauge gadget

Cylinder gauge gadget

A cylinder gauge is represented by a vertical cylinder, whose fill level is
indicative of the data to be displayed. It is used to show inventory levels, power
plant reports, and fuel levels. The example in Figure 8-43 uses a cylinder gadget
to illustrate the amount for orders that are on hold.
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Orders on Hold

F160K
F135K
F120K
F105K
a0k
F75K
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F20K
F15K
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$146.56H

Shipped Orders |Cancelled Orders (In Process Orders |Disputed Orders (On Hold Orders |Resolved Orders [Total Orders
$3,032,204.26 54144521 $13,48854 $0.00 5146,561.44 S 39,580.60 153,273,280.05

Figure 8-43 Cylinder gadget

You can convert cylinder gadgets into thermometer or bullet gadgets, as
described later in this document.

Thermometer gadget

A thermometer gadget, as the name implies, displays temperatures. The fill level
of the thermometer indicates the data to display.

You can convert thermometer gadgets to cylinder gadgets or bullet gadgets, as
described later in this document. The example in Figure 8-44 shows a
thermometer gadget illustrating the amount for cancelled orders.

Cancelled Orders

FEM ———
F45M —
Fhd —
FIEM —
F3M —
F2.5M —
2z —
F1EM —
F1M —
FE00K —

®

$41.45K

Shipped Orders [Cancelled Orders |In Process Orders |Disputed Orders (On Hold Orders |Reso]ved Orders |Total Orders
$3,052,204.26 541,445.21 $134588.54 $0.00 5 146,561.44 S 39,560.60 15 3,273,280.05

Figure 8-44 Thermometer gadget

Bullet gadgets

A bullet gadget is a variation of a bar chart and serves as a replacement for
dashboard gauges and meters, which typically require too much space, and are
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cluttered with distracting decoration. There are horizontal and vertical bullet
gadgets. The example in Figure 8-45, shows a horizontal bullet gadget,
illustrating the amount for orders in progress.

Orders in progress

$13.49K

FO OF2ZK FAK FGK O FSK F10K F12K §14k F16K F15k F20K

Shipped Orders |Cancelled Orders [In Process Orders [Disputed Orders (On Hold Orders |[Resolved Orders [Total Orders
$3,032,204.26 541,445.21 $13458.54 5 0.00 5 146,561 .44 5 39,580.60 $3,273,280.05
Figure 8-45 Bullet gadget

You can convert bullet gadgets into cylinder gadgets or thermometer gadgets, as
described in this document.

Sparkline gadget

Sparkline gadgets are data-intense, design-simple, word-sized graphics charts for
embedding in a context of words, numbers, and images. Whereas the typical
chart shows as much data as possible, and is set off from the flow of text,
sparkline gadgets are succinct, memorable, and located where they are discussed.
The example in Figure 8-46, shows a sparkline gadget illustrating the volatility of
product line orders. Sparkline gadgets have no subtypes.

Product Line Total Ordered Orders by month, 2003 Orders by month, 2004
1 1
[ /\
224 /I | 1201 [3.28K120] 1,07k J-' '.‘ 147K [ETKIE0]
. \aW W
Classic Cars Bea7 <V N/ ~
1 1
220 \ 427 (1ekRa) gm0 N [\ a2 1akz1a
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/ | %
460 / \ 225 [1.00K225] 413 .'I 243 [1.23K]134]
= -, ."
Ll \
Planes 9,663 ¥
7 A
/ A
201 /;f 021 [221)234] @32 __.-' a65 [[47]267]
-— —_(’ D
Ships 7,153
Figure 8-46 Sparkline gadgets
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The use of sparkline gadgets inline typically means that they are about the same
height as the surrounding text. Also, sparkline charts can be used in
space-efficient executive dashboards to show a lot of KPIs in a single view.

Modifying the subtype of a Flash chart or gadget

You can modify Flash charts in the same way that you modify a standard chart.
Similar chart subtype options are available in the standard chart subtype and
Flash chart subtype menus. For Flash gadgets the available subtypes depend on
the gadget. For example, you can change the subtype of a meter gadget to a linear
gadget, or change the subtype of a bullet gadget to a cylinder or thermometer
gadget.

How to modify the subtype of a Flash chart

1 To change Flash chart subtypes, select the chart or gadget to highlight it, then
choose Change Subtype from the chart menu.

2 On Chart Subtype, select a subtype, then choose OK.

How to modify the subtype of a Flash gadget

1 To change Flash gadget subtypes, select the gadget to highlight it, then choose
Change Type from the gadget menu.

2 On Flash Gadget Type, select the subtype. Then, choose OK.

The example in Figure 8-47, shows how you can change the subtype of a meter
gadget to a linear gauge.

Flash Gadget Type b 4
[ B
Linear Gauge

’

Figure 8-47 Changing the subtype of a meter gadget

In the example in Figure 8-48, you change the subtype of a cylinder gadget to a
bullet, or thermometer gadget.

Flash Gadget Type x

L

Thermometer Bullet

g
Figure 8-48 Changing the subtype of a cylinder gadget
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Formatting a Flash chart

You can format data in Flash charts in the same way that you format data in a
standard chart. You can modify the font used for the chart title, the axes, the
legend, and the tooltip of a chart. The font used for the tooltip is called the base
font. The font used for the chart title, axis labels, and legend is known as outside
font. You can specify the font type, size and color for base fonts and outside fonts.

How to format a Flash chart

To format a Flash chart, select the chart. Then, choose Format Chart from the chart
menu and modify the information on Format as needed. Choose OK.

Formatting a Flash gadget

Each gadget has a different set of formatting properties, which change specific
aspects of the gadget’s appearance. Figure 8-49 displays the formatting options
you can modify in a linear gadget. Figure 8-50 and Figure 8-51 display the Format
Flash Gadget dialog box for the linear gadget.

Resolved Orders
/ Plot value
i) £3.27H Needles
A £ A 4 :
/ “ Regions
—— Tick marks
30 900K SOI0K H1ZM $15M S2M 24 S26M §22M SN Bam—— Scale

Figure 8-49 Formatting options displayed for a linear gauge gadget

Format Flash Gadget b 4

= Flash Gadget
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Height 5 inches v
Font Acial v| 10 | Auto >
Show Tooltip
+ Needle

Show Meedle Value  ghgye Nesdle v
Show Needle On Top v
+ Scale

Show Value

[T] Auto values

Minimum Value 0

Maximum Value 100000

e —
Figure 8-50 Formatting Flash gadget dimensions, needle values, and scale
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Figure 8-51 Formatting Flash gadget region and tick marks

For each Flash gadget you can modify a set of general formatting options, as well
as needle, plot, scale, region, tick marks, and value properties.

The following section describes the formatting options you can modify for each
type of gadget.
Modifying general properties

General properties of a gadget control overall appearance, such as color, size, and
font properties. General properties can also define the title text, tooltip, and
orientation for specific gadget types.

Table 8-1 describes the general formatting properties available to specific gadgets,
and their usage.

Table 8-1 Formatting general properties
Option Gadget Usage
Color Bullet, cylinder, Sets the color of the gauge.
thermometer
Font All Set the font type, size, style, and
color of displayed values. You
can select a standard color using
color picker, or specify a custom
color.
Height All Specifies the height of the
gadget.
Orientation Bullet Specifies whether to display the
gadget horizontally or vertically.
Title Sparkline, bullet Adds a title to the gadget.
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Table 8-1 Formatting general properties

Option Gadget Usage

Tooltip Linear gauge, meter Specifies text for the tooltip.

Width All Specifies the width of the
gadget.

Modifying needle properties

Needle properties define the position of a needle. A needle appears only in a
linear gauge and in a meter gauge. Table 8-2 describes the needle properties you
can modify in Interactive Viewer.

Table 8-2 Formatting needle properties
Option Gadget Usage
Show Needle Linear gauge, meter Specifies the position of the
On needle
Show Needle Meter Displays or suppresses the
Value value to which the needle

points, and specifies the display
position for the values

Modifying plot properties
Plot properties control the appearance of elements in the data plot area of bullet

and sparkline gadgets. In both gadgets, you can specify whether to display or
hide plot values.

Additionally, in a sparkline gadget, you can specify whether to display the open,
close, lowest, or highest values. Table 8-3 describes the plot properties you can
modify using Interactive Viewer.

Table 8-3 Formatting plot properties
Option Gadget Usage
Show Close Sparkline Enables and disables the display
Value of the close value
Show High and  Sparkline Enables and disables the display
Low Values of the high and low values
Show Open Sparkline Enables and disables the display
Value of the open value
Show Plot Value Bullet, sparkline Displays or suppresses the

plotted values
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Modifying scale properties

Scale properties define the range of values and the number of tick marks that a
gadget displays. The scale properties affect the numbers displayed on the gadget,
not its size. Minimum Value and Maximum Value specify the lowest and highest
numbers, respectively. However, if the data set value (represented by the needle
value) is lower than the minimum value or higher than the maximum value, the
minimum or maximum value is ignored. Table 8-4 describes the scale properties
you can modify using Interactive Viewer.

Table 8-4 Formatting scale properties
Option Gadget Usage
Auto Values All Enables a scale to be specified by
Interactive Viewer
Maximum All Sets the highest value of the
Value scale
Minimum All Sets the lowest value of the scale
Value
Show Values Cylinder, meter, bullet, Shows values of the scale

linear gauge

Modifying region properties

Region properties enable the division of the data plot into regions. Use regions to
provide more information about values in a gadget. Table 8-5 describes the region
formatting properties you can modify in Interactive Viewer.

Table 8-5 Formatting region properties

Option Gadget Usage

Color Linear gauge, meter, Specifies the color of the region.
bullet

End Value Linear gauge, meter, Specifies where the region ends.
bullet

Label Linear gauge, meter, Specifies the name of the region.
bullet

Region Linear gauge, meter, Chooses the region for which the
bullet settings apply. You can also add

or remove a region from the list.

Start Value Linear gauge, meter, Specifies where the region starts.
bullet

Show Labels Linear gauge Displays or suppresses the

region labels.

136 Working with Actuate BIRT Viewers



Modifying tick marks

Ticks properties define the position and count of tick marks on a gadget. Tick
marks can appear in the positions listed in Table 8-6.

Table 8-6 Formatting tick marks
Option Gadget Usage
Auto Adjust All but sparkline Enables or disables tick marks
Tick Marks created evenly across the scale
Position Cylinder, thermometer Positions tick marks on the right

Position Above
Position Below
Position Left

Show Tick
Marks

Show Tick
Values

Major
Tickmarks
Count

Linear gauge, meter,
bullet

Linear gauge, meter,
bullet

Cylinder, thermometer

Linear gauge, meter,
bullet, cylinder,
thermometer

Linear gauge, meter,
bullet, cylinder,
thermometer

All but sparkline

side of the gadget

Sets tick marks to appear above
the gadget

Sets tick marks to appear below
the gadget

Positions tick marks on the left
side of the gadget

Enables or disables the display
of tick marks on the gadget

Enables or disables the display
of values on tick marks

Specifies the number of tick
marks to display on the scale

Modifying the value property

You can also display or hide the value in a cylinder or thermometer gadget, as
described in Table 8-7.

Table 8-7 Formatting the value property
Option Gadget Usage
Show Value Cylinder, thermometer Displays or hides the value

illustrated in the gadget

How to format a Flash gadget

To format a Flash gadget, select the gadget. Select Format Flash Gadget from the
gadget menu and modify the information on Format as needed.

Choose OK to apply your selection.
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Filtering data in a Flash chart or gadget

You can also create filters for chart and gadget data in the same way you do for
standard charts. You can limit the appearance of data on a chart or gadget by
setting filters for the chart or gadget data.

How to filter data in a Flash chart or gadget

Select the chart or gadget, and choose Filter from the chart or gadget menu.
Create conditions as needed. To define more than one condition, choose
Advanced Filter and modify the options in the same way you did when creating
filters for report data.

Drilling up or down data hierarchies in a Flash chart

Drilling up and down data hierarchies in a Flash chart function the same way as
for regular charts. Interactive Viewer supports drilling up to view summary
information and drilling down to view details for the following Flash chart types:

s Column
m Bar

m Line

m Pie

m Doughnut

Selecting a legend item to hide specific Flash chart
data
If a Flash chart contains more than one value series, you can also use the legend of

the chart to toggle between the series. For example, in Figure 8-52, from the
legend, select Series 1 to hide profit values in the chart.

B
4.8M
3.6M
il Series 1
2.4M il Series 2

1.2M

0

Boston London WYC  Paris San Sydney Tokyo
Francisco

Figure 8-52 Selecting a legend value
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L

The chart now displays revenue by sales office only, as shown in Figure 8-53. This
option provides a quick view of the data for each series.

To redisplay profit values in the Flash chart, select Series 1 in the legend. The
Flash chart displays both sets of values.

BM

-
3.6M _

Series 1
2.4M il Series 2

1.2M

/

Boston London NYCZ  Paris San Sydney Tokyo
Francisco

Figure 8-53 Chart displaying revenue by sales office

Exporting data from a Flash chart or gadget

In Actuate 11 and later releases, you can export data from a Flash chart or gadget
to a flat file format, which uses a comma, tab, pipe, or semicolon delimiter. These
file formats can be read by Microsoft Excel.

How to export data from a Flash chart or gadget

Select the chart or the gadget, and choose Export Data from the chart or gadget
menu. On Export Data, specify the data to export, and other options, in the same
way you did when exporting report data.

Exporting a Flash chart or gadget

Using Interactive Viewer, you can export a Flash chart, or gadget to PDF format.

How to export a Flash chart or gadget

Select the chart or the gadget, and choose Export Content from the chart or
gadget menu. On Export Content, specify the options in the same way you did
when exporting report content. Additionally, specify the resolution in DPI at
which to export the chart or gadget.

Printing a Flash chart or gadget

Interactive Viewer enables you to print a Flash chart or gadget.
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How to print a Flash chart or gadget

Select the Flash chart or gadget. From the context menu, choose Print Chart and
specify the printer to which you want to send the print job.

Using effects

In some types of Flash charts, you can use the context menu to set or modify
visual animation effects. For example, in a pie or doughnut chart, you can specify
the following properties:

m Enable rotation of the pie or doughnut.
This option causes the pie or doughnut to rotate.

m Enable slicing movement.

This option causes each segment of the pie or doughnut, appears to slice away
from the original chart.

Modifying Adobe Flash Player options

This section describes how to modify Adobe Flash Player to display redraw
regions, debug and correct scripting errors, change the settings of the Flash
player, and get more information about the version of Adobe Flash Player
currently in use. To get more information about your version of Adobe Flash
Player, select the chart or gadget, then choose About Adobe Flash Player from the
context menu.

Displaying redraw regions

A redraw region is the area around a chart or gadget that is redrawn when that
object changes. Everything in a redraw region is redrawn during the next
rendering phase after an object changes. Displaying a redraw region provides you
with information about changes made to the Flash chart. Sometimes Flash Player
combines several closely spaced objects together in a single redraw region,
improving performance speed of the objects being rendered.

To display redraw regions, select the chart or gadget, and choose Redraw region
from the context menu. A red box appears on the object showing the redraw
region.

Using the debugger option

You can use this option to debug and correct errors that occur in the scripts and
code that run Flash charts and gadgets. To use the debugger option, select the
chart or gadget, and choose Debugger from the context menu.
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Modifying settings

You use this option to customize Adobe Flash Player settings based on your
requirements. You can modify display, privacy, local storage, microphone, and
camera settings. To modify Flash Player settings, select the chart or gadget, and
choose Settings from the context menu. Make the modifications on the Adobe
Flash Player Settings dialog box that appears. Choose Close.

Modifying HTMLS5 charts

Actuate BIRT Viewers support a chart format built on HTMLS5 technology.
HTMLS is an open standard for structuring and presenting content for the World
Wide Web, and is increasingly regarded as the alternative to Flash when creating
interactive and animated content for traditional and mobile devices. You can use
the viewers to view HTMLD5 charts created using BIRT Designer Professional.

HTMLS5 charts are animated charts that you can view on all platforms and mobile
devices. Report developers who create these charts can use scripting to customize
properties such as presentation, design time, and generation time to a greater
extent than when using Flash charts. Standard BIRT charts support extensive
scripting but do not support animation.

Information about working with regular charts, Flash charts, and Flash objects in
a report is provided in an earlier section in this document. The following section
describes how you can use Interactive Viewer to work with HTMLS5 charts to
modify formatting properties, create filters to view specific data, export data and
export the charts to various supported formats. Figure 8-54 shows an example of
an HTMLS bar chart displaying total sales by country and produce line.

1.250.000
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Figure 8-54 HTMLS5 bar chart displaying total sales amounts
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Comparing HTML5, Flash, and standard charts
Table 8-8 provides a comparison of the different chart types supported in Actuate

BIRT Viewers.

Table 8-8 Features available in HTMLS5, Flash, and standard charts
Function HTML5 Flash Standard
Displays in the web viewer v v v
Displays in PDF v v
Displays in other document formats v v
(DOC, PPT, XLS, etc.) as a static image
Supported on mobile devices v limited v
Provides animation 4 4
Supports customization through scripting v limited v
Rank in number of available chart types, 3 1 2

1 being the highest

HTMLS charts support commonly used chart types, such as column, bar, line, pie,
doughnut, scatter, and area charts.

Formatting an HTML5 chart

The formatting options available for an HTML5 chart are similar to those
available for standard charts. For a bar, column, line, or area chart, the formatting
options available for HTML5 charts are the same as the options you use to format
standard charts, except that you cannot set the dimension for HTMLS5 versions of
these chart types. For pie and doughnut charts you can modify the chart title, and
specify the width and height.

Filtering data in an HTML5 chart

You can also create filters for HTML5 chart data in the same way you do for
standard charts. You can limit the appearance of data on a chart by setting filters
for the chart data.

How to filter data in an HTML5 chart

Select the chart, and choose Filter from the chart menu. Create conditions as
needed. To define more than one condition, choose Advanced Filter and modify
the options in the same way you did when creating filters for report data.
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Drilling up and down data hierarchies

Interactive Viewer supports drilling up to view summary information and
drilling down to view details for the following HTML5 chart types:

m  Column
m Bar

m Line

m Pie

Drilling up and down data hierarchies in an HTML5 chart function the same way
as for regular charts.

Selecting a legend item to hide specific chart data

Using Interactive Viewer, you can select a legend item in an HTMLS5 chart, to hide
data for that item in the chart. For example, the bar chart in Figure 8-55 shows
sales totals by product line, grouped by country. Select each product line in the
legend for which you want to hide data. In the example, the chart displays sales
information for the Planes, Ships, and Trains product lines. Each selected legend
item is displayed in gray, and the corresponding data hidden in the chart.

250,000

200,000

Planes
150,000 Ships
M Trains

100,000
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0 - [ |

Germa:y Japan_ Singapore UK USA
Figure 8-55 Selecting each legend item hides the data in the chart

Using effects in HTML5 charts

When working with a pie or doughnut chart in Interactive Viewer, selecting a
slice in a pie chart or a segment in a doughnut chart causes that slice or segment
to explode from the chart, or move outward. The example in Figure 8-56 shows a
slice exploding from the pie chart.
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Figure 8-56 Exploding a slice in a pie chart

Exporting data from an HTML5 chart

You can export data from an HTML5 chart to a flat file format, which uses a
comma, tab, pipe, or semicolon delimiter. These file formats can be read by
Microsoft Excel.

How to export data from an HTML5 chart

Select the chart and choose Export Data from the chart menu. On Export Data,
specify the data to export, and other options, in the same way you did when
exporting report data.

Exporting an HTMLS5 chart

Using Interactive Viewer, you can export an HTMLS5 chart to all other supported
formats, but the chart displays as a static image. The chart is identical in
appearance to the chart displayed in the viewer.

How to export an HTML5 chart

Select the chart, and choose Export content from the chart menu. On Export
Content, specify the options in the same way you did when exporting report
content. Additionally, specify the resolution in DPI at which to export the chart.

Printing an HTML5 chart

Interactive Viewer enables you to print an HTML5 chart.

How to print an HTML5 chart

From the main menu, choose Print and specify the printer to which you want to
send the print job.
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Modifying cross tabs

This chapter contains the following topics:

About cross tabs

Formatting cross-tab data
Analyzing cross-tab data
Exporting cross-tab content
Modifying charts in a cross tab
Printing a cross tab

Saving a cross tab
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About cross tabs

A cross tab displays summary, or aggregate values, such as sums, counts, or
averages, in a row-and-column matrix similar to a spreadsheet. For example, you
can use a cross tab to view sales data for each product line, by year, or total sales
for each product line, by geography, and so on.

In Interactive Viewer, you can modify and format a cross tab to change the
appearance of specific data values. You can also display detail information for
data values to view important summary information at a glance. You can export
cross-tab content to other formats such as Excel, Word, PowerPoint, PostScript, or
PDE. You can also print cross tab content, modify charts, Flash charts and Flash
gadgets in a cross tab, and save a cross tab as a BIRT design (.rptdesign) or BIRT
document (.rptdocument) file.

If you need to drill further to analyze the data in various situations, you can
launch Actuate BIRT Data Analyzer, which enables you to manipulate the data in
the cross tab, create a pivot table of cross-tab data, and display more detailed
information for existing data.

Introducing a cross tab

A cross tab is ideal for summarizing data in a compact and concise format. The
aggregate values in a cross tab are arranged in dimensions and measures, and
each cross tab can display multiple dimensions and multiple measures. The data
for a cross tab is derived from a cube, which also arranges data in dimensions and
measures. Dimensions are categories, such as products, customers, or sales
periods, by which measures are aggregated. Measures represent values that are
counted or aggregated, such as costs or units of products.

A cross tab has the following characteristics:

m [trequires at least three fields. In the example cross tab shown in Figure 9-1,
the three fields are year, product line, and revenue.

m  One field populates the column headings in the cross tab. There is one column
for each unique value in the field.

m  One field populates the row headings in the cross tab. There is one row for
each unique value in the field.

m  One field's values are aggregated, and these values populate the cells of the
cross tab. In the example, each cell displays a sales total by product line, for
each month and quarter, in the year 2004. The sales total is calculated by
applying the SUM aggregate function across the values in the extended price
field.

146 Working with Actuate BIRT Viewers



Parts of a cross tab

A cross tab consists of the following three areas, as shown in Figure 9-1:
m  The row area

m  The column area

m  The detail area

The row and column areas contain the dimensions. The dimension values form
the row and column headings of the cross tab. The detail area contains one or
more measures to display aggregate data.

Figure 9-1 shows the example report, which groups data by month, quarter, and
year. Each number in the cross tab represents the sales total of a particular
product for a particular month. Grand Total displays the total sales of all products
for each month, the total sales for each quarter, and the total sales across months
and quarters in 2004. Grand Total also displays the total sales for each product
line by month, quarter, and for the whole year.

Rows Columns
/ Cars Motorcycles Planes Ships Trains Trucks and Buses Vintage Cars Grand Total

Revemie Reveme Reverme Reveme Revemie Reveme Reveme Reverme |

$108,562 439,987 $31,158  $26,310  $6,387 $42,909 $256,315

n $108,25¢2 $45,694 $34,000 $24.894 $4.763 $35749 348,688 $302,021

— $99.512 $15553  $9.879 $32.193 $45.,252 $202.395

$317.307 $85.682  $65,159 66,763 $21.029 $67.942 $136,849 $760,730

n $89.998 $32.223 $33.882 310,808 3333852 $200.289

“ $70,698 $47.873 $35,898 $3.240 $4.862 $31729 $38.596 $233.036

“ $46,025 $16.472 $41.967 $48,110 $162,574
$206,722 $80,101  $69,780 $30.719 $4.862 $73.696 $119,998 $585,879 .
$138,040 465,156 43,256 $20,260  $6,985 $36.967 §72.418 4388.082| — Detail
(e 140,458 455,640 $32.083  $e3L85  §7.132 32,147 $65,019 $355,364 area

“ $140.177 36,515 $30,634 $23.114 $5.611 337720 362,984 $306.755

$410,675  $127.311 $105,974 $66,859 $21.728 $106,834  $200,421  $1,048,801

$210.010 $69.147 §31.081  $40.831  $13.781 $68.620 $107.121 540,642

$397.634 §121.,934 597607 $43535  $12.148 $70.998 §183.657 $935.713

$131,433 $43,069 $68,654  $43.838  $13,350 $52612 $75.,882 $428,838

$739.277 $234,150 $197.342 $128.254 $39.278 $200,231 $366,660  $1,905,193

1,682,980 §527.244  §430.255  $292,595  BEG.BYT $448.703 §823.828  $4.300603] |
Grand Total $1,682,980 §527.244  §430.255  §292,595  $86.697 $448.703 $823.926 [ $4,300,603)
Figure 9-1 Parts of a cross tab

Formatting cross-tab data

You can use Interactive Viewer to improve the presentation of data in a cross tab.
You can modify the appearance of the dimensions and measures in a cross tab by
specifying formatting properties. For example, to indicate that the numbers
displayed in the cross tab are currency amounts, you apply the currency format
that displays a currency symbol alongside the amount. It is also easier to read the
numbers if they are aligned to the right. Using color, you can differentiate the
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product line subtotals that run horizontally across the report, from the quarterly
and yearly grand totals that run vertically down the report.

In Interactive Viewer, you can change the appearance of data in a cross tab in the
following ways:

m Format data and labels by specifying font properties, and text alignment for a
label, data element, or for the cross tab.

m Change the width of a column or the height of a row.

m Format data strings depending on the type of data in the data element.

Selecting a cross-tab element

To view available formatting options, select a cross-tab element. From the context
menu, choose Format, or Alignment to view the formatting options for the
selected element. For example:

m To format a label, select the label, then from the context menu, select a
formatting option.

m To format the data in a column, select a cell in the column, then from the
context menu that appears, select a formatting option.

m To format the values in a group, select a cell in the grouped column, then from
the context menu, select a formatting option. When you select a column to
modify, the changes you specify are applied to the data values in each data
group. If you choose the group at the highest level, the data values in this
group are formatted based on the options you select. You must choose each
group to specify formatting options for that group level. You can also specify
formatting properties for the group label for each group.

Changing font properties and alignment

Using Interactive Viewer, you can change the font properties and alignment of
values in cross-tab elements, including dimension and measure labels and data
values. The properties you can modify include the background color, font color,
size, and type. A value of Auto indicates that the default value applies. You can
also specify whether to display the font in bold, italic, or underlined style.

How to change font properties
1 Select a cross-tab element. From the main menu, choose Format>Font.
Font displays the current font property values, as shown in Figure 9-2.
2 On Font, specify the new properties as follows:

m  Use the drop-down lists to modify the font properties for the selected
element.

m  Choose an option to apply bold, italic, or underlined style.
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Choose OK.

Font x
Font: Size:
Auto v Auto ¥
Color: Background Color:
Auto > Auto >
B I u
Preview
’

Figure 9-2 Specifying font properties
How to change text alignment

Select a cross-tab element. From the context menu, choose Alignment>Left,
Alignment>Center, or Alignment>-Right.

Reverting to default formats

To revert a cross-tab element back to its default font formats, select the cross-tab
element. From the main menu, choose Format>Font. Select Auto from each
drop-down list. To reset text alignment, select the element, and choose the
appropriate alignment option.

If you applied a number format to data, you can restore the formats to those in the
original cross tab. Select the data cell. From the context menu choose
Format>Format Data. Then, select Unformatted from the drop-down list.

Displaying details about data values

To view details about cross-tab data, select a cell in the data area. From the context
menu, choose Show Detail Tooltip, as shown in Figure 9-3.

¥8 Show Detail Tooltip

Alignment 3
Format 3

.—: Analyze

|2 Export Content

Figure 9-3 Choosing Show Detail Tooltip from the context menu

Now when you select any cell in the display area of the cross tab, the tooltip for
that data value appears. A tooltip displays the column and row level details and
the measure value, as shown in Figure 9-4.
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Detail x
Row Level

year: 2004

quarter: 3

month: 7

Column Level
PRODUCTLINE: Trains

Measure
Revenue: 58,985

Function
5UM

Figure 9-4 Detail information for the selected cell

Displaying this detail tooltip information is especially useful if you are analyzing
data in a large cross tab where you cannot simultaneously view the column
heading, row heading, and data cell in your browser window.

To return to the regular view, select any cell in the display area, and choose Hide
Detail Tooltip from the context menu.

Changing the width of a column or height of a row

You can optimize the layout of a cross tab by changing the width of cross tab
columns and the height of rows. Using this option enables you to eliminate the
extra space when you print or export the cross tab to other formats, and also
creates additional space to avoid truncated column entries in the cross tab.

How to change column width

Select any cell in the cross tab. Hover the mouse pointer on the right or left border
of the highlighted cell, as shown in Figure 9-5. Using the mouse pointer, drag the
border outward or inward to increase or decrease the width of the selected cell.
The modified width applies to all rows in the column.

Classic Cars Motorcycles
Reveme Hi i Reveme Reverme
Year/QTR/Month $109.562 $39.987 $31,159 $26,310 $6,387
Hy
_ $108.232 = $45,604 $34.000 $24,894 4,763
$99,512 — $15,559 $9.079
1 Total $317.307 $85.682 $685,159 $66,763 $21.029
Figure 9-5 Modifying column width in a cross tab

How to change row height

Select any cell in the cross tab. Hover the mouse pointer on the top or bottom
border of the highlighted element, as shown in Figure 9-6. Using the mouse
pointer, drag the border up or down to increase or decrease the height of the
selected element. The modified height applies to the entire row.
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Classic Cars Motorcycles Planes
Reveme R

Year/QTR/Month $109.562 $39.987 531,159 b26.310 $5,387

bioe.z3z $45,694 134,000 124,694 $4,763
§89.812 = $15,559 $9.879
$317.307 $55.682 $65.159 $66,763  $21.029
$89.998 $32.229 $33.882 $10.608
Figure 9-6 Modifying row height in a cross tab

1 Total

Analyzing cross-tab data

You can use BIRT Data Analyzer to manipulate a cross tab to analyze its data.
Using BIRT Data Analyzer, you can answer questions such as:

m  What are the sales for product A over time?
m  How do total sales break down by product?
m  How many units of product B shipped to all locations in April?

You can add, remove, reorganize, and customize the data and its appearance in
the cross tab to examine relationships and trends. Using BIRT Data Analyzer, you
can perform the following tasks:

m Filter, group, and sort data.
m Format a cross tab.
m Perform calculations.

To launch BIRT Data Analyzer, select any cell in the cross tab, then from the
menu, choose Data Analyzer.

For more information about BIRT Data Analyzer, see Using BIRT Data Analyzer.

Exporting cross-tab content

You can export cross-tab content to other formats, such as Excel, PDFE, PostScript,
PowerPoint, and Word, just as you can export content from a BIRT report. When
you export a cross tab to Microsoft Excel, Excel displays the cross tab as a pivot
table, in which you can further analyze existing data.
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Modifying charts in a cross tab

You can modify charts present in a cross tab in Interactive Viewer, similar to how
you would for a regular chart.

You can also sometimes switch views between a cross tab and chart, if this option
was enabled at the time of creating the cross tab in BIRT Designer Professional.

Printing a cross tab
You can print a cross tab in the same way as you print a BIRT report.

Saving a cross tab

B Sometimes you need to save a modified cross tab, to use later, or make it available
for other users to view and modify. In Interactive Viewer, you can save a modified
cross tab just as you save a BIRT report. You can save a cross tab to the following
file types:

m  Actuate BIRT report document (.rptdocument) file
m  Actuate BIRT design file (.rptdesign) file
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Modifying summary
tables

This chapter contains the following topics:

About summary tables

Editing and formatting summary-table data
Organizing data in a summary table

Creating a computed column in a summary table
Filtering data in a summary table

Modifying a chart in a summary table

Saving a modified summary table
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About summary tables

A summary table presents aggregate or summary information in a report,
providing users with a concise view of the data at a glance. The aggregate
information displayed in a summary table is typically displayed in the table
header or footer, or the group or section header or footer in a detail BIRT report. A
summary table is particularly useful when a user needs to work with large
volumes of data, because the calculations are made at the data source level,
making only the computed data visible to the user. Report developers can create a
summary table using Actuate BIRT Studio or BIRT Dashboards by simply
selecting the relevant data fields in the correct order, and inserting them into the
report design. A summary-table report can provide users with information such
as sales by territory, or sales by employee, or sales by employee, by territory.

Although hiding details for a group in a detail table can achieve the same
presentation of aggregate information as a summary table, improved
performance and reduced server load are a few unique benefits of using a
summary table over hiding the details in a detail table.

You can use Interactive Viewer to edit and format data in a summary table,
organize data columns, create filters for column data, and save a modified
summary table. In addition, you can use both viewers to export a summary table,
export data in a summary table to supported flat file formats, display a table of
contents, and print a summary table.

About columns in a summary table

The columns in a summary table are classified into dimension columns, attribute
columns, and measure columns. The columns used to group data in other
columns are dimension columns, and the columns whose aggregated values are
evaluated are measure columns.

A dimension column groups data in other columns. Dimension columns are
typically not aggregated. Some examples of dimension columns include order
date, country, state, product line, and so on. A measure column is typically
ungrouped, and contains aggregated data. Some examples of measure columns
include number of orders, quantity ordered, profit, revenue, and so on.
Sometimes a summary table can contain additional columns called attribute
columns. Attribute columns are typically associated with a dimension column.
For example, Product Code can be an attribute of the Product Line dimension.

Dimension columns are always displayed to the left in a report design. In the
example, as shown in Figure 10-1, Order Date is a higher level or outer dimension
group, and Country is another dimension group that contains the associated
attribute Customer City. Dimension columns and their associated attribute
columns are typically displayed side-by-side in a summary table. The example
also displays a third dimension column, Order Status.
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A grouped dimension column displays subtotals for the data in each group. A
grouped dimension column does not display duplicate data values allowing for
accurately calculated aggregate data.

Dimension column

Dimension column
Dimension column

ORDERDATE COUNTRY STATUS COUNT VALUE

(ORDERNUMBER) Measure column
Austria Attribute column
Salzburg
Shipped 1
Sub Total ( Salzburg ) 1
Sub Total (Austria) 1|
Austria
Graz
Resolved 1
Shipped 1
Sub Total (Graz) i
Sub Total (Austria) 1|
—— Subtotal
Austria
Salzburg
Shipped 1
Sub Total ( Salzburg ) 1
Sub Total (Austria) i
Austria
Salzburg
Shipped 1
Sub Total (Salzburg ) 1
Sub Total (Austria ) 1
—— Subtotal
Austria
Graz
Shipped 1
Sub Total (Graz ) 1|
Sub Total (Austria) 1
Austria
Salzburg
Shipped 1
Sub Total ( Salzburg ) 1
Sub Total (Austria) 1|
Grand Total 1 Grand total

Figure 10-1 A summary table

The following section describes how you can modify data in a summary table.

About modification options

In Interactive Viewer, you can modify summary tables by editing and formatting
data, creating filters to display specific data, inserting calculations in a summary
table, and so on. Table 10-1 compares the actions you can perform on dimension

columns, attribute columns, and measure columns.
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Table 10-1 Modification options for data in a summary table

Dimension Attribute Measure
Action column column column
Create a new computed column. v
Create filters. v v v
Delete the column. v v v
Edit and format the column header. v v v
Filter data using the Top/Bottom N 4
condition.
Format data. v v v
Modify aggregate data. v
Reorder columns. v
Show or hide columns. v v v
Sort column data in ascending or v v
descending order.
Specify alignment properties. v v v
Specify font properties. v v v

Editing and formatting summary-table data

In Interactive Viewer, you can modify the appearance of the data in a summary
table to edit and format column headers, column data, and font and alignment
properties. You can also modify font properties and format aggregate data values.

How to format the column header

Select the column to highlight it, then select Header>Change Text,
Header> Alignment—>Left, Center, or Right, or Header>Font from the context
menu, shown in Figure 10-2.

[ teader [ eN—_——

Column

Alignment 3

Filter A Font

Alignment

3
3
Sort 3
L3
3

Format

Figure 10-2 Modifying a column header
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How to format column data

Select the column to highlight it, then choose Format>Font or Format>Format
Data from the context menu.

How to format aggregate data values

Select the Subtotal or Grand Total value, and choose Format>Font or
Format>Format Data from the context menu.

Organizing data in a summary table

You can organize data in a report by sorting column data, showing or hiding
columns and report elements, and moving or deleting a column.

Sorting data

You can sort data in dimension columns, or attribute columns in a summary table,
in descending order. A grouped column automatically sorts data in ascending
order. To modify the sort order, select the column, and choose Sort>Sort
Descending from the context menu.

Showing and hiding columns in a report

You can hide or show dimension columns, attribute columns, and measure
columns in a summary table.

Select a column to highlight it, then select Column>Show Column from the
context menu to display the column in the report.

Select a column to highlight it, then select Column>Hide Column from the
context menu to hide the column that you do not want to display in the report.

Moving and deleting a column

In Interactive Viewer, you can move an attribute or measure column, but cannot
move a dimension column in a summary table. You can delete a dimension
column, an attribute column, or a measure column. You can move attribute
columns among other attribute columns in a summary table. When you move a
measure column in a summary table, you can move it only within the other
measure columns.

To move a measure column, select the column and choose Column~>Move to Left
from the context menu.

To delete a column, select the column and choose Column->Delete Column from
the context menu.
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Creating a computed column in a summary table

You can create a computed column for data in measure columns, as you would do
for a regular report column. You can also edit an existing computed column in a
summary table. You cannot create computed columns for data in dimension
columns.

Filtering data in a summary table

id
u

You can filter data in dimension, attribute, and measure columns in the same way
in which you filter data in a report table. You can create multiple filter conditions,
and modify existing filter conditions. You cannot create filters for data in a
dimension column containing date-and-time data.

You can also filter a measure column using the Top/Bottom N condition, as
shown in Figure 10-3. Select the measure column, and choose Filter>Filter or
Filter>Top/Bottom N from the context menu. You cannot use the Top/Bottom N
condition to filter data values in a dimension or attribute column.

Header 3
Column 3

BN -

Alignment v | < Top/Bottom N
Format 3

Figure 10-3 Filtering data in a summary table

Modifying a chart in a summary table

You can modify a chart in a summary table, in the same way you perform this
task in a detail table. You can modify the subtype, formatting options, and export
the chart to other formats.

Saving a modified summary table

You can save a modified summary table similar to how you perform this task for
a BIRT report.
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Functions and operators

This chapter contains the following topics:
m Functions

m  Operators
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% OF( )

Functions

This section is a complete reference to all of the functions in Interactive Viewer.
This reference organizes the functions into two sections based on those used in
expressions when creating a computed column and functions that are used to
perform aggregate calculations.

Functions used in computed column expressions

The following list of functions appear when you create expressions to compute
column data. Each function entry includes a general description of the function,
its syntax, the arguments to the function, the result the function returns, and an
example that shows typical usage. Use this reference to find information about a
function that you want to use when you insert a computed column to display
calculated data in your report design.

% OF( )

Category
Column
% Base

Returns

Example

Calculates the percentage value of a selected column compared to a selected base
group value.

Financial
Select a column from the list.
Select a base group from the list.

For the selected column, Interactive Viewer calculates the percentage of the base
group total and displays the percentage value.

For example, compare a single revenue value to the total value of all revenue,
using the following calculation:

(<Column A>/<Column B>) * 100%

% OF DIFFERENCE()

Category
Column

Column

Calculates the percentage of the difference between values.
Financial
Select the first column from the list.

Select the second column from the list.
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Returns

ABS( )

Interactive Viewer calculates the percentage of the difference between the second
measure and the first measure, as follows:

((ColumnB - ColumnA)/ColumnB) * 100%

Interactive Viewer displays the percentage of the difference in the column values.

ABS()

Syntax

Argument

Returns

Example

Returns the absolute value of a number without regard to its sign. For example,
6 is the absolute value of 6 and -6.

ABS(num)

num
The number, or numeric expression specifying the number, for which you need to
find the absolute value.

A number representing the absolute value of num.

The following example returns the absolute value for each number in the
TemperatureCelsius data field:

ABS ( [TemperatureCelsius])

ADD_DAY()

Syntax

Arguments

Returns

Example

Adds a specified number of days to a date value.
ADD_DAY (date, daysToAdd)

date
The date or date expression representing the start date.

daysToAdd
The number of days to add to the start date. If you specify a negative number, the
result is as if the number is subtracted from the start date.

The date value that results from adding the specified number of days to the start
date.

The following example adds 15 days to each date value in the InvoiceDate data
field:

ADD DAY ([InvoiceDate], 15)
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ADD_HOUR( )

ADD_HOUR()

Syntax

Arguments

Returns

Example

Adds a specified number of hours to a date value.
ADD_HOUR(date, hoursToAdd)

date
The date or date expression representing the start date. If a start date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

hoursToAdd
The number of hours to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date-and-time value that results from adding the specified number of hours
to the start date.

The following example adds eight hours to each date value in the ShipDate data
field:

ADD_HOUR ( [ShipDate], 8)

ADD_MINUTE()

Syntax

Arguments

Returns

Example

Adds a specified number of minutes to a date value.
ADD_MINUTE(date, minutesToAdd)

date
The date or date expression representing the start date. If a start date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

minutesToAdd
The number of minutes to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date-and-time value that results from adding the specified number of
minutes to the start date.

The following example subtracts 30 minutes from each date in the StartTime data
field:

ADD MINUTE ( [StartTime], -30)

ADD_MONTH()

Adds a specified number of months to a date value.
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Syntax

Arguments

Returns

Example

ADD_QUARTER( )

ADD_MONTH(date, monthsToAdd)

date
The date or date expression representing the start date.

monthsToAdd
The number of months to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date value that results from adding the specified number of months to the
start date. This function always returns a valid date. If necessary, the day part

of the resulting date is adjusted downward to the last day of the resulting month
in the resulting year. For example, if you add one month to 1/31/08,
ADD_MONTH( ) returns 2/29/08, not 2/31/08 or 2/28/08, because 2008 is a
leap year.

The following example adds two months to each date value in the InitialRelease
data field:

ADD MONTH( [InitialRelease], 2)

ADD_QUARTER()

Syntax

Arguments

Returns

Example

Adds a specified number of quarters to a date value.
ADD_QUARTER(date, quartersToAdd)

date

The date or date expression representing the start date.

quartersToAdd
The number of quarters to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date value that results from adding the specified number of quarters to the
start date. A quarter is equal to three months. For example, if you add two
quarters to 9/22/08, ADD_QUARTER( ) returns 3/22/09.

The following example adds two quarters to each date value in the
ForecastClosing data field:

ADD QUARTER ( [ForecastClosing], 2)

ADD_SECOND()

Syntax

Adds a specified number of seconds to a date value.
ADD_SECOND(date, secondsToAdd)
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ADD_WEEK( )

Arguments

Returns

Example

date
The date or date expression representing the start date. If a start date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

secondsToAdd
The number of seconds to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date-and-time value that results from adding the specified number of
seconds to the start date.

The following example adds 30 seconds to each date value in the StartTime data
field:

ADD SECOND ( [StartTime], 30)

ADD_WEEK()

Syntax

Arguments

Returns

Example

Adds a specified number of weeks to a date value.
ADD_WEEK(date, weeksToAdd)

date
The date or date expression representing the start date.

weeksToAdd
The number of weeks to add to the start date. If you specify a negative number,
the result is as if the number is subtracted from the start date.

The date value that results from adding the number of weeks to the start date.

The following example adds two weeks to each date value in the OrderDate data
field:

ADD_WEEK ( [OrderDate], 2)

ADD_YEAR()

Syntax

Arguments

Returns

Adds a specified number of years to a date value.
ADD_YEAR(date, yearsToAdd)

date
The date or date expression representing the start date.

yearsToAdd
The number of years to add to the start date. If you specify a negative number, the
result is as if the number is subtracted from the start date.

The date value that results from adding the number of years to the start date.
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Example

BETWEEN( )

The following example adds five years to each date value in the HireDate data
field:

ADD YEAR( [HireDate], 5)

BETWEEN()

Syntax

Arguments

Returns

Examples

Tests if a value is between two specified values.

BETWEEN(value, upperBound, lowerBound)

value

The value to test. The value can be a string, numeric, or date value.

upperBound
The first value in the range of values to which to compare. String and date values
must be enclosed in double quotation marks (" ").

lowerBound
The second value in the range of values to which to compare. String and date
values must be enclosed in double quotation marks (" ").

True if value is between upperBound and lowerBound, or equal to upperBound
or lowerBound; returns false otherwise.

The following example tests each value in the SalesTotal data field to see if the
value is between 10000 and 20000:

BETWEEN ( [SalesTotal], 10000, 20000)

The following example tests each value in the CustomerName data field to see if
the value is between A and M:

BETWEEN ( [CustomerName] , "A", "M")

The following example tests each value in the ReceiptDate data field to see if the
value is between 10/01/07 and 12/31/07:

BETWEEN ( [ReceiptDate], "10/01/07 12:00 AM", "12/31/07 12:00 AM")

The following example uses BETWEEN( ) in conjunction with the IF( ) and
ADD_DAY( ) functions to calculate a shipment date. If an orderDate value is in
December 2007 (between 12/1/07 and 12/31/07), add 5 days to the orderDate
value. If an orderDate value is in a month other than December, add 3 days to the
orderDate value.

IF ( (BETWEEN ( [orderDate], "12/1/07 12:00 AM", "12/31/07 12:00
AM")), (ADD DAY ([orderDate], 5)), (ADD DAY ([orderDate], 3)))
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CEILING()

Syntax

Arguments

Returns

Examples

Rounds a number to the nearest specified multiple.
CEILING(num, significance)

num
The numeric value to round to.

significance
The multiple to round num to.

The number that results from the rounding up. If num is an exact multiple of
significance, no rounding occurs.

CEILING( ) is commonly used to round up prices. For example, to avoid dealing
with pennies, you can round up prices in a Price data field to the nearest nickel
using the following expression:

CEILING ([Price], 0.05)

If the Price value is 20.52, CEILING( ) returns 20.55.

The following example rounds up prices to the nearest dime:
CEILING ([Pricel, 0.1)

If the Price value is 20.52, CEILING( ) returns 20.60. If the Price value is 20.40,
CEILING( ) returns 20.40. No rounding occurs because 20.40 is already a multiple
of 0.1.

The following example rounds prices up to the nearest dollar:
CEILING ([Pricel, 1)
If the Price value is 20.30, CEILING( ) returns 21.0.

DAY()

Syntax

Argument

Returns

Example

Returns a number from 1 to 31 representing the day of the month.
DAY(date)

date
The date or date expression from which you want to extract the day.

The number of the day of the month for the specified date value.

The following example gets the number of the day for each date value in the
ShipDate data field:

DAY ( [ShipDate])
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DIFF_DAY()

Syntax

Arguments

Returns

Example

Calculates the number of days between two date values.
DIFF_DAY(datel, date2)

datel
The first date or date expression to use in the calculation.

date2
The second date or date expression to use in the calculation.

The number of days between datel and date2.

The following example calculates the number of days between each value in the
invoiceDate data field and each value in the paymentDate data field. The results
show how long it takes to pay invoices.

DIFF DAY ([invoiceDate], [paymentDate])

The following example calculates the number of days from an order date to
Christmas:

DIFF DAY ([orderDate], "12/25/08")

The following example calculates the number of days from the current date to
Christmas. TODAY() is a function that returns the current date.

DIFF_DAY (TODAY (), "12/25/08")

DIFF_HOUR()

Syntax

Arguments

Returns

Example

Calculates the number of hours between two date values.
DIFF_HOUR(datel, date?2)

datel
The first date or date expression to use in the calculation. If the date does not have
a time value, the function assumes the time is midnight, 12:00 AM.

date2
The second date or date expression to use in the calculation. If the date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

The number of hours between datel and date2.

The following example calculates the number of hours between each value in the
startTime data field and each value in the finishTime data field:

DIFF HOUR( [startTime], [finishTime])
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The following example calculates the number of hours from the current date to
Christmas. NOW() is a function that returns the current date and time. If you
supply a literal date as an argument, you must include the time value, as shown
in the following example.

DIFF_HOUR(NOW(), "12/25/08 12:00 AM")

DIFF_MINUTE()

Calculates the number of minutes between two date values.
Syntax DIFF_MINUTE(datel, date2)

Arguments datel
The first date or date expression to use in the calculation. If the date does not have
a time value, the function assumes the time is midnight, 12:00 AM.

date2
The second date or date expression to use in the calculation. If the date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

Returns The number of minutes between datel and date2.

Example The following example calculates the number of minutes between each value in
the startTime data field and each value in the finishTime data field:

DIFF MINUTE ( [startTime], [finishTime])

The following example calculates the number of minutes from the current date to
Christmas. NOW() is a function that returns the current date and time. If you
supply a literal date as an argument, you must include the time value, as shown
in the following example:

DIFF_MINUTE (NOW(), "12/25/08 12:00 AM")

DIFF_ MONTH()

Calculates the number of months between two date values.
Syntax DIFF_MONTH(datel,date2)

Arguments datel
The first date or date expression to use in the calculation.

date2
The second date or date expression to use in the calculation.

Returns The number of months between datel and date2. The function calculates the
difference by subtracting the month number of datel from the month number of
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Example

DIFF_QUARTER( )

date2. For example, if datel is 8/1/08 and date2 is 8/31/08, DIFF_MONTH()
returns 0. If datel is 8/25/08 and date2 is 9/5/08, DIFF_MONTH( ) returns 1.

The following example calculates the number of months between each value in
the askByDate data field and each value in the ShipByDate data field:

DIFF MONTH ( [askByDatel, [shipByDatel)

The following example calculates the number of months from each value in the
hireDate data field to the end of the year:

DIFF_MONTH ( [hireDate], "1/1/09")

DIFF_QUARTER()

Syntax

Arguments

Returns

Example

Calculates the number of quarters between two date values.
DIFF_QUARTER(datel, date2)

datel
The first date or date expression to use in the calculation.

date2
The second date or date expression to use in the calculation.

The number of quarters between datel and date2. DIFF_QUARTER calculates the
difference by subtracting the quarter number of the month in datel from the
quarter number of the month in date2. The first quarter consists of the first three
months in a calendar year, the second quarter consists of the next three months,
and so on. For example, if datel is 8/1/08 and date2 is 10/31/08,
DIFF_QUARTER( ) returns 1. If datel is 7/25/08 and date2 is 09/5/08,
DIFF_QUARTER( ) returns 0.

The following example calculates the number of quarters between each value in
the PlanClosing data field and each value in the ActualClosing data field:

DIFF QUARTER ([PlanClosing], [ActualClosing])

The following example calculates the number of quarters from each value in the
orderDate data field to the end of the year:

DIFF_ QUARTER( [orderDate], "1/1/09")

DIFF_SECOND()

Syntax

Calculates the number of seconds between two date values.
DIFF_SECOND(datel, date2)
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Arguments

Returns

Example

datel
The first date or date expression to use in the calculation. If the date does not have
a time value, the function assumes the time is midnight, 12:00 AM.

date2
The second date or date expression to use in the calculation. If the date does not
have a time value, the function assumes the time is midnight, 12:00 AM.

The number of seconds between datel and date2.

The following example calculates the number of seconds between each value in
the startTime data field and each value in the finishTime data field:

DIFF SECOND( [startTime], [finishTime])

The following example calculates the number of seconds from the current date to
Christmas. NOW() is a function that returns the current date and time. If you
supply a literal date as an argument, you must include the time value, as shown
in the following example:

DIFF_SECOND (NOW(), "12/24/08 12:00 AM")

DIFF_ WEEK()

Syntax

Arguments

Returns

Example

Calculates the number of weeks between two date values.
DIFF_WEEK(datel, date?2)

datel
The first date or date expression to use in the calculation.

date2
The second date or date expression to use in the calculation.

The number of weeks between datel and date2. The function calculates the
difference by subtracting the week number of datel from the week number of
date2. For example, if datel is 1/3/08 (week 1 of the year), and date2 is 1/7/08
(week 2 of the year), DIFF_WEEK( ) returns 1.

The following example calculates the number of weeks between each value in the
askByDate data field and each value in the shipByDate data field:

DIFF WEEK( [askByDate], [shipByDatel])

The following example calculates the number of weeks from each value in the
orderDate data field to the end of the year:

DIFF_WEEK( [orderDate], "1/1/09")

170 Working with Actuate BIRT Viewers



DIFF_YEAR( )

DIFF_YEAR()

Syntax

Arguments

Returns

Example

Calculates the number of years between two date values.
DIFF_YEAR(datel, date2)

datel

The first date or date expression to use in the calculation.
date2

The second date or date expression to use in the calculation.

The number of years between datel and date2. The function calculates the

difference by subtracting the year number of datel from the year number of
date2. For example, if datel is 1/1/08 and date2 is 12/31/08, DIFF_YEAR()
returns 0. If datel is 11/25/08 and date2 is 1/5/09, DIFF_YEAR( ) returns 1.

The following example calculates the number of years between each value in the
HireDate data field and each value in the TerminationDate data field:

DIFF YEAR([HireDate], [TerminationDate])

The following example calculates the number of years from each value in the
HireDate data field to the current date. TODAY( ) is a function that returns the
current date.

DIFF YEAR([HireDate], TODAY())

DIFFERENCE( )

Category

Column

Column

Returns

Calculates the difference between values in two columns, ColumnB — ColumnA.
Math

In the first field, select a column from the list, or type a value to subtract from the
second field.

In the second field, select a column from the list.

Interactive Viewer subtracts the first value from the second value and displays
the difference in the cross tab.

FIND()

Syntax

Finds the location of a substring in a string.
FIND(strToFind, str)

FIND(strToFind, str, startPosition)
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Arguments

Returns

Example

strToFind
The substring to search for. The search is case-sensitive.

str
The string in which to search.

startPosition
The position in str where the search starts.

The numerical position of the substring in the string. The first character of a string
starts at 1. If the substring is not found, FIND( ) returns 0.

The following example searches for the substring, Ford, in each ProductName
value. If the product name is 1969 Ford Falcon, FIND( ) returns 6.

FIND ("Ford", [ProductName])

The following example searches for the first hyphen (-) in each product code. If
the product code is ModelA-1234-567, FIND( ) returns 7.

FIND("-", [ProductCodel])

The following example uses FIND( ) in conjunction with the LEFT( ) function to
display the characters preceding the hyphen in a product code. The LEFT()
function extracts a substring of a specified length, starting from the first character.
In this example, the length of the substring to display is equal to the numerical
position of the hyphen character.

LEFT ( [ProductCode], FIND("-", [ProductCodel))
If the product code is ModelA-1234, LEFT( ) returns the following string:
ModelA

IF()

Syntax

Arguments

Returns

Returns one value if a specified condition evaluates to True, or another value if
the condition evaluates to False.

IF(condition, dolfTrue, dolfFalse)

condition
The condition to test.

dolfTrue
The value to return if condition evaluates to True.

dolfFalse
The value to return if condition evaluates to False.

Returns the dolfTrue value if condition is True or the dolIfFalse value if condition
is False.
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Example

IN(C)

The following example calculates and displays different discount amounts based
on the value in the Total data field. If the Total value is greater than 5000, the
discount is 15%. Otherwise, the discount is 10%.

IF([Totall >5000, [Totall*15%, [Total]*10%)

The following example uses IF( ) in conjunction with the BETWEEN( ) and
ADD_DAY( ) functions to calculate a shipment date. If an orderDate value is in
December 2007 (between 12/1/07 and 12/31/07), add 5 days to the orderDate
value. If a orderDate value is in a month other than December, add 3 days to the
orderDate value.

IF ( (BETWEEN ( [orderDate], "12/1/07 12:00 AM", "12/31/07 12:00
AM")), (ADD DAY ([orderDate], 5)), (ADD DAY ([orderDate], 3)))

The following example checks each value in the Office data field. If the value is
Boston, San Francisco, or NYC, the computed column displays U.S. If the value is
something other than Boston, San Francisco, or NYC, the computed column
displays Europe and Asia Pacific.

IF([Office] ="Boston" OR [Office]="San Francisco" OR
[Office] ="NYC", "U.S.", "Europe and Asia Pacific")

IN()

Syntax

Arguments

Returns

Example

Tests if a value is equal to a value in a list.
IN(value, checkl,..., checkN)

value
The value to test. The value can be a string, numeric, or date value.

checkl, ..., checkN
The value or values to compare to.

True if value is equal to one of the check values; returns false otherwise.

The following example tests if New Haven, Baltimore, or Cooperstown are values
in the city data field. If any one of the cities is in the data field, IN( ) returns true.

IN([city], "New Haven", "Baltimore", "Cooperstown")

The following example tests if 9/15/08 or 9/30/08 are values in the payDate data
field. If you supply a literal date as an argument, you must include the time
value, as shown in the following example:

IN( [payDate], "9/15/08 12:00 AM", "9/30/08 12:00 AM")

The following example uses IN( ) in conjunction with the IF( ) function to test if
Ships or Trains are values in the ProductLine data field. If Ships or Trains is a
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value in the field, the computed column displays Discontinued Item; otherwise,
the product line value is displayed as it appears in the field.

IF(IN([ProductLine], "Ships", "Trains"), "Discontinued Item",
[ProductLine])

ISNULL()

Tests if a value in a specified data field is a null value. A null value means no
value exists.

Syntax ISNULL(value)

Argument value
The data field in which to check for null values.

Returns  True if a value in the specified data field is a null value; returns false otherwise.

Example The following example uses ISNULL( ) in conjunction with the IF( ) function to
test for null values in the BirthDate data field. If there is a null value, the
computed column displays No date specified; otherwise the BirthDate value is
displayed.

IF (ISNULL( [BirthDate]l), "No date specified", [BirthDate])

LEFT()

Extracts a substring from a string, starting from the leftmost, or first, character.
Syntax LEFT(str)
LEFT(str, n)

Arguments  str
The string from which to extract a substring.

n
The number of characters to extract, starting from the first character.

Returns A substring of a specific length.

m If you omit n, the number of characters to extract, the function returns the first
character only.

m Ifnis zero, the function returns an empty string.

m If nis greater than the length of the string, the function returns the entire
string.
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Example

LEN( )

The following example displays the first letter of each name in the
CustomerName data field:

LEFT ( [CustomerName] )

The following example uses the LEFT( ) and FIND( ) functions to display the
characters preceding the hyphen in a product code:

LEFT ( [ProductCode] , FIND("-", [ProductCodel]))
If the product code is ModelA-1234, LEFT( ) returns the following string:
ModelA

LEN()

Syntax

Argument

Returns

Example

Counts the number of characters in a string.
LEN(str)

str
The string expression to evaluate.

The number of characters in the specified string.

The following example returns the length of each value in the ProductCode data
field:

LEN ( [ProductCode] )

The following example uses LEN( ) in conjunction with the RIGHT( ) and FIND( )
functions to display the characters that appear after the hyphen in a product code.
RIGHT( ) extracts a substring of a specified length, starting from the last
character. In this example, the length of the entire string returned by LEN()
minus the length up to the hyphen is the number of characters to display.
RIGHT ( [PRODUCTNAME], LEN([PRODUCTNAME] ) - (FIND

("-" , [PRODUCTNAME] )))

If the product code is ModelA-Ford, RIGHT( ) returns the following string:

A-Ford

LIKE()

Syntax

Argument

Tests if a string matches a pattern.
LIKE(str, pattern)

str
The string to evaluate.
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Returns

Example

pattern

The string pattern to match. You must enclose the pattern in double quotation
marks (" "). Use the correct case when typing the characters to match; the match is
case-sensitive. You can use the following special characters in a pattern:

m A percent character (%) matches zero or more characters. For example, %ace%
matches any string value containing the substring ace, such as Facebook, and
MySpace. It does not match Ace Corporation because this string contains a
capital A, and not the lowercase a.

m  An underscore character (_) matches exactly one character. For example, t_n
matches tan, ten, tin, and ton. It does not match teen or tn.

To match a literal percent (%), underscore (_), precede those characters with a two
backslash (\\) characters. For example, to see if a string contains M_10, specify
the following pattern:

"$M\\_10%"
True if the string matches the pattern; returns false otherwise.

The following example returns true for values in the customerName field starting
with D:

LIKE ( [customerName], "D%")

The following example returns true for productCode values containing the
substring Ford:

LIKE ( [productCode], "%Ford%")

The following example uses two LIKE( ) expressions to look for the substrings
“Ford” or “Chevy” in each ProductName value. If a product name contains either
substring, the computed column displays U.S. Model; otherwise, it displays
Imported Model.

IF(((LIKE([ProductName], "%$Ford%") = TRUE) OR (LIKE ([ProductName],
"$Chevy%") = TRUE)), "U.S. model", "Imported Model")

LOWER()

Syntax

Argument

Returns

Converts all letters in a string to lowercase.
LOWER(str)

str
The string to convert to lowercase.

The specified string in all lowercase letters.
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Example

MOD( )

The following example displays all the string values in the productLine data field
in lowercase:

LOWER ( [productLine])

MOD( )

Syntax

Arguments

Returns

Example

Returns the modulo value for a number and a divisor.
MOD(number, divisor)

number
The number from which to derive the mod value.

divisor
The divisor for the mod function.
Returns the remainder value of number divided by divisor.

The following example computes the remainder of PriceEstimate data field
divided by 12, returning an integer. For example, if the PriceEstimate value is
27365, MOD( ) returns 5.

MOD ( [PriceEstimate], 12)

MONTH()

Syntax

Arguments

Returns

Returns the month for a specified date value.
MONTH(date)
MONTH(date, option)

date
The date or date expression whose month to retrieve.

option
A number representing the month format to return. Use one of the following
values:

m 1 to get the month as a number from 1 to 12.
m 2 to get the full month name, for example, January. The result is locale-specific.

m 3 to get the abbreviated month name, for example, Jan. The result is
locale-specific.

If you omit option, MONTHY( ) returns the month as a number.

The month for a specified date value.
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Example

The following example returns the month (1 - 12) for each value in the ShipDate
data field:

MONTH ( [ShipDate])
The following example returns the full month name for each ShipDate value:

MONTH ( [ShipDatel, 2)

NOTNULL()

Syntax

Argument

Returns

Example

Tests if a value in a specified data field is a non-null value.
NOTNULL(value)

value
The data field in which to check for non-null values.

True if a value in the specified data field is not a null value; returns false
otherwise.

The following example uses NOTNULL( ) in conjunction with the IF( ) function
to test for non-null values in the BirthDate data field. If there is a non-null value,
the BirthDate value is displayed; otherwise the string “No date specified” is
displayed.

IF (NOTNULL ( [BirthDate]), [BirthDate], "No date specified")

NOW( )

Syntax

Returns

Example

Returns the current date and time.
NOW()

The current date and time. For example:
Sep 23, 2008 11:56 AM

The following example uses the DIFF_MINUTE( ) and NOW( ) functions to
calculate the number of minutes from the current date and time to Christmas:

DIFF_MINUTE (NOW(), "12/25/08 12:00 AM")

PRODUCT( )

Category

Returns the product of multiplication, ColumnA * ColumnB.
Math
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Column
Column

Returns

QUARTER( )

Select the first measure name from the list.
Select the second measure name from the list.

Interactive Viewer multiplies the value in the first column by the value in the
second and displays the product.

QUARTER()

Syntax

Arguments

Returns

Example

Returns the quarter number for a specified date value.
QUARTER(date)

date
The date or date expression whose quarter number to get.

A number from 1 to 4 representing the quarter for a specified date value.
Quarter 1 starts in January.

The following example displays the quarter number for each value in the
CloseDate data field:

QUARTER ( [CloseDate])

The following example displays a string—Q1, Q2, Q3, or Q4—for each value in
the CloseDate data field:

"Q" & QUARTER([CloseDatel])

RANK()

Syntax

Arguments

Returns the rank of a value in a set of values. The rank of a value ranges from 1 to
the number of values in the set. If two values are identical, they have the same
rank.

RANK((expr)
RANK(expr, ascending, groupLevel)

expr
The expression specifying the values to evaluate. The field can be of string,
numeric, or date type.

ascending
Use one of the following values:

m 0 to rank values in descending order. In descending order, the highest value is
ranked 1, and the lowest value is equal to the number of values in the set.

m 1 to rank values in ascending order. In ascending order, the lowest value is
ranked 1, and the highest value is equal to the number of values in the set.
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If you omit the ascending argument, RANK( ) assumes 0 (descending order).

groupLevel

The numeric index of the group whose values to use in the calculation. 0 indicates
the table, 1 indicates the first group, 2 indicates the second group, and so on. If
you do not supply a value for groupLevel, the function performs the calculation
over all the values in the table.

Returns A number representing the rank of a value in the specified data field in the table
or in the specified group.

Example The following example ranks each value in the Score data field. The ranking is
performed over all the values in the table.

RANK ( [Score] )

The following example ranks each value in the Score data field in ascending
order. The ranking is performed over all the values in each group at the second
level.

RANK ( [Score], 1, 2)

RATIO()

Returns the ratio, ColumnA /ColumnB.
Category Math
Column  Select the first column from the list.
Column  Select the second column from the list.

Returns Interactive Viewer divides the first column value by the second column value and
displays the ratio value.

RIGHT()

Extracts a substring from a string, starting from the rightmost, or last, character.
Syntax RIGHT(str)

RIGHT(str, n)

Arguments  str
The string from which to extract a substring.

n
The number of characters to extract, starting from the last character.
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Returns

Example

ROUND( )

A substring of a specific length.

m If you omit n, the number of characters to extract, the function returns the last
character only.

m If nis zero, the function returns an empty string.

m If nis greater than the length of the string, the function returns the entire
string.

The following example displays the last four characters of each value in the

ProductCode data field:

RIGHT ( [ProductCode], 4)

The following example uses RIGHT( ) in conjunction with the LEN( ) and FIND( )
functions to display the characters that appear after the hyphen in a product code.
This example assumes that the number of characters after the hyphen varies.
Therefore, the length of the entire string (returned by LEN( )) minus the length up
to the hyphen (returned by FIND( )) is the number of characters to display.

RIGHT ( [ProductCode], (LEN([ProductCode]) - FIND("-" ,
[ProductCode] ) ))

If the product code is ModelA-Ford, RIGHT( ) returns Ford. If the product code is
ModelB-Toyota, RIGHT( ) returns Toyota.

ROUND()

Syntax

Arguments

Returns

Example

Rounds a number to a specified number of digits.
ROUND(num)
ROUND(num, dec)

num
The number to round.

dec
The number of digits to which to round num. If you omit dec, ROUND()
assumes 0.

A number rounded to a specified number of digits.

The following example rounds the numbers in the PriceEstimate data field to
return an integer. For example, if the PriceEstimate value is 1545.50, ROUND( )
returns 1546. If the PriceEstimate value is 1545.25, ROUND( ) returns 1545.

ROUND ( [PriceEstimate])
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The following example rounds the numbers in the PriceEstimate data field to one
decimal place. For example, if the PriceEstimate value is 1545.56, ROUND( )
returns 1545.6. If the PriceEstimate value is 1545.23, ROUND( ) returns 1545.2.

ROUND ( [PriceEstimate], 1)

The following example rounds the numbers in the PriceEstimate data field to one
digit to the left of the decimal point. For example, if the PriceEstimate value is
1545.56, ROUND( ) returns 1550. If the PriceEstimate value is 1338.50, ROUND( )
returns 1340.

ROUND ( [PriceEstimate], -1)

ROUNDDOWN( )

Syntax

Arguments

Returns

Example

Rounds a number down to a specified number of digits.
ROUNDDOWN(num)

ROUNDDOWN(num, dec)

num
The number to round down.

dec
The number of digits to which to round num down. If you omit dec, ROUND( )
assumes 0.

A number rounded down to a specified number of digits.

The following example rounds down the numbers in the PriceEstimate data field
to return an integer. For example, if the PriceEstimate value is 1545.25,
ROUNDDOWN( ) returns 1545. If the PriceEstimate value is 1545.90,
ROUNDDOWN( ) returns 1545.

ROUNDDOWN ( [PriceEstimate])

The following example rounds down the numbers in the PriceEstimate data field
to one decimal place. For example, if the PriceEstimate value is 1545.56,
ROUNDDOWN( ) returns 1545.5. If the PriceEstimate value is 1545.23,
ROUNDDOWN( ) returns 1545.2.

ROUNDDOWN ( [PriceEstimate], 1)

The following example rounds the numbers in the PriceEstimate data field down
to one digit to the left of the decimal point. For example, if the PriceEstimate
value is 1545.56, ROUNDDOWN( ) returns 1540. If the PriceEstimate value is
1338.50, ROUNDDOWN( ) returns 1330.

ROUNDDOWN ( [PriceEstimate], -1)
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ROUNDUP( )

ROUNDUP()

Syntax

Arguments

Returns

Example

Rounds a number up to a specified number of digits.
ROUNDUP(num)

ROUNDUP(num, dec)

num
The number to round up.

dec
The number of digits to which to round num up. If you omit dec, ROUND( )
assumes 0.

A number rounded up to a specified number of digits.

The following example rounds up the numbers in the PriceEstimate data field to
return an integer. For example, if the PriceEstimate value is 1545.25,
ROUNDUP( ) returns 1546. If the PriceEstimate value is 1545.90, ROUNDUP( )
returns 1546.

ROUNDUP ( [PriceEstimate])

The following example rounds up the numbers in the PriceEstimate data field to
one decimal place. For example, if the PriceEstimate value is 1545.56,
ROUNDUP( ) returns 1545.6. If the PriceEstimate value is 1545.23, ROUNDUP( )
returns 1545.3.

ROUNDUP ( [PriceEstimate], 1)

The following example rounds up the numbers in the PriceEstimate data field to
one digit to the left of the decimal point. For example, if the PriceEstimate value is
1545.56, ROUNDUP( ) returns 1550. If the PriceEstimate value is 1338.50,
ROUNDUP() returns 1340.

ROUNDUP ( [PriceEstimate], -1)

RUNNINGSUM()

Syntax

Argument

Returns

Calculates a running sum for each data row. A running sum is a total
accumulated from row to row.

RUNNINGSUM(expr)

expr
The expression specifying the values to use in the calculation. The data type must
be numeric.

A cumulative total for each row.
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SEARCH( )

Example The following example calculates a running sum for each value in the
LineltemTotal. For example, if the LineltemTotal field contains 50, 75, 80, 90, and
95, RUNNINGSUM( ) returns 50, 125, 205, 295, and 390 for each row, respectively.

RUNNINGSUM ( [LineItemTotall)

SEARCH()

Finds the location of a substring in a string. The substring can contain wildcard
characters.

Syntax SEARCH(pattern, str)
SEARCH(pattern, str, startPosition)

Arguments pattern
The string pattern to search for. You must enclose the pattern in double quotation
marks (" "). You can use the following special characters in a pattern:

m  An asterisk ( * ) matches zero or more characters, including spaces. For
example, t*n matches tn, tin, and teen.

m A question mark (?) matches exactly one character. For example, t?n matches
tan, ten, tin, and ton. It does not match teen or tn.

str
The string to search.

startPosition
The position in str where the search starts.

Returns  The numerical position of the string pattern in the string. The first character of a
string starts at 1. If the substring is not found, SEARCHY( ) returns 0.

Example The following example searches for the string pattern, S*A, in each product code.
If the product name is KBS5412A, SEARCH( ) returns 3.

SEARCH ("S*A", [ProductCode])

The following example uses SEARCH( ) in conjunction with the LEFT( ) function
to display the characters preceding the first space character in a product name.
The LEFT( ) function extracts a substring of a specified length, starting from the
first character. In this example, the length of the substring to display is equal to
the numerical position of the space character.

LEFT ( [ProductName] , SEARCH(" ", [ProductName]))
If the product name is 1969 Ford Falcon, LEFT( ) returns 1969.
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SQRT( )

SQRT()

Syntax

Argument

Returns

Example

Calculates the square root of a number.
SQRT(num)

num
The number, or numeric expression specifying the number, for which you want to
find the square root. The number must be a positive number.

A number that is the square root of num.

The following example calculates the square root of each value in the LotSize data
field:

SQORT ( [LotSizel)

The following example uses SQRT( ) to calculate the actual distance travelled
uphill, given the base distance and elevatlon valyes. This example applies the
Pythagoras theorem, which states that a°+b” = c. Using this theorem, the actual
distance travelled is ¢, which means we want to calculate

c = Ja+b’
which translates to the following expression:

SORT ( ( ( [Distance] * [Distance]) + ([Elevation] * [Elevation])))

TODAY(

Syntax

Returns

Example

)

Returns the current date that includes a time value of midnight, 12:00 AM.
TODAY()

The current date in the following format:

Sep 25, 2008 12:00 AM

The following example calculates the number of days from the current date to
Christmas:

DIFF_DAY (TODAY (), "12/25/08")

The following example calculates the number of years from each value in the
HireDate data field to the current date:

DIFF YEAR([HireDate], TODAY())
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TRIM()

Syntax

Argument

Returns

Example

Removes the leading and trailing blanks from a specified string. TRIM( ) does not
remove blank characters between words.

TRIM(str)

str
The string from which to remove leading and trailing blank characters.

A string with all leading and trailing blank characters removed.

The following example uses TRIM( ) to remove all leading and trailing blank
characters from values in the FirstName and LastName data fields. The
expression uses the & operator to concatenate each trimmed FirstName value
with a space, then with each trimmed LastName value.

TRIM( [FirstName]) & " " & TRIM([LastName])

TRIMLEFT()

Syntax

Arguments

Returns

Example

Removes the leading blanks from a specified string.
TRIMLEFT((str)

str
The string from which to remove the leading blank characters.

A string with all leading blank characters removed.

The following example concatenates a literal string with each value in the
customerName data field. TRIMLEFT( ) removes all blank characters preceding
the customerName value so that there are no extra blank characters between the
literal string and the customerName value.

"Customer name: " & TRIMLEFT ([customerName] )

TRIMRIGHT()

Syntax

Argument

Returns

Removes the trailing blanks from a specified string.
TRIMRIGHT(str)

str
The string from which to remove the trailing blank characters.

A string with all trailing blank characters removed.
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Example

The following example concatenates each value in the Comment data field with a
semicolon, then with a value in the Action data field. TRIMRIGHT( ) removes all
blank characters after the Comment value so that there are no extra blank
characters between the Comment string and the semicolon.

TRIMRIGHT ( [Comment]) & "; " & [Action]

UPPER()

Syntax

Argument

Returns

Example

Converts all letters in a string to uppercase.
UPPER(str)

str
The string to convert to uppercase.

The specified string in all uppercase letters.

The following examples displays all the string values in the customerName data
field in all uppercase:

UPPER ( [customerName] )

WEEK ()

Syntax

Argument

Returns

Example

Returns a number from 1 to 52 representing the week of the year.
WEEK(date)

date
The date or date expression whose week of the year to get.

A number representing the week of the year for the specified date value.

The following example gets the week number of the year for each date value in
the ShipDate data field:

WEEK ( [ShipDate])

WEEKDAY/( )

Syntax

Arguments

Returns the day of the week for a specified date value.
WEEKDAY (date, option)

date
The date or date expression from which you get the day of the week.
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Returns

Example

option
A number representing the weekday format to return. Use one of the following
values:

m 1 to get the day as a number from 1 (Sunday) to 7 (Saturday).
m 2 to get the day as a number from 1 (Monday) to 7 (Sunday).
m 3 to get the day as a number from 0 (Monday) to 6 (Sunday).

m 4 to get the full weekday name, for example, Wednesday. The result is
locale-specific.

m 5 to get the abbreviated weekday name, for example Wed. The result is
locale-specific.

If you omit option, WEEKDAY( ) assumes option 1.
The day of the week for a specified date value.

The following example gets the full weekday name for each date value in the
DateSold data field:

WEEKDAY ( [DateSold], 4)

YEAR()

Syntax

Returns

Example

Returns the four-digit year value for a specified date value.
YEAR(date)

date
The date or date expression from which you extract the year part.

The number representing the four-digit year for the specified date value.

The following example retrieves the four-digit year for each date value in the
ShipDate data field, and adds 15 to the four-digit year. If the ShipDate value is
Sep 16, 2008, YEAR( ) returns 2023.

(YEAR ( [ShipDate]) + 15)

Functions used in aggregate calculations

Table 11-1 describes the range of functions that perform aggregate calculations. In
Interactive Viewer, you can perform aggregate calculations across the data rows
in a group, section, or across an entire report table.
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Table 11-1 Aggregate functions

Aggregate function

Description

AVERAGE

COUNT

COUNT VALUE

FIRST

LAST

MAX

MEDIAN

MIN

MODE

QUARTILE

STDDEV

Returns the average, or mean for a set of data rows. For
example, if a report column contains values 5, 2, 7, and 10,
AVERAGE returns 6.

Counts the number of data rows. If a column contains values
5,2,7,and 10, COUNT returns 4.

Counts the number of unique values in a set of data rows. If a
report column contains values 5, 2, 5, 7, and 10,
COUNTVALUE returns 4.

Returns the first value in set of data rows. If a report column
contains data rows 5, 2, and 10, FIRST returns 5.

Returns the last value in a set of data rows. If a report column
contains data row values 2, 5, 7, and 10, LAST returns 10.

Returns the largest value in a set of data rows. If a report
column contains data row values 5, 2, 7, and 10, MAX returns
10. For string values, MAX returns the last alphabetical value.
For date values, MAX returns the latest date.

Returns the median, or middle value in a set of data rows. If a
report column contains values, 5, 2, 7, and 10, MEDIAN
returns 6.

Returns the smallest value in a set of data rows. If a report
column contains data row values 5, 2, 7, and 10, MIN
returns 2. For string data, MIN returns the first alphabetical
value. For date values, MIN returns the earliest date.

Returns the mode, or the value that occurs most frequently in
a set of data rows. If a report column contains values, 5, 2, 5,
7, and 10, MODE returns 5.

Returns the quartile value in a set of data rows, given a
specified quart (0-4). A quartile can be defined as any three
values that divide a set of values into four equal parts, such
that each part represents 1/4 of the set of values. MIN,
MEDIAN, and MAX return the same value as QUARTILE
when quart is equal to 0, 2, and 4, respectively. If a set of data
rows contains 50, 75, 80, 90, and 95, and you specify a quart
of 2, QUARTILE returns 80.

Returns the standard deviation of a set of data rows.
Standard deviation is a statistic that shows how widely
values disperse from the mean value. If a set of data rows
contains 50, 75, 80, 90 and 95, STDDEYV returns 17.536.

(continues)
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Table 11-1

Aggregate functions (continued)

Aggregate function

Description

SUM

VARIANCE

WEIGHTEDAVE

Adds all the values in a set of data rows. If a report column
contains 50, 75, 80, 90, and 95, SUM returns 390.

Returns the variance of a set of data rows. Variance is a
statistical measure expressing large the size of the differences
between the values. The variance increases as the differences
between the numbers increase. If a set of data rows contains
50, 75, 80, 90, and 95, VARIANCE returns 307.5. If a set of
data rows contains 5, 2, 5, 7, and 10, VARIANCE returns 8.7.

Returns the weighted average value in a set of data rows,
given weights specified in another set of values. In a
weighted average, each number is assigned a weight or
degree of importance. These weights determine the relative
importance of each number on the average. Grades are often
computed using a weighted average. For example, for a set of
scores 50, 75, 80, 90, and 95, with respective weights, 10, 25,
15, 30, and 20, WEIGHTEDAVE returns 81.75.

Operators

This section is a complete reference to all the operators you can use when you
create expressions. This reference organizes the operators into the following

categories:

m  Operators in computed column expressions

m Operators in conditional formatting and filter condition expressions

Operators in computed column expressions

Table 11-2 lists the operators you can use when you write expressions for a

computed column.

Table 11-2 Operators in computed column expressions
Operator Use to Example
+ Add two or more numeric values [OrderAmount] + [SalesTax]
together.
- Subtract one numeric value from another. [OrderAmount] - [Discount]
* Multiply numeric values. [Price] * [Quantity]
/ Divide numeric values. [Profit] /12
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Table 11-2 Operators in computed column expressions

Operator Use to Example

N Raise a numeric value to a power. [Length]"2

% Specify a percent. [Price] * 80%

= Test if two values are equal. IF([ProductName] = "1919 Ford

Falcon", "Discontinued Item",
[ProductName])

> Test if one value is greater than another ~ IF([Total] > 5000, [Total]*15%,

value. [Total]*10%)

< Test if one value is less than another IF([SalePrice] < [MSRP], "Below

value. MSRP", "Above MSRP")

>= Test if one value is greater than or equal ~ IF([Total] >= 5000, [Total]*15%,

to another value. [Total]*10%)

<= Test if one value is less than or equal to IF([SalePrice] <= [MSRP], "Below or

another value. equal to MSRP", "Above MSRP")

AND Test if two or more conditions are true. IF(([Gender] = "Male" AND

[Salary] >= 150000 AND [Age] <
50), "Match found", "No match")
OR Test if any one of multiple conditionsis  IF(([City] = "Boston") OR ([City] =
true. "San Francisco"), "U.S.", "Europe
and Asia")

& Concatenate string values. [FirstName] & " " & [LastName]
Operators in conditional formatting and filter
condition expressions
Table 11-3 lists the operators you can use when you create expressions for
conditional formatting and filter conditions.

Table 11-3 Operators in conditional formatting and filter condition expressions

Operator Use to Example

Any Of Test if a column value is equal to any one  Country Any Of USA, Canada,

of the specified values. Mexico

Between Test if a column value is between two Profit Between 1000 and 2000

specified values.

Bottom N Test if a column value is among the SalesAmount Bottom N 10

lowest n values.
(continues)
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Table 11-3 Operators in conditional formatting and filter condition expressions (continued)

Operator Use to Example

Bottom Test if a column value is in the bottom SalesAmount Bottom Percent 5

Percent n percent of all values.

Equal to Test if a column value is equal to a Country Equal to France
specified value.

Greater Test if a column value is greater than a Total Greater Than 5000

Than specified value.

Greater Test if a column value is greater than or ~ Total Greater Than or Equal to 5000

Than or equal to a specified value.

Equal to

In Test if a column value is in the list of Country In USA, Canada, Mexico
specified values. Usage similar to the
Any Of operator.

Is False Test if a column value is false. LoanApproved Is False

Is Not Null  Test if a column value is not a null value. CreditLimit Is Not Null
A null value means no value is supplied.

Is Null Test if a column value is a null value. CreditLimit Is Null

Is True Test if a column value is true. LoanApproved Is True

Less Than  Test if a column value is less than a Total Less Than 5000
specified value.

Less Than  Test if a column value is less than or Total Less Than or Equal to 5000

or Equalto equal to a specified value.

Like Test if a column value matches a string ProductName Like %Ford%
pattern.

Not Test if a column value is not between two  Profit Not Between 1000 and 2000

Between specified values.

Not Equal  Test if a column value is not equal to a Country Not Equal to France

to specified value.

Not In Test if a column value is not in the Country Not In USA, Canada,
specified list of values. Mexico

Not Like Test if a column value does not matcha  ProductName Not Like %Ford%
string pattern.

Top N Test if a column value is among thetop ~ SalesAmount Top N 10

Top Percent

n values.

Test if a column value is in the top
n percent of all values.

SalesAmount Top Percent 5
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Actuate BIRT Viewer Reference






Configuring
Actuate BIRT Viewer

This chapter covers the following topics:

m Configuring the Actuate BIRT Viewer toolbar using iv_config.xml
m Configuring an Actuate BIRT Viewer using web.xml

m Configuring a BIRT Viewer Java Extension

m Configuring default export formats
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Configuring the Actuate BIRT Viewer toolbar using
iv_config.xml

The Actuate BIRT Viewer provides a toolbar and context menus that support
many of the formatting, sorting, and grouping tasks you perform on data. The
toolbar and menus also support adding or deleting columns or groups, and
working with fonts and text alignment. You also can print reports and export
content or data. Enable or disable each of these features using the configuration
file iv_config.xml. Its location is:

<context root>\WEB-INF\iv_config.xml

The iv_config.xml file contains lists of features that are enabled or disabled based
on security roles as defined in Actuate iServer. The default roles included for
iv_config.xml are:

n Al

m Active Portal Intermediate
m  Active Portal Advanced

m Active Portal Administrator

The Active Portal roles are created when iServer is installed or, if you are using
the Java Component Actuate BIRT Viewer, set in the web.xml
DEFAULT_WORKGROUP_FUNCTIONALITY_ROLE parameter. You can add
additional iServer roles as needed. Each set of features for a role is called a feature
control. Each feature control contains the user role being described, and the set of
features that are marked individually as available or not available. The following
section of iv_config.xml shows the default feature control for the Active Portal
Advanced role:

<FeatureControl>
<Role>Active Portal Advanced</Role>
<Features>
<Feature>
<FeatureName>SaveDesign</FeatureName>
<Availablity>false</Availablity>
</Feature>
<Feature>
<FeatureName>SaveDocument</FeatureName>
<Availablitystrue</Availablity>
</Feature>

</Featuress>
</FeatureControls>
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All <FeatureControl> tags are placed within the <FeatureConfiguration>
element. Each feature is described by the <Feature> tag, and its availability is
described with the <Availability> tag. If a particular feature is available to a role,
availability is set to true. If the feature is not available, it is set to false.

Exception stack trace display is also controlled in the iv_config.xml file. When an
exception occurs, the viewer can display a stack trace can be displayed in the
exception dialog. The trace is used for support purposes, and is set to false by
default. This value is not associated with user roles and is placed outside the
<FeatureControl> tag. The format of the iv_config.xml file appears as shown in
the following code:

<IVConfigs>
<!-- Disable stack trace on exception dialog -->
<ExceptionStackTrace>false</ExceptionStackTrace>

<!-- Config features -->

<FeatureConfigurations
<!-- All -->
<FeatureControls>

</FeatureControl>
<FeatureControl>

</FeatureControls>

</FeatureConfiguration>
</IVConfig>

Table 12-1 lists the features that can be set, and how the availability tag affects
them.

Table 12-1 Actuate BIRT Viewer feature set

Feature Availability tag description

AdvancedSort Shows or hides the Advanced Sort item in the context
menu

Aggregation Shows or hides the Aggregation item in the context
menu

Analyze Enables or disables the Analyze item in the cross tab

toolbar and context menu
AutoEnablelV Enables or disables interactivity by default

CalculatedColumn  Shows or hides the New Computed Column and Edit
Computed Column items in the context menu

(continues)

Chapter 12, Configuring Actuate BIRT Viewer 197



Table 12-1

Actuate BIRT Viewer feature set (continued)

Feature Availability tag description

ChartSubType Shows or hides the Chart Subtype item in the context
menu

ChartProperty Shows or hides the Chart Property item in the context
menu

ColumnEdit Shows or hides the Hide Column, Show Columns, and
Delete Column items in the context menu

CollapseExpand Shows or hides the Hide Detail and Show Detail items
in the context menu

ColumnResize Shows or hides the Column Width item in the context
menu

ConditionalFormat ~ Shows or hides the Conditional Formatting item in the
context menu

EditReport Shows or hides the Enable Interactivity item in the
toolbar main menu

ExportData Shows or hides the Export Data menu item in the
toolbar main menu

ExportElement Shows or hides the Export Content menu item in the
context menu

ExportElementData ~ Shows or hides the Export Data menu item in the
context menu

ExportReport Shows or hides the Export Content menu item in the
toolbar main menu

FacebookComments Shows or hides the Facebook Comment menu item in
the toolbar main menu

FlashGadgetFormat ~ Shows or hides the Format Flash Gadget item from the
gadget context menu

FlashGadgetType Shows or hides the Change Type from the gadget
context menu

Filter Shows or hides the Filter item in the context menu

Format Shows or hides the Format, Change Font, and
Alignment items in the context menu

GrandTotal Enables or disables the Grand Total option in the
aggregation dialog

GroupEdit Shows or hides the Move To Group, Add Group, and

Delete Group items in the context menu
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Table 12-1

Actuate BIRT Viewer feature set (continued)

Feature Availability tag description

HideShowltems Shows or hides the Hide/Show Item menu item in the
toolbar main menu

Highlight Shows or hides highlighting

HoverHighlight Shows or hides the mouse over rectangles on page
elements

LinkToThisPage Shows or hides the Link To This Page item in the main
menu

MainMenu Enables or disables the toolbar’s main menu

MoveColumn Shows or hides the Move to Left and Move to Right
items in the context menu

PageBreak Shows or hides the Page Break item in the context menu

PageNavigation Shows or hides the page navigation icons in the
navigation bar

Parameter Shows or hides the Parameter item in the toolbar

Print Shows or hides the Print menu item in the toolbar main
menu

Resize Enables or disables the Resize feature

ReorderColumns Shows or hides the Reorder Columns item in the context
menu

SaveDesign Shows or hides the Save Design menu item in the
toolbar main menu

SaveDocument Shows or hides the Save Document menu item in the
toolbar main menu

ScrollControl Shows or hides the scroll control panel in page content

ServerPrint Shows or hides the Server Print menu item in the
toolbar main menu

ShareFormat Shows or hides the Copy Format menu item in the
context menu

ShareStyle Shows or hides the Copy Style menu item from the
context menu

ShowTooltip Shows or hides tooltips

Sort Shows or hides the Sort Ascending and Sort Descending

items in the context menu

(continues)

Chapter 12, Configuring Actuate BIRT Viewer 199



Table 12-1

Actuate BIRT Viewer feature set (continued)

Feature

Availability tag description

SubTotal

Enables or disables the SubTotal option in the
aggregation dialog

SuppressDuplicate Shows or hides the Repeat Values and Do Not Repeat

SwitchView
Toc

TextEdit
Toolbar
ToolbarHelp

Values items in the context menu

Shows or hides the Switch View item in the context
menu

Shows or hides the TOC menu item in the toolbar main
menu

Shows or hides the edit text icon on text elements
Shows or hides the toolbar

Shows or hides the toolbar Help menu item

TopBottomNFilter Shows or hides the Top/BottomN item in the context

menu

Configuring an Actuate BIRT Viewer using web.xml

Actuate BIRT Interactive Viewer (IV) parameters in web.xml affect how BIRT
reports are run and viewed. Table 12-2 describes these configuration parameters
for BIRT reports, BIRT Viewer, and Interactive Viewer.

Table 12-2 Actuate BIRT Viewer web.xml parameters

Parameter name

Description

ALLOW_EXPORT_PAGE_
LIMIT

ALLOW_IV_PAGE_LIMIT

AUTOSUGGEST_DELAY

AUTOSUGGEST_FETCH_
SIZE

Indicates the maximum number of pages that can be exported
or printed at a time from an Actuate BIRT Viewer. For example,
if the value of this parameter is 200, no more than 200 pages
will be exported or printed from a report using the viewer.

Specifies whether Information Console checks for a page limit
before triggering an operation.

Configure the delay before the parameters page opens an
automatic suggestion for a parameter. The value is measured in
milliseconds, and the default value is 500.

The number of autosuggest parameter values to load on the
parameters page. The default value is -1, which loads all
values.
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Table 12-2

Actuate BIRT Viewer web.xml parameters (continued)

Parameter name

Description

AUTOSUGGEST_LIST_
SIZE

BIRT_ARCHIVE_
MEMORY_TOTALSIZE

BIRT_CHART_MAX_ROW

BIRT_CHART_MAX_
VARIABLE_SIZE

BIRT_CUBE_FETCH_
LIMIT_COLUMN_EDGE

BIRT _CUBE_FETCH_
LIMIT_ROW_EDGE

BIRT_DATA_RESULTSET_
MAX_BUFFER_SIZE

BIRT_
HTMLRENDEROPTION _
ENGCASSTYLE

BIRT_JDBC_
CONNECTION_POOL_
SIZE

BIRT_JDBC_
CONNECTION_POOL_
TIMEOUT

BIRT_MAX_MEMORY _
SIZE_PER_ARCHIVE

BIRT_RESOURCE_PATH

The number of autosuggest parameter values to display on the
Parameters page when active. If more values exist than are
displayed, the user can scroll through the other values. The
default value is 10.

The total memory available for BIRT report document files, in
kilobytes. The default value is 50 megabytes.

The maximum number of rows bound to a chart in a BIRT
report. The default value is 10000 rows.

The maximum size for a variable used in a Flash chart,
measured in bytes. The default value is 0, which allows a
variable to be of any size.

The maximum column limit for accessing a data cube. The
value must be a non-negative integer; 0 indicates no limit.

The maximum row limit for accessing a data cube. The value
must be a non-negative integer; 0 indicates no limit.

The result set buffer size, in megabytes, for a data set in a BIRT
report. The default value is 10 megabytes.

Enables the agentStyleEngine property for the HTML render
option for a BIRT report. This setting is related to using a
browser’s internal CSS capabilities when rendering reports in
HTML. It provides better column alignment and faster
rendering, especially in a browser other than Microsoft Internet
Explorer. The default value is true.

Specifies the number of idle connections cached by BIRT JDBC
connection pool. The default value is 10.

Specifies how long an idle connection will remain in the BIRT
JDBC connection pool in seconds. The default value is 3600.

The amount of memory used by each BIRT report document
file, in kilobytes. A report larger than this size is written to disk
instead of being cached in memory. Use this parameter for
performance tuning. The default value is 200 kilobytes.

The path to Actuate BIRT shared resources, including libraries
and templates for the BIRT report designs and BIRT Studio. The
default value is <context root>\resources.

(continues)
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Table 12-2 Actuate BIRT Viewer web.xml parameters (continued)

Parameter name

Description

BIRT_SCRIPT_LIB_PATH

BIRT_SAVE_REPORT _
DOCUMENT_ENABLED

BIRT_SAVE_REPORT_
DOCUMENT_FOLDER

BIRT_VIEWER_LOCALE

CACHE_CONTROL

Path for the BIRT script libraries (JARs). The default value is
<context root>\scriptlib.

Determines if temporary report files are saved. Enables the user
to save output from BIRT Interactive Viewer using the
__outputDocName URL parameter. Using this parameter saves
the document to the folder assigned to
BIRT_SAVE_REPORT_DOCUMENT_FOLDER. Default is true.

Path to the folder where temporary report files are created. The
default path to which to save BIRT Report Documents saved
using the __outputDocName parameter. This parameter is
made available by setting the
BIRT_SAVE_REPORT_DOCUMENT_ENABLED parameter.

Locale that determines formatting for numbers and dates on
BIRT reports. The default value is the locale of the machine on
which Information Console is installed.

Specifies how a web browser caches information using one of
the following values:

m  NO-CACHE indicates that the browser does not cache
information and forwards all requests to the server. With
NO-CACHE, the back and forward buttons in a browser do
not always produce expected results, because choosing
these buttons always reloads the page from the server.

If multiple users access Information Console from the same
machine, they can view the same cached data. Setting
CACHE_CONTROL to NO-CACHE prevents different
users viewing data cached by the browser.

m  NO-STORE indicates that information is cached but not
archived.

m PRIVATE indicates that the information is for a single user
and that only a private cache can cache this information. A
proxy server does not cache a page with this setting.

m PUBLIC indicates that information may be cached, even if it
would normally be non-cacheable or cacheable only within
an unshared cache.

m  UNSET (no value) is the default value. The browser uses its
own default setting when there is no CACHE_CONTROL
value.
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Table 12-2 Actuate BIRT Viewer web.xml parameters (continued)

Parameter name

Description

CACHE_CONTROL
(continued)

DEFAULT_LOCALE
DEFAULT_TIMEZONE

DEFAULT_WORKGROUP_
FUNCTIONALITY_ROLE

EXPORT_AS_
ATTACHMENT

IV_ENABLE_IV

JAVA_REPORT_API_
IMAGE_CACHE_
EXPIRATION

JREM_TASK_QUEUE_SIZE

JREM_THREAD_POOL_
SIZE

JREM_THREADPOOL_
MAXSYNC_
TASKRUNTIME

Caching information reduces the number of server requests
that the browser must make and the frequency of expired page
messages. Caching increases security risks because of the
availability of information in the cache. For additional
information about cache control, see the HTTP /1.1
specifications.

The default locale. The default locale is en_US. Users can select
a locale when they log in.

The default time zone. The default time zone is Pacific
Standard Time (PST).

Specifies the functionality role for all users using BIRT Viewer.
The default value is Active Portal Intermediate.

Determines whether a Microsoft Excel, PowerPoint, or Word
report for BIRT Viewer is opened in the Microsoft Internet
Explorer browser or a separate application.

m  When the value is true, the exported report opens in a
separate Microsoft Word, Microsoft PowerPoint, or
Microsoft Excel application.

m  When the value is false, the exported report opens in the
browser window with Microsoft Word, Microsoft
PowerPoint, or Microsoft Excel embedded inside the
browser.

The Firefox browser always opens these report formats in a
separate application.

Determines whether the Enable Interactivity option is usable in
the BIRT Viewer control menu. If false, the Enable Interactivity
option is disabled.

Specifies how long in seconds to cache images for Actuate BIRT
reports and business reports. The default value is 86,400, which
is one day.

Specifies the maximum queue length for the Java Report
Engine thread pool. The default value is 1000.

Specifies the maximum number of threads in the Java Report
Engine thread pool. The default value is 10.

Specifies the maximum time a synchronous report generation
is allowed to run. The default value is 600.

(continues)
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Table 12-2

Actuate BIRT Viewer web.xml parameters (continued)

Parameter name

Description

JREM_THREADPOOL_
MONITORTHREAD_
POLLINGINTERVAL

JREM_THREADPOOL_
SYNC_TASKQUEUE_
TIMEOUT

NUMBER_OF_FILTER _
VALUES

DEFAULT_COLUMN_
PAGE_BREAK_INTERVAL

DEFAULT_PAGE_BREAK _
INTERVAL

DEFAULT_ROW_PAGE_
BREAK_INTERVAL

PROXY_BASEURL

REPOSITORY_CACHE_
TIMEOUT_SEC

TEMP_FOLDER _
LOCATION

Controls the interval in seconds at which the Java Report
Engine thread pool checks for Java report execution time-out or
queue time-out. The default value is 30.

Specifies the maximum time, in seconds, that a Java
synchronous request stays in the Java Report Engine task
queue before timing out, in seconds. The default value is 300.

Specifies the number of distinct values to display when a user
chooses to filter a report on a column in BIRT Viewer. The
default value is 200.

Specifies the number of columns to display on one page when
viewing a cross tab. Must be a non-negative number. Default
value is 10.

Specifies the number of rows to display in one page when
viewing a report. If set to 0, there are no page breaks.

Specifies the number of rows to display on one page when
viewing a cross tab. Must be a non-negative number. Default
value is 40.

Indicates a proxy server’s URL if the network uses one between
the BIRT Viewer web application and the client. The default
value is blank, which indicates that the network does not use a
Proxy server.

Specifies, in seconds, how long to retain temporary files that
BIRT Viewer creates when a user modifies the appearance of a
report. The default value is 900, which is 15 minutes.

Path to the folder where temporary files are created.

Configuring a BIRT Viewer Java Extension

The BIRT Design Engine API provides the IBirtViewerExtension,
IBirtViewerContext, IBirtViewerOp, and IBirtViewer Session Java interfaces to
extend the functionality of BIRT Viewer. Classes implementing these interfaces
are associated with the BIRT Viewer web application when they are added in the
birtviewer-extension.xml configuration file. Its location is:

<context root>\WEB-INF\birtviewer-extension.xml

For example, to enable myIlVExtension.jar to operate on the BIRT Viewer, add an
entry to birtviewer-extension.xml as follows:
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<?xml version="1.0" encoding="UTF-8" ?>

<BirtWebViewerExtension>

<!-- Class name for Interactive viewer extension -->
<InteractiveViewer>com.actuate.sample.MyIvExtension
</InteractiveViewers>
</BirtWebViewerExtensions>

Save the compiled code archive to the <context root>\WEB-INF\lib folder for the
BIRT Viewer web application and restart the application to enable the custom
interface. The interfaces are part of the com.actuate.birtviewer.extension package
of the BIRT Design Engine API.

The IBirtViewerExtension interface defines the event handler methods that
activate implemented code, as follows:

package com.actuate.birtviewer.extension;
public interface IBirtViewerExtension({

// Event handler that runs when a design changes
void afterDesignChange( IBirtViewerContext context, IBirtViewerOp
operation, ReportDesignHandle designHandle ) ;

// Event handler after design get opened.
void afterDesignOpen( IBirtViewerContext context,
ReportDesignHandle designHandle ) ;

// Event handler that runs when a design is saved
void afterDesignSave( IBirtViewerContext context, IBirtViewerOp
operation, ReportDesignHandle designHandle, String path );

//Event handler that runs when viewer creates a new session object
void afterViewerSessionStart( IBirtViewerContext context ) ;

// Event handler that runs before a design change occurs
void beforeDesignChange ( IBirtViewerContext context, IBirtViewerOp
operation, ReportDesignHandle designHandle ) ;

// Event handler that runs before a design opens
void beforeDesignOpen( IBirtViewerContext context, String path );

// Event handler that runs before a design is saved

boolean beforeDesignSave( IBirtViewerContext context,
IBirtViewerOp operation, ReportDesignHandle designHandle,
String path );

// Event handler before soap response get sent back.
void beforeResponse( IBirtViewerContext context, IBirtViewerOp
operation, GetUpdatedObjectsResponse response ) ;

// Triggered when session object gets destroyed.
void beforeViewerSessionClose( IBirtViewerSession session ) ;

}
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The IBirtViewerContext interface defines methods that retrieve information from
the HTTP session, as follows:

package com.actuate.birtviewer.extension;
public interface IBirtViewerContext

// Gets the base URL for the viewer
String getAppBaseUrl( );

// Gets reportlet id/bookmark if user is working on a reportlet.
String getReportletId( ) ;

// Gets the extended session object
IBirtViewerSession getSession( );

// Gets the current user name
String getUserName ( ) ;

// Gets the volume profile name
String getVolumeProfile( ) ;

// Gets the resource folder name
String getVolumeResourceFolder( ) ;

}

The IBirtViewerOp interface defines methods that retrieve information from the
extended session for BIRT Viewer, as follows:

package com.actuate.birtviewer.extension;
public interface IBirtViewerOp

// Gets column ids if target element is a table
String[] getColumnIIds( );

// Gets the operation name
String getName( ) ;

// Gets the target element instance ids
String[] getTargetIIds( );

// Get target element type
String getTargetType( ) ;

}

The IBirtViewerSession interface defines methods that retrieve and set a session
from the extended session for BIRT Viewer, as follows:

package com.actuate.birtviewer.extension;
public interface IBirtViewerSession {

// Check whether key exists.
boolean containsKey( String key );
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//Get attribute from session.
Object getAttribute( String key );

//Set attribute into session.
void setAttribute( String key, Object attribute );

}

Configuring default export formats

The iServer platform provides output format emitters as plug-ins. These emitters
can be configured so that content exported by the BIRT Viewer has specific
settings. To configure emitter default options, add a RenderDefaults.cfg file to the
emitter configuration JAR file for the emitter with specific options set with text.
For example, to configure the Microsoft Excel (.xls) file emitter, add
RenderDefaults.cfg to the following JAR file:

<iServer root>\Jar\BIRT\platform\plugins\
com.actuate.birt.report.engine.emitter.config.xls 11.0.4.<date
stamp>.jar

RenderDefaults.cfg contains one parameter and value pair on each line to
configure each default setting. For example, to configure the XLS emitter to
disable pivot tables and to not hide grid lines by default, the RenderDefaults.cfg
file contains the following entries:

excelRenderOption.EnablePivotTable=false
excelRenderOption.hideGridlines=false

After adding the configuration file to the emitter configuration JAR file,
re-archive and save the JAR file to the plugins folder. Then, restart the iServer
Service. After these steps, the viewer displays the configured default options
when exporting a report to the XLS output format, as shown in Figure 12-1.

Export Content X

Export Format: Excel (XL5) i
-« Page Settings

Fage range

Text wrapping

Enable pivet table  []

Auto adjustment for
pivet table

Chart DPI 192

Export charts as
images D

Enable live formulas
Hide grid lines =
Output to multiple

sheets
g
Figure 12-1 Export content with the pivot table default disabled
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Table 12-3 lists the default settings parameters for the different file formats the
emitters produce.

Table 12-3 Configurable default settings for exporting content
Format Parameter Description
All ChartDpi Sets the chart resolution. For example,
ChartDpi=120.
PDF pdfRenderOption Enables bidirectional text support.
bidiProcessing
pdfRenderOption Embeds fonts in the output document.
.embeddedFonts
pdfRenderOption Enables font substitution for unknown
fontSubstitution fonts.
pdfRenderOption Enables splitting words with a hyphen
.hyphenation at line breaks.
pdfRenderOption Controls rendering content when the
.pageOverflow content exceeds the page size. Integer
values indicate the following options:
m  1: clips the content
m 2:scales the content to fit the page
m  4: (default) divides the content into
multiple pages
m 8: expands the page to fit content
pdfRenderOption Enables text wrapping.
textWrapping
RenderChartInSVG Renders charts as vector graphics.
PPT/ BIDIProcessing Enables bidirectional text support. For
PostScript example, BIDIProcessing=false.
FontSubstitution Sets font substitution for unknown
fonts. For example,
FontSubstitution=false.
TextWrapping Enables text wrapping. For example,

TextWrapping=false.

XLS/XLSX excelRenderOption Enables BIRT Viewer to automatically

.AutoFitPivotTable adjust content for display in pivot
tables.

excelRenderOption Enables formulas for derived values.

.EnableLiveFormula
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Table 12-3 Configurable default settings for exporting content

Format Parameter Description
XLS/XLSX  excelRenderOption Enables pivot tables.
(continued) .EnablePivotTable
excelRenderOption Renders charts as images only.
.ExportChartsAsImages
excelRenderOption Hides grid lines.
.hideGridlines
excelRenderOption Enables multiple worksheet output.
.multipleSheet
excelRenderOption Enables text wrapping.
.wrappingText
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Actuate BIRT Viewer URIs

This chapter contains the following topics:

About the BIRT Viewer servlet

Information Console file manager URIs overview
Information Console file manager URIs quick reference
Common URI parameters

Information Console file manager URIs reference
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About the BIRT Viewer servlet

Java servlets extend web server functionality. The BIRT Viewer is a Java servlet
that manages binary content and performs tasks such as uploading and
downloading binary files.

You invoke the BIRT Viewer servlet using the following syntax:
http://<application servers:<ports>/<context roots>/iv

where

m application server is the name of the machine hosting the application server.
m port is the port on which the application server listens for requests.

m context root is the Information Console context root.

m ivis the name to which the servlet is mapped in the web application’s web.xml
file. A typical location for web.xml is <context root>\WEB-INF\web.xml.

Servlet names are case-sensitive. Do not modify the servlets, their names, or their
mapping in web.xml.

Using open-source BIRT URIs in Actuate BIRT Viewer

Actuate BIRT Viewer fully supports the URIs for the open-source BIRT Viewer.
After migrating from open-source BIRT to Actuate BIRT, you can use the same
URISs in the Actuate BIRT Viewer that you used in open-source BIRT.

Accessing the BIRT Viewer using a URI

The BIRT Viewer servlet displays a BIRT report and provides tools to affect the
document and design files. This servlet provides both the BIRT Viewer and the
BIRT Report Interactive Viewer. The Interactive Viewer is licensed separately
from the BIRT Viewer.

To create a link using the URL provided by the Link to this page menu item in the
viewer, an HTML page containing the link must use a strict Document Type
Definition (DTD). Without the DTD, some user interface components such as
controls, dialogs, and menus do not appear correctly. To use the strict DTD, use
the following code at the beginning of the HTML page markup:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN"
"http://www.w3.org/TR/html4/strict.dtd" >
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Name

URI
parameters

The BIRT Viewer displays the report with toolbar options to navigate the report
and a menu to perform additional tasks, as shown in Figure 13-1.

1i5 L

Sw

Classic Models, Inc
2207 Bridgepointe Parkway

San Mateo, CA 94404 Customer Order Histo

Australian Collectors, Co.

Contact: Peter Ferguson Sales Representative: Andy Fixter

Figure 13-1 BIRT Viewer

The Interactive Viewer displays the report with toolbar options to navigate the
report, a menu to perform additional tasks, and provides context menus to edit
and format report elements, as shown in Figure 13-2.

= 115 L

1 Classic Models, Inc =-
2207 Bridgepointe Parkway

% San Mateo, CA 04404 Customer Order HiStOI’V

Australian Collectors, Co.
Contact: Peter Ferguson Sales Representative: Andy Fixter

Figure 13-2 BIRT Interactive Viewer

The BIRT Viewer servlet supports rptdocument file formats. For backwards
compatibility with previous releases, the BIRT Viewer also supports the
bizdocument file format.

com.actuate.iv.servlet.IVServlet

Table 13-1 lists and describes the URI parameters for the Interactive Viewer
servlet.

Table 13-1 IVServilet URI parameters
URI parameter Description
__bookmark Name of the element of a report to display instead of the
whole report file.
__floatingfooter Boolean value to add a margin under the footer.
(continues)
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Table 13-1 IVServlet URI parameters (continued)

URI parameter Description

__format A format for the displayed report:
m pdf: Adobe PDF
xls: Microsoft Excel
doc: Microsoft Word
ppt: Microsoft PowerPoint
ps: PostScript
html: HTML
flashchartsxml: used to display a fusion chart

flashgadgetsxml: used to display Flash gadgets in a
fusion chart.

m reportlet: This is used together with __bookmark to
show a particular part/element of the report.

__from_page_range The page range of a report to display.

__from_page_style The page style to use for a report in pdf or ps formats:
m auto: The page size and content size remains the same.
m actualSize: Change the page size to fit the content.
m fitToWholePage: Change the content size to fit the

page size.
Used with the __format parameter.
__imageid Identifier of the report file image to display.
__instanceid Identifier of the report file to display.
__launchiv A Boolean value that enables interactivity.
__locale Code for a locale. For example FR_fr specifies the French
language and the country, France.
__page The number of a page to render.
__report Name of the report file to display.
__rtl Boolean value that specifies right-to-left orientation for
the report.
repositoryType The name of the object to download.
serverURL The URL that accesses iServer, such as
http:/ /ESL02835:8000.
userid The user’s identifier, required to log in to the Actuate
iServer.
volume A string value specifying the Encyclopedia volume for

this report.
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Information Console file manager URIs overview

The following sections describe the Java Component Information Console JSPs
that manage files and folders. For a repository managed with iServer, the
Information Console provides this functionality. For information about
Information Console URIs, see Information Console Developer Guide.

The following sections provide quick reference tables and detailed reference
information about Actuate Information Console URIs. An Actuate Information
Console URI is a directive to Actuate Information Console to perform an action,
such as showing a list of files, rather than change the appearance of the
application.

Information Console pages use the .do extension for the Struts action mapping to
a page. The complete page name appears as part of the reference material.
Actuate Information Console page and folder names are case-sensitive.

Information Console file manager URIs quick reference

Table 13-2 lists the Information Console file manager URIs.

Table 13-2

Actuate Information Console URI pages

Actuate Information
Console page

Description

about page
banner page

browse file page

delete file status page
detail page
drop page

error page

execute report page
getfiledetails page
getfolderitems page

Displays information about Actuate Information Console

Displays a banner at the top of each Information Console file
manager page

Provides file and folder browsing functionality for the submit
request pages

Displays whether a file was successfully deleted
Supports error handling and presenting object details
Supports deleting files or cancelling running jobs

Retrieves an error message from the exception or the request and
displays it

Submits a run report job request to the server
See file or folder detail page
See index page

(continues)
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Table 13-2 Actuate Information Console URI pages (continued)

Actuate Information
Console page

Description

home page

list page
page not found page

parameters page

Provides the link from the My Folder button to the Information
Console file manager home page

Supports listing files and folders

Displays an error message when a JSP is unavailable in Information
Console file manager

Presents a list of the request parameters

Common URI parameters

All Actuate Information Console file manager URIs have the parameters shown
in Table 13-3. String values that are too long are truncated for all parameters. The
web browser that you use determines the length of parameters.

Table 13-3 Common URI parameters

URI parameter

Description

locale

serverURL

timezone

volume

_vp

The current user’s locale, such as U.S. English (en-US). Information
Console locale names have the form nn_CC. nn is the language
abbreviation and CC is the country code.

Contains the URI that accesses the Actuate web application, such as
http:/ /Services:8000.

The current user’s time zone.
The volume to which the user is connected.

The name of a server configured in VolumeProfile.xml. Information
Console uses the volume information in a VolumeProfile entry except
when a volume parameter specifies a different one.

Information Console file manager URIs reference

This section provides the detailed reference for Information Console file manager
URIs. In the definitions, <context root> represents the name of your Actuate
Information Console context root. Table 13-4 lists the topics in this section and the
pages discussed in each topic. All pages are under the Information Console
context root.
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about page

Table 13-4 Actuate Information Console pages
Page Information Console file
about page iportal\activePortal\ private\options\about.jsp

banner page

browse file page

delete file status
page

detail page

m error detail page

m file or folder
detail page

drop page

error page

execute report page

iportal\activePortal\ private\common\banner.jsp
browsefile.do
iportal\activePortal\ private\query \browse.jsp

iportal\activePortal\private\filesfolders
\deletefilestatus.jsp

iportal\activePortal\errors\detail.jsp
getfiledetails.do
iportal\activePortal\private\filesfolders\filedetail.jsp

deletefile.do

errors\error.jsp
iportal\activePortal\private\common\errors\error.jsp

executereport.do

index page getfolderitems.do
iportal\activePortal\ private\filesfolders
\filefolderlist.jsp

list page getfolderitems.do
iportal\activePortal\ private\filesfolders
\filefolderlist.jsp

home page iportal\activePortal\ private\common\breadcrumb.jsp

page not found page iportal\activePortal\errors\pagenotfound.jsp

parameters page iportal\activePortal\ private \newrequest
\parameters.jsp

viewer page for BIRT IVServlet

reports

about page

Name

Displays the help about page, containing information about Actuate Information
Console. Called when the user chooses the About tab on the options page. The
default about page for Information Console is similar to Figure 13-3.

<context root>\iportal\activePortal\private\options\about.jsp
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banner page

Parameters  The about page uses the common URI parameters.

Used by iportal\activePortal\private\options\optionspage.jsp

About License

Actuate Information Console version: 11

Volume profile: qa

Actuate BIRT iServer version: 11

Licensed for: Evaluation

JSP server: Apache Tomcat/7.0.69

Current language: English

Current time zone: America/Los_Angeles
@2017 Actuate. All Rights Reserved.

Copyright: Trademarks owned by Actuate
"OpenText” is a trademark of OpenText.

Figure 13-3 Information Console about page

banner page

Provides the banner that appears across the top of all Actuate Information
Console web pages. The default banner displays the Actuate logo, user name,
cluster name, and volume name, and provides links for Logout, Options, and
Help. The banner page obtains the user name, cluster name, and volume name
from variables maintained by the authenticate page.

Name <context root>\iportal\activePortal\private\common\banner.jsp

Used by iportal\activePortal\private\login.jsp
iportal\activePortal\ private\channels\channelnoticelist.jsp
iportal\activePortal\ private\channels\channeloperationstatus.jsp
iportal\activePortal\ private\filesfolders\ deletefilestatus.jsp
iportal\activePortal\ private\filesfolders\filedetail jsp
iportal\activePortal\ private\filesfolders \filefolderlist.jsp
iportal\activePortal\ private\jobs\getjobdetails.jsp
iportal\activePortal\ private\jobs\joboperationstatus.jsp
iportal\activePortal\ private\jobs\selectjobs.jsp
iportal\activePortal\ private \newrequest\newrequest.jsp
iportal\activePortal\ private \newrequest\newrequest2.jsp
iportal\activePortal\ private \newrequest\submitjobstatus.jsp
iportal\activePortal\ private\options\options.jsp
iportal\activePortal\ private\query\create.jsp
iportal\activePortal \ private\query\execute.jsp
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browse file page

browse file page

Name

Parameters

Used by

Contains file and folder browsing functionality used by other submit request
pages.
<context root>\browsefile.do

<context root>\iportal\activePortal\private\query\browse.jsp

workingFolder is the name of the folder for which to display contents in the
folder browser window. The browse file page also uses the common URI
parameters.

iportal\activePortal\ private \newrequest\browse.jsp
iportal\activePortal\ private\query \browse.jsp

delete file status page

Summarizes the result of a deletion performed by the drop page and indicates
whether a file was successfully deleted. The delete file status page includes
authenticate to obtain user session data. Information Console performs the
deletion as part of an action and then forwards to the delete file status page.

Name <context root>\iportal\activePortal\private\filesfolders\deletefilestatus.jsp
Used by Not applicable.
detail page
Displays detailed information about repository objects. There are two detail
pages:
<context root>\iportal\activePortal\ errors
<context root>\iportal\activePortal \filesfolders
error detail page
Provides a template error page that can be embedded in another page.
Name <context root>\iportal\activePortal\errors\detail.jsp
Used by iportal\activePortal \private \common\errors\error.jsp

iportal\activePortal\viewer\print.jsp
iportal\activePortal \viewer\saveas.jsp
iportal\activePortal\viewer \searchframe.jsp
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drop page

iportal\activePortal\viewer\viewdefault.jsp
iportal\activePortal \viewer\viewtoc.jsp

file or folder detail page

Displays detailed information about the selected viewable folder or file. Users
request file details by choosing the magnifying glass icon to the right of files listed
on the folder page, or folder details by choosing the magnifying glass icon to the
right of the folder name in the breadcrumb. Users can request another viewable
document or delete the current file or folder from the file or folder detail page.
filedetail jsp uses the HTML code in <context root>\iportal\activePortal
\private\filesfolders\filedetailcontent.jsp to display the information.

Name <context root>\getfiledetails.do

<context root>\iportal\activePortal\private\filesfolders\filedetail.jsp

Parameters  Table 13-5 describes the parameters for the file or folder detail page. The file or
folder detail page also uses the common URI parameters.

Table 13-5 File or folder detail URI parameters

URI parameter Description

name The full path name of the repository object for which to show details.

This parameter is ignored if objectID is also specified.
objectID The repository object’s unique identifier.
version The repository object’s version number. The default is the latest version.
Used by Not applicable.

drop page

Deletes the specified file or folder. The drop page includes the banner page to
obtain user session data.

Name <context root>\deletefile.do
Parameters  Table 13-6 describes the parameters for the drop page. The drop page also uses
the common URI parameters.
Table 13-6 File or folder drop URI parameters
URI parameter Description

ID

The unique identifier of the repository object to delete.
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error page

Table 13-6 File or folder drop URI parameters
URI parameter Description
name The full path name of the repository object to delete. Multiple name
parameters, to delete more than one file or folder at a time, are allowed.
This parameter is ignored if ID is also specified.
redirect URI to which to redirect the job deletion page. The default redirect page
is processedaction_status.
Used by Not applicable.
error page
Displays the specified error message. Information Console uses two pages. All
Information Console code uses <context root>\iportal\activePortal\ private
\common\errors \error.jsp.
Name <context root>\iportal\activePortal\errors\error.jsp
<context root>\iportal\activePortal\private\common\errors\error.jsp
Used by iportal\activePortal\private\login.jsp

iportal\activePortal\ private \common \ closewindow.jsp
iportal\activePortal\ private\common\sidebar.jsp
iportal\activePortal \ private\common\errors\errorpage.jsp
iportal\activePortal\ private\options\options.jsp
iportal\activePortal\ private\query \create.jsp
iportal\activePortal \ private\query\execute.jsp
iportal\activePortal\ private\templates\template.jsp
iportal\activePortal \viewer\closewindow.jsp
iportal\activePortal\viewer\print.jsp
iportal\activePortal \viewer\saveas.jsp
iportal\activePortal\viewer \searchframe.jsp
iportal\activePortal\ viewer\searchreport.jsp
iportal\activePortal\viewer\viewframeset.jsp

execute report page

Submits a run report job request.

When executing a report job or query, a cancel button appears after a specified
wait time passes. You can change the time by setting the
EXECUTE_REPORT_WAIT_TIME configuration parameter in the appropriate
Actuate Information Console configuration file.

Chapter 13, Actuate BIRT Viewer URIs 221



execute report page

For reports that accept run-time parameters, you can set the parameter in the

URL by

adding an ampersand (&), the parameter name, and an equal(=) sign,

followed by the parameter value in quotes.

Name <context root>\executereport.do

Parameters  Table 13-7 describes the parameters for the execute report page. The execute
report page also uses the common URI parameters.

Table 13-7 Execute report URI parameters
URI parameter Description
__ageDays Use with __ageHours to determine how long output objects exist before

__ageHours

_executableName

invokeSubmit

__outputDocName

__priority

__priorityValue

__progressive

__serverURL

__wait

they are automatically deleted. Use only if __archivePolicy is set to Age.
ageDays can be any positive number.

Use with __ageDays to determine how long output objects exist before
they are automatically deleted. Use only if __archivePolicy is set to Age.
__ageHours can be any positive number.

The name of the executable file for this request.

Controls whether the browser is redirected to the parameter screen or
whether the report job is run immediately. If true, the report job is
executed without displaying the parameters. If false, the parameters are
displayed. False is the default.

The name and path of the resulting BIRT document. This parameter is
only usable for BIRT Reports when the
BIRT_SAVE_REPORT_DOCUMENT_ENABLED parameter is set to
TRUE in web.xml.

If the given path is absolute, then executereport saves the report to that
path. If the given path is relative, then executereport saves the report to
the path set in the BIRT_SAVE_REPORT_DOCUMENT_PATH web.xml
parameter.

Specifies the job submission priority. Values are High, Medium, and
Low.

Specifies a number ranging from 1 to 1000 and corresponding to the job
submission priority. You can only specify values allowed by your
functionality level.

Indicates whether to display the report document after it generates. If
false, the report document displays after it generates. If true, the report
document displays progressively, as it generates.

Contains the URI that accesses the JSP engine, such as
http:/ /Services:8900.

If "wait", Information Console waits for the report generation to be
completed before displaying it. If "nowait", Information Console
displays the first page right away even if the report job is not completed.
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Used by

home page

For example, the following URL executes the Sales By Territory.rptdesign report
immediately with the Territory run-time parameter set to EMEA:

http://localhost:8080/ActuateJavaComponent/executereport.do?
___requesttype=immediate& executableName=/Public
/BIRT%20and%20BIRT$20Report%20Studio%20Examples
/Sales%20by%20Territory.rptdesign&userid=anonymousé&
__saveOutput=false&Territory=%22EMEA%22&invokeSubmit=True

The following parameter names are reserved for internal use only by the execute
report page:

m doframe
m inputfile
m jobType
= name

m selectTab

Not applicable.

home page

Name

Provides two sets of links. On the right side it provides a graphical and a text
shortcut link from the My Folder button to the current user’s Actuate Information
Console home folder. If the Information Console installation includes BIRT
Studio, there is another shortcut link, BIRT Studio, to BIRT Studio. On the left
side, it provides the links and other text for the breadcrumb, or path from the
repository root to the current folder.

Users access their home page by choosing the My Folder link below the Actuate
Information Console page banner.

Figure 13-4 shows the default My Folder and breadcrumb links.

My Documents

) Add Contert

Elsave

‘;'_.';‘,L,IT'UD

B Documents 7
My Jobs

IChannels
Sy Mohile Subscript

g Folder

Folders

" Dashboard

1 Home

Add File Filter: On | OFF  Wiew: | Categories vl

Public

Resources

Figure 13-4

My Folder and breadcrumb links

Home link
BIRT Studio link

Breadcrumb links

<context root>\iportal\activePortal\private\common\breadcrumb.jsp
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index page

Used by

iportal\activePortal\ private\skins\tabbed \ templates \mypagetemplate.jsp
iportal\activePortal\ private\skins\tabbed \ templates\template.jsp
iportal\activePortal\ private\skins\classic\templates\template.jsp
iportal\activePortal\ private\skins \treeview \ templates\template.jsp

index page

Name

Parameters

Table 13-8

Provides the entry point and structure for the parts of Actuate Information
Console generated from multiple files.

The index page is the default entry point to the Actuate Information Console web
application. The index page provides the entry point and structure to support the
Files and Folders functionality. The structure is a table that Actuate Information
Console uses to format and present files and folders data. Page content varies
depending on the Actuate Information Console directive.

The index page uses the banner page to provide the reporting web page
banner. filefolderlist.jsp uses the HTML code in <context root>\iportal
\activePortal\private \filesfolders \filefolderlistcontent.jsp to display files and
folders data.

<context root>\getfolderitems.do

<context root>\iportal\activePortal\private\filesfolders\filefolderlist.jsp

Table 13-8 describes the parameters for files and folders index page. The files and
folders index page also uses the common URI parameters.

File and folder index URI parameters

URI parameter Description

startUpMessage Specifies a message to appear when Actuate Information Console calls

subpage

this page.

Specifies the content of the page. Possible values are:
m _list: include list

m _detail: include detail

Specifying any other value for subpage invokes the page not found
page.

list page

Lists files in a container, such as a folder.

The list page presents a list of files and folders that reside in the current working
repository folder. Users request folder listings by choosing links on the reporting
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page not found page

web page. The list page includes a filter section where users specify criteria for
viewing report documents.

When users access a repository for the first time, Actuate Information Console
displays their home folder, if they have one, or the top folder in the repository. All
files and folders in that folder that they have permission to view appear in the list
page. Users can specify a filter to choose the types of files to view.

Name <context root>\getfolderitems.do
<context root>\iportal\activePortal\private\filesfolders\filefolderlist.jsp

Parameters  Table 13-9 describes the parameters for the list page. The list page also uses the
common URI parameters.

Table 13-9 File and folder list URI parameters

URI parameter Description

applyFilter If true, apply filter. If false, filter not applied.

filter The filter specifying the file and folder names to list. Filter is a string.
The default is "".

folder The folder for which to list the contents. Folder name is a string. If no

folder is specified, list uses the last working folder known for the
session if cookies are enabled. If cookies are not enabled, list uses the
user’s home folder as specified in the user settings.

onlyLatest If true, show only the latest version of a file if multiple versions exist. If
false, show all versions of a file if multiple versions exist. The default is
false.

resetFilter Any non-null value for resetFilter causes the filter to return to its

original state. Users can reset the filter by choosing the Default button
on the listing page.

showDocument If true, show all viewable documents. If false, do not show viewable
documents. The default is true.

showExecutables  If true, show all report executables. If false, do not show report
executables. The default is true.

showFolders If true, show all folders. If false, do not show folders. The default is true.

Used by Not applicable.

page not found page

Displays an error message when Actuate Information Console cannot find the
page that a user specifies. This page is an Information Console page only.
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parameters page

Name <context root>\iportal\activePortal\errors\pagenotfound.jsp
Used by Not applicable.

parameters page

Displays report job parameters. Parameters include the headline, output file
name, and report executable file name. Users access the parameters list by
choosing Parameters.

Parameters looks like Figure 13-5.
Name <context root>\iportal\activePortal\private\newrequest\parameters.jsp

Used by iportal\activePortal\private\newrequest\newrequestpage.jsp

Parameters [7)
-I Sales Office and Sales Rep
Select Sales Office |rvc B -
Select Sales Rep ID |Tseng ;l i
*! Required.
Cancel

Figure 13-5 Parameters page
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Symbols

A operator 191
! format symbol 36

? (question mark) character 184

@ format symbol 36

* (asterisk) character 184

* operator 190

/ operator 190

\ (backslash) characters 95
& format symbol 36

& operator 83, 191

% (percent) character 95

% OF DIFFERENCE function 160

% OF function 160
% operator 191

+ operator 190

< format symbol 36
< operator 191

<= operator 191

= operator 191

> format symbol 36
> operator 191

>= operator 191

- operator 190

_ (underscore) character 95

Numerics
3-D charts 116

A

about page 215, 217
ABS function 161
absolute values 161
accessing
BIRT Viewer 5
data 11
Data Analyzer 151
home page 223
Interactive Viewer 6
repository items 224
web applications 224
actions 215

Index

Active Portal security roles 196

Actual Size print option 16

Actuate BIRT Viewer. See BIRT Viewer

Actuate Deployment Kit

displaying information about 217

Actuate Interactive Viewer. See Interactive

Viewer

Add Group command 64, 198
ADD_DAY function 83, 84, 161

ADD_HOUR function 162
ADD_MINUTE function 162
ADD_MONTH function 162

ADD_QUARTER function 163
ADD_SECOND function 163

ADD_ WEEK function 164
ADD_YEAR function 164
adding

computed columns 78, 81, 158

data fields to expressions 79, 85

filter conditions 91, 96

filters 90-91, 97

formatting rules 24, 25, 28

hyperlinks 13

page breaks 58,74, 204
Adobe Flash Player 140, 141

Advanced Filter dialog 97, 100, 101, 117
Advanced Function Printing formats 43, 44,

45

Advanced Sort command 61, 197

Advanced Sort dialog 61, 62
AdvancedSort feature 197
AFP emitters 44,45

AFP formats 43, 44, 45

AFP Viewer plug-in 45
ageDays parameter 222
ageHours parameter 222

agentStyleEngine property 201
aggregate calculations 70, 188

aggregate data
adding 68, 69, 70
deleting 70
displaying 66,72, 146, 154
exporting 41, 47

Index
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aggregate data (continued) filtering 116

filtering 158 flipping 120

formatting 157 formatting 121

viewing cross tabs and 146 overlapping 122

viewing summary tables and 155 plotting 118
aggregate functions 68, 188 scaling 122
aggregate values. See aggregate data showing changes over time 104, 107, 109
aggregating data 6670, 155 showing deviation and 115
Aggregation command 68, 197 showing multiple 114, 115
Aggregation dialog box 68, 69, 70 showing relationship to whole 111
Aggregation feature 197 showing trends and 114
alignment 23, 37, 149, 156 axis labels 121, 122
Alignment command 22, 149, 198 axis titles 121
ALLOW_EXPORT_PAGE_LIMIT

parameter 200 B

ALLOW_IV_PAGE_LIMIT parameter 200 back button (web browser) 202

analyzing data 40, 63 background colors 117

AND operator 97,98, 191 backslash (\) ch ter 95
animation 40, 104, 128, 140 bz;:mse? sh(}) character

Any Of operator 92,191 displaying 218

applications 49, 203 banner page 215, 218

accessing 224 bar chart sub 104, 105, 106
applyFilter parameter 225 bgi EhZitsS%OZ}iesz ' '

archiving 201 See also charts
area chart subtypes 108 bar colors 117

area charts 107 bar stick stock chart subtype 113
See also charts BETWEEN function 165
arithmetic operations 171, 178

Bet tor 191
Arrange Columns dialog 59, 66 bien;\;;efrill:s ezr?zor
asterisk (*) character 184 BIRT Design Engine API 204

attribute columns 154, 158 BIRT Interactive Viewer. See Interactive
See also summary tables Viewer

aut'hen-tication BIRT iServer. See iServer
issuing URIs and 216 BIRT Report Designer Professional 13
Auto adjust tickmarks property 137 BIRT Report Studio
Auto format option 37, 148, 149 displaying data and 212
[1:3:8 5;11?6 S};trlggerlg 136 BIRT Report Studio link 223
BIRT R t Studi 223
AUTOSUGGEST_DELAY parameter 200 BIRT Rgggf‘t V;;ngrpzaigze °
AUTOSUGGEST_FETCH_SIZE BIRT Report Viewer servlet
parameter 200 See also BIRT Viewer

AUTOSUGGEST_LIST_SIZE parameter 201 BIRT reports 212
Availability tag 197 BIRT ts. S t
AVERAGE function 70, 189 BIRT Stadio 13, 200
axes values (charts) BIRT Viewer '

as x-y coordinates 114

comaring 115 configuring interface for 196
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displaying reports and 4, 5, 200
extending functionality of 204
navigating through reports with 10
BIRT_ARCHIVE_ MEMORY_TOTALSIZE
parameter 201

BIRT_CHART_MAX_ROW parameter 201

BIRT_CHART_MAX_VARIABLE_SIZE
parameter 201

BIRT_DATA_RESULTSET_MAX_BUFFER _

SIZE parameter 201
BIRT_HTMLRENDEROPTION_
ENGCASSTYLE parameter 201

BIRT_JDBC_CONNECTION_POOL _ SIZE

parameter 201
BIRT_JDBC_CONNECTION_POOL_
TIMEOUT parameter 201
BIRT_MAX_MEMORY_SIZE_
PER_ARCHIVE parameter 201
BIRT_RESOURCE_PATH parameter 201
BIRT_SAVE_REPORT_DOCUMENT_
ENABLED parameter 202
BIRT_SAVE_REPORT_DOCUMENT_
FOLDER parameter 202
BIRT_SCRIPT_LIB_PATH parameter 202
BIRT_VIEWER_LOCALE parameter 202
black and white images 44
blank characters 186
blank values 93
Boolean column format dialog 34
Boolean data type 34
Bottom N operator 93, 158, 191
Bottom Percent operator 93, 192
breadcrumbs 223
browse file page 215, 219
browsers. See web browsers
browsing 219
bubble charts 115
See also charts
buffer size parameter 201
bullet gadgets 130, 135
See also Flash gadgets

C

cache 201, 202, 203
CACHE_CONTROL parameter 202, 203

calculated columns. See computed columns

calculated data 41, 78, 80, 160
CalculatedColumn feature 197
Calculation dialog box 80
calculations 66, 70, 78, 154
calendar 94
candlestick stock chart subtype 113
capitalization 187
case 176, 187
case sensitivity 176, 215
category axis. See x-axis
category series 104, 118
CEILING function 166
Change Font command 198
Change Text command 38
changes, previewing 21, 25, 119
changing

alignment 22, 149

axis labels 121, 122

chart subtypes 116

charts 48, 116

column headers 21, 38

columns 7

data 20

expressions 81

file names 15

filter conditions 100

Flash object types 132

folders 14, 15

font properties 21, 148

parameter values 89

report document files 14

reports 6,13, 20

servlets 212

summary tables 155

text 38
character formats 35, 36
character strings. See strings
characters

converting to lowercase 36, 176

converting to uppercase 36, 187

counting 175

finding matching 95, 176, 184

matching literal 95

referencing data fields and 85

removing blank 186
chart dimensions 116, 120
Chart DPI option 44, 52

Index
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Chart Filter dialog 116

Chart Property command 198

chart reports 104

Chart Subtype command 116, 198

Chart Subtype dialog 116, 132

chart subtypes 116, 132

chart titles 119

chart types 104
See also specific type

chart view 126

ChartProperty feature 198

charts
animating. See Flash charts
binding to rows 201
changing 48, 116
displaying data and 104, 122, 152, 158
displaying small sets of values in 112
drilling through 123
exporting 40, 45, 48, 127
exporting data in 127
filtering data for 117
formatting 117, 119, 121
interchanging axes values in 120
overlapping multiple series in 108, 110
previewing 119
rendering as images 52
resizing 119
scaling axes values in 122
setting font properties for 119, 121
showing percentages in 106, 108, 111
showing relationships in 111
showing side-by-side series in 104
stacking series in 105, 108, 110
tracking stock data and 113

ChartSubType feature 198

closing table of contents 11

closing values (charts) 113

closing values (gadgets) 135

CMYK images 45

CollapseExpand feature 198

Color property 134, 136

colors 23,44,117,147

column areas (cross tabs) 147

column headers 21, 38, 156
changing font properties for 21
editing 38
exporting 43
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formatting text in 21, 156
selecting 20
column headings 72
column headings (cross tabs) 146
column labels
See also column headers; field names
column names. See column headers
Column Width command 198
ColumnEdit feature 198
ColumnResize feature 198
columns
See also fields
accessing toolbar for 7
aggregating data and 66, 67, 68, 69, 70
changing font properties for 22, 23
changing order of 59, 157
comparing date values in 94
comparing string patterns in 95
copying formats for 37
creating computed. See computed columns
creating multiple formatting rules for 29
deleting 59, 60, 157
displaying data types in 29, 30
displaying hidden 60
editing 7
exporting specific 41
filtering empty or null values in 93
filtering merged 101
formatting data in 20, 21, 23, 157
getting distinct values in 70
getting number of values in 70
grouping data and 64, 65, 66, 72
grouping on multiple 65
hiding 60, 157
merging 20
removing aggregate data from 70
removing conditional formats from 29
resizing 58, 59
restoring default formats for 37
selecting 20, 23
setting page breaks for 74, 204
setting text attributes for 25
sorting merged 62
sorting multiple 61
suppressing duplicate values in 72,73
viewing cross tabs and 146
viewing summary tables and 154



comma-separated values files 40, 41, 42
comparison operators 26, 91, 97
comparisons 26,27, 92,94, 95, 115
computed columns
See also calculated data; calculations
creating 78, 81, 158
editing 81
exporting and 47
writing expressions for 83-85, 160, 190
concatenation 83, 191
conditional formatting 23-29, 191
Conditional Formatting command 24, 198
Conditional Formatting dialog 24, 25, 26, 29
ConditionalFormat feature 198
conditions
comparing data and 25, 26,27, 97,172
filtering data and. See filter conditions
formatting data and. See conditional
formatting
cone charts 106
See also charts
configuration files 196, 200
configuration parameters 200
configurations
mapping servlets to 212
connection pool 201
connection timeout intervals 201
context menus 7, 128, 196
cookies 216
Copy Format command 37
Copy Format dialog 37
Copy Style command 23
Copy Style dialog box 23
copying
alignment properties 23
font properties 23
formats 37
hyperlinks 13
COUNT function 70, 189
Count Value function 70
COUNTDISTINCT function 189
creating
computed columns 78, 81, 158
expressions 83-85
filter conditions 91, 96
filters 90-91, 97
formatting rules 24, 25, 28

hyperlinks 13

summary tables 154
criteria. See conditions
cross tabs

aligning data in 149

changing font properties for 148

customizing charts in 152
displaying data and 146

displaying tooltips for 149, 150

exporting and 40, 45, 49, 151
formatting data in 147, 148
printing 152

restoring default formats for 149

saving 152
selecting elements in 148
setting page breaks for 204
viewing 147
CSV files 40,41, 42
cubes 146
Currency format 31
currency values 147
current date and time 178, 185
customizing
charts 116, 117, 152, 158
date-and-time formats 33
Flash charts 133
Flash gadgets 133
Flash Player 141
numeric formats 31
reports 6
string formats 36
summary tables 154, 155, 156
cylinder gauge gadgets 129, 137
See also Flash gadgets

D

dashboards 4, 112, 130, 132
data
See also values
aggregating 66-70, 155
analyzing 40, 63
changing 20
comparing 27,95
controlling access to 11

creating animated representations of 104

displaying 58, 60, 80, 104

Index
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data (continued)
exporting 40-43, 127, 139, 151
filtering 88, 101, 116, 138, 142, 158
formatting 20, 23, 30, 147, 156
grouping 62-66, 154
hiding 71,72, 154
organizing 58, 60, 62, 157
previewing changes to 21, 25
restoring default formats for 37, 149
restoring original order of 62
retrieving 11, 88
showing differences in 115
sorting 60-62, 157

Data Analyzer 146

Data Analyzer command 151

data buffer 201

data cubes 146

data fields. See fields

data filters
adding conditions to. See filter conditions
applying to charts 117, 138, 142
comparing date values and 94
comparing string values and 93, 95
creating 90-91, 97
removing 101
retrieving specific values and 92-93, 98
setting at run time 88
setting on Flash objects 138, 142
setting on merged columns 101
setting on summary tables 158
testing 91, 96

data formats. See formats

data groups. See groups

data points 104, 114, 118
See also charts

data range. See range of values

data rows
calculating running totals for 183

data rows. See rows

data series
See also charts
displaying multiple 112
drilling through 123, 125
overlapping multiple 108, 110
plotting data and 104, 118
showing open and close values 113
showing relationship to whole 111
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showing side-by-side comparisons of 104
stacking multiple 105, 108, 110

data sets 136, 201

data sources 4, 154

data type export options 42

data types 30,70

Date column format dialog 32

date formats 202

date values
adding days to 84, 161
adding months to 162
adding quarters to 163
adding time values to 162, 163
adding weeks to 164
adding years to 164
aggregating 70
as literals 84
calculating days between 167
calculating months between 168
calculating quarters between 169
calculating time values between 167, 168,

169

calculating weeks between 170
calculating years between 171
comparing 26, 94
exporting 42
formatting 32-34
grouping 64, 65
plotting 118, 122
restoring default formats for 37
returning current 178, 185
returning month for 177
returning quarter in 179
returning weekdays for 166, 187
returning weeks for 187
returning year for 188
showing changes over time 104
subtracting 84

date-and-time format symbols 33

date-and-time formats 32, 33

day formats 188

DAY function 166

days
adding to date values 84, 161
calculating number of 167
returning number in month 166
returning specific 187



debugging 140
default banner 218
default folders 14, 15
default locale 203
default security roles 196
default time zone 203
DEFAULT_COLUMN_PAGE_BREAK _
INTERVAL parameter 204
DEFAULT_LOCALE parameter 203
DEFAULT_PAGE_BREAK_INTERVAL
parameter 204
DEFAULT_ROW_PAGE_BREAK_
INTERVAL parameter 204
DEFAULT_TIMEZONE parameter 203
DEFAULT_WORKGROUP_
FUNCTIONALITY_ROLE parameter 196,
203
Delete Column command 198
delete file status page 215, 219
Delete Group command 198
deleting
aggregate data 70
blank characters 186
columns 59, 60, 157
files 219, 220
filter conditions 101
folders 220
formatting conditions 29
page breaks 74,75
text 38
delimiter characters 40
Design Engine API 204
design files 13, 88
designs 14, 201
detail areas (cross tabs) 147
detail data 71,72, 154
detail pages 215, 219
developers 126
deviation 115
DIFF_DAY function 83, 85, 167
DIFF_HOUR function 167
DIFF_MINUTE function 168
DIFF_MONTH function 168
DIFF_QUARTER function 169
DIFF_SECOND function 169
DIFF_WEEK function 170
DIFF_YEAR function 171

difference charts 115

See also charts
DIFFERENCE function 171
dimension columns 154, 158

See also summary tables
dimensions 146, 147

See also cross tabs
directories 14
directory paths. See file paths
Disable Interactivity command 6
displaying

AFP output 47

aggregate data 66,72, 146, 154

banners 218

calculated values 78, 160

charts 126

columns 60

cross tabs 146, 147

data 58, 60, 80, 104

detail data only 72

distinct values 204

duplicate values 72,73

error messages 221

Excel output 49

filter conditions 97

hidden values 73

legends 120

numeric values 29

PDF output 51

redraw regions 140

report elements 70

report parameters 226

reports 4,10

specific content 12, 88

specific page 10, 12,13

specific section 10

summary tables 154

table of contents 10, 64, 200

tables 126

tooltips 149, 150
distinct values 70, 189, 204
do directive 215
Do Not Repeat Values command 73, 200
.doc formats. See Word document formats
.docx formats. See Word document formats
document files 13, 220, 225
documentation ix
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documents 4, 15

See also reports
doughnut charts 128

See also Flash charts
downloading

binary files 212
DPI setting (charts) 44, 48
drilling actions

charts 123,125

cross tabs 146

Flash objects 138, 143
drop pages 215, 220
Duplex value 44
duplicate values

counting 70

hiding 72,73

summary tables and 155
dynamic data filters 88

E

Edit Computed Column command 81, 197
edit text icon 200
editable report items 38
editing. See changing
EditReport feature 198
e-mail 13
embedded fonts 52
emitters 40
empty values 93
Enable Interactivity command 6, 198, 203
Enable Pivot table option 49
Encoding Style option 41
Encyclopedia volumes 216
See also repositories
End Value property 136
Equal to operator 92,192
error detail page 219
error messages 221, 225
error page 215,221
errors 85, 140, 197
Excel emitters 40, 48
Excel formats
exporting charts and 127
exporting report content and 40, 43, 53
Excel spreadsheets 49, 203
exception stack trace 197
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executable files 225
executableName parameter 222
execute report page 215, 221
executing
Java servlets 212
Export Column Data Type option 42
Export Column Header option 43
Export Content command 45, 139, 144, 198
Export Content dialog
exporting to AFP formats 44, 45
exporting to Excel 49
exporting to PDF 51
exporting to PostScript 53
exporting to PowerPoint 54
exporting to Word 54
exporting to XHTML 55
Export Data command 127, 139, 144, 198
Export Data dialog 41
Export Locale Neutral Format option 42
EXPORT_AS_ATTACHMENT
parameter 203
ExportData feature 198
exporting
charts 45,127
data 40-43,127,139, 151
Flash objects 51, 139, 144
report content 40, 43, 55, 200
specific report pages 44, 47
ExportReport feature 198
expressions
adding literal values to 84
adding reserved characters to 85
aggregating data and 68, 70
calculating data values and 78, 81, 83, 160
changing 81
exporting data and 47
filtering data and 90, 96, 97, 191
formatting data and 25, 26, 27, 34, 191
returning unexpected values from 30
verifying data types in 30
verifying syntax of 81
extensible HTML formats 127

F

feature controls 196
Feature tag 197



FeatureConfiguration tag 197
FeatureControl tag 197
features 196, 197
field names 79, 85
fields
See also columns
building cross tabs and 146
creating expressions and 79, 85
displaying specific set of 88, 89
sorting data and 60, 61
testing for null values in 174
file cache 201
file names 14, 15
file or folder detail page 220
file paths 201, 204
files
accessing 224
archiving 201
changing location of 14, 15
deleting 219, 220
exporting and 40, 42, 43
filtering 225
getting information about 220
naming 15
saving cross tabs and 152
saving reports and 13
saving temporary 202
Filter command 198
filter conditions
adding 90
changing 100
deleting 101
displaying 97
grouping 98, 99
selecting multiple values for 92, 96, 97, 98
setting evaluation order for 99
Filter dialog box 91, 92, 101
filter expressions 191
Filter feature 198
filter parameter 225
filtering
data 88,101, 116, 138, 142, 158
report documents 225
report files 225
filters
adding conditions to. See filter conditions
applying to charts 117, 138, 142

comparing date values and 94
comparing string values and 93, 95
creating 90-91, 97
removing 101
retrieving distinct values and 204
retrieving specific values and 92-93, 98
setting at runtime 88
setting on Flash objects 138, 142
setting on merged columns 101
setting on summary tables 158
testing 91, 96
financial data 115
FIND function 171
Firefox browser 203
See also web browsers
FIRST function 189
Fixed format 31
Flash chart types 138, 143
Flash charts
changing subtype of 132
debugging 140
displaying data and 104, 127
drilling through 138, 143
exporting and 48, 51, 139, 144
filtering data for 138, 142
formatting 133
printing 51, 140
redrawing 140
setting visual effects for 140
Flash Gadget Type dialog 132
Flash gadget types 128
Flash gadgets
adding titles to 134
changing subtypes of 132
debugging 140
displaying data and 104, 127
exporting and 51, 139, 144
filtering data for 138, 142
formatting 133, 137
hiding values in 135
printing 51, 140
redrawing 140
setting color of 134
setting properties for 134-137
showing regions in 136
showing tick marks in 136, 137
Flash objects. See Flash charts; Flash gadgets
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Flash Player 140, 141

flat file formats 40

Flip Axis option 120

folder detail page 220

folder names 215

folder parameter 225

folders
accessing 224
browsing contents 219
changing default 14, 15
creating temporary files and 202, 204
deleting 220
getting information about 220
linking to 223

font attributes 21

Font command 21, 148

Font dialog 21, 148

font properties 21, 23, 148

Font property 134

font size 16, 117

font substitution 52

fonts 117, 156

footers 16, 68

Format Chart dialog 119, 120

Format command 198

Format Data command 30

Format feature 198

Format Flash Gadget command 137

format patterns 31, 33, 36

formats
copying 37
creating multiple rules for 29
defining custom 31, 33, 36
exporting charts and 127
exporting data and 40, 43, 127
printing reports and 16
removing conditions on 29
restoring default 37, 149
selecting standard 31, 32, 35
setting conditions for 23-29
setting locale for 202

formatting
aggregate data 157
Boolean values 34
charts 117,119, 121
cross tabs 147
data 20, 23, 30, 147, 156
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Flash charts 133

Flash gadgets 133, 137

text 20, 21, 35-36, 156
formatting options 24, 134, 148
formatting rules 24, 25, 28, 29
formulas. See expressions
forward button (web browser) 202
functionality roles 203
functions 70, 81, 160

G

gadgets. See Flash gadgets

gauges 112,129

General Date format 33

general formatting properties (gadgets) 134

General Number format 31

generating reports 203

graphs. See charts; Flash charts

grayscale images 45

Greater Than operator 92,192

Greater Than or Equal to operator 192

Group Details dialog 65

group footers 68

group headers 68, 72,73

group labels 38

GroupEdit feature 198

grouping
data 62-66, 154
filter conditions 98, 99

grouping intervals 64, 65

groups
aggregating data and 66, 67, 68
changing order of 65
collapsing and expanding 72
displaying data and 58, 62, 63, 154
formatting cross tabs and 148
hiding detail data in 71, 72, 154
hiding duplicate values in 72,73
selecting multiple columns and 65
setting page breaks for 74
sorting summary datain 157

H

Header command 38
headers
See also column headers



displaying aggregate data in 68
printing reports and 16
suppressing duplicate values and 72,73
headings. See column headings; row headings
Height property 134
help menu 200
Hide Column command 60, 157, 198
Hide Detail command 72, 198
Hide Detail Tooltip command 150
Hide or Show Items dialog 70
Hide/Show Item command 199
HideShowltems feature 199
hiding
chart items 121, 122
detail data 71, 72, 154
duplicate values 72,73
gadget region labels 136
gadget tick marks 137
gadget values 135
items in reports 60, 70
summary data 157
toolbars 200
high values (candlesticks) 113
Highlight feature 199
home folders 223
home page 216, 223
hours
adding to date values 162
calculating number of 167
HoverHighlight feature 199
HTML formats
exporting charts and 127
exporting reports and 16, 51
rendering to 201
hyperlinks 12, 13

IBirtViewerContext interface 206
IBirtViewerExtension interface 205
IBirtViewerOp interface 206
IBirtViewerSession interface 206
ID parameter 220

idle connections 201

IF function 83,172

image cache 203

image resolution 52

images 17, 45
IN function 173
In operator 192
index pages 224
Information Console
viewing reports and 200
input 11, 88
interactive features 4,7
Interactive Viewer 213
changing parameters and 89
changing reports and 7, 20
customizing charts and 104, 116, 152, 158
customizing Flash objects and 128
displaying cross tabs and 146, 147, 152
displaying reports and 4, 6, 58, 200
displaying summary tables and 154, 155,
156, 157
exporting data and 40, 43
filtering data and 88
formatting data and 31, 32, 35, 37
grouping data and 64
navigating through reports with 10
printing reports and 16
saving reports and 13, 202
setting gadget values and 136
tracking data and 78, 80
Interactive Viewer licenses 6
Interactive Viewer servlet
See also Interactive Viewer
Internet Explorer 203
See also web browsers
invokeSubmit parameter 222
Is False operator 192
Is Not Null operator 93, 192
Is Null operator 93, 192
Is True operator 192
ISNULL function 174
iv_config.xml 196, 197
IV_ENABLE_IV parameter 203

J

Jakarta Struts action mapping 215
JAR files 202

Java programming interfaces 204
Java Report Engine 203

Java servlets 212

Index 237



JAVA_REPORT_API_IMAGE_CACHE_
EXPIRATION parameter 203
JavaServer Pages. See JSPs
JDBC connection pool 201
jobs 226
JREM_TASK_QUEUE_SIZE parameter 203
JREM_THREAD_POOL_SIZE parameter 203
JREM_THREADPOOL_MAXSYNC_
TASKRUNTIME parameter 203
JREM_THREADPOOL_MONITORTHREAD
_ POLLINGINTERVAL parameter 204
JREM_THREADPOOL_SYNC_TASKQUEUE
_ TIMEOUT parameter 204
JSPs
mapping actions to 215
naming 215

L

Label property 136

labels
changing chart axes 121, 122
changing text in 38
deleting text in 38
formatting chart 117, 121
formatting text in 21, 156
hiding chart 122
selecting 20

LAST function 189

leading characters 186

LEFT function 174

legend titles 121

legends 119, 120, 123

LEN function 175

Less Than operator 92, 192

Less Than or Equal to operator 192

libraries 202

licenses 6

LIKE function 175

Like operator 192

line chart subtypes 110, 111

line charts 109
See also charts

linear gauge gadgets 129, 133
See also Flash gadgets

Link To This Page button 13

Link To This Page command 13, 199
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Link To This Page dialog 13

linking to folders 223

linking to reports 10, 13

links 218, 223
See also hyperlinks

LinkToThisPage feature 199

list pages 216, 224

lists 173,226

literal characters 95

literal values 26, 84

locale parameter 216

locales
creating computed columns and 84
exporting data and 42
filtering data and 94
formatting data and 31, 33, 202
setting default 203
specifying current 216

logical functions 82

logical operators 98

Long Date format 33

Long Time format 33

low values (candlesticks) 113

LOWER function 176

lowercase characters 35, 36, 176

Lowercase format 35

M

MainMenu feature 199
matching character patterns 95, 176, 184
math functions 82
mathematical operations 80, 83, 171, 178, 190
MAX function 70, 189
Maximum Value property 136
maximum values (charts) 122
maximum values (gadgets) 136
measure columns 154, 157

See also summary tables
measures 146, 147

See also cross tabs
MEDIAN function 189
Medium Date format 33
Medium Time format 33
memory 201
menus 7, 128, 196
merging columns 20



meter chart subtypes 112 Not Equal To operator 93, 192

meter charts 112, 118 Not In operator 192
See also charts Not Like operator 93,192

meter gadgets 128 Not operator 98
See also Flash gadgets NOTNULL function 178

MIN function 70, 189 NOW function 178

Minimum Value property 136 null values 93, 174

minimum values (charts) 122 Number column format dialog 31

minimum values (gadgets) 136 number data types 30

minutes number formats 29, 30, 31, 202
adding to date values 162 NUMBER_OF_FILTER_VALUES
calculating number of 168 parameter 204

MOD function 177 numeric values

MODE function 189 aggregating 70, 188

month formats 177 as literals 84

MONTH function 177 averaging 189

months calculating percentage of 160
adding to date values 162 calculating ratio for 180
calculating number of 168 calculating running totals for 183
returning 177 calculating square root of 185

Move To Group command 198 combining 114

Move to Group Header command 73 displaying 29

Move to Group Header dialog 73 filtering 93

multiple sort actions 61 formatting 30-31, 147

multiplication 178 grouping 64

My Folder link 223 multiplying 178

plotting 118, 122
N restoring default formats for 37, 149

returning absolute 161
Ezﬁien[;arameter 220,221 returning difference between 160, 171
computed columns 80 rounding 166, 181, 182, 183
JSPs 215 showing percentage to whole 106, 108, 111
showing relationship between 104

t files 15
report es showing totals for 105, 108, 110

naming restrictions 215

naming restrictions. See case sensitivity O

navigating tumbled documents 44

navigation options 10, 11, 12 objectID parameter 220
needle properties (gadgets) 135 online documentation ix
needles (gadgets) 135 online help. See online documentation
networks 204 onlyLatest parameter 225
New Computed Column command 80, 197 opening

No Condition operator 88 applications 203
NO-CACHE value 202 BIRT Viewer 5
non-null values 178 Data Analyzer 151
NO-STORE value 202 Interactive Viewer 6
Not Between operator 93, 192 reports 13
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opening (continued)
table of contents 10
opening values (charts) 113
opening values (gadgets) 135
operations. See actions
operators
comparing data and 26
filtering data and 88, 97, 98
listed 190, 191
setting parameter values and 90
OR operator 98, 191
orientation (gadgets) 134
Orientation property 134
output formats
exporting charts and 127
exporting reports and 40, 43
printing reports and 16
outputDocName parameter 222
overlay chart subtypes 108, 110
overwriting reports 14

P

Page Break command 74, 199
Page Break dialog 74, 75
page breaks 58, 74, 204
page footers 16
page headers 16
page names 215
page navigation 10
page navigation icons 199
page not found messages 224, 225
page not found page 216, 225
Page range option 44
page ranges 17, 44
PageBreak feature 199
PageNavigation feature 199
pagination 16, 58
See also page breaks
Parameter command 199
Parameter feature 199
parameters
adding to URIs 216
changing values for 89
configuring report viewers and 200
displaying 226
executing reports and 223
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prompting for 200

retrieving data and 11, 88

setting values for 89, 90
Parameters command 11, 89, 90
Parameters dialog box 89, 90
parameters list 226
parameters page 200, 216, 226
paths 201, 204

home folders 223
pattern matching 95, 176, 184
PDF emitters 40, 51
PDF formats

exporting and 43, 51, 127

printing reports and 16
PDF print options 16
PDF viewer plug-in 17
% OF DIFFERENCE function 160
% OF function 160
percent (%) character 95
Percent format 31
percent stacked chart subtypes 106, 108, 111,

116

percentages 83, 191

displaying calculated data and 160
performance 44, 154, 201
pie charts 111, 118, 128

See also charts
pipe-separated values files 40, 42
Plex Mode option 44
plot properties (gadgets) 135
Position Above property 137
Position Below property 137
Position Left property 137
Position property 137
PostScript emitters 53
PostScript formats 43, 53, 127
PowerPoint documents 203
PowerPoint formats 44, 54, 127
predefined formats. See standard formats
previewing

AFP output 45

charts 119

data 21,25

reports 17
Print command 16, 199
Print dialog box 16



Print feature 199
printing
cross tabs 152
Flash objects 51, 140
reports 16-17, 44, 200
specific range of pages 17
priority parameter 222
priorityValue parameter 222
PRIVATE value 202
PRODUCT function 178
programmers 126
progressive parameter 222
prompting for values 88
prompts 11, 88
properties
copying 23
exporting data and 40
formatting data and 21, 148
printing reports and 16
proxy servers 202, 204
PROXY_BASEURL parameter 204
ps formats. See PostScript formats
PSV files 40, 42
PUBLIC value 202
pyramid charts 106
See also charts

Q

QUARTER function 179
quarters 163,169, 179
QUARTILE function 189
question mark (?) character 184
queue 203

R

range of values 128, 129, 136, 165, 179
RANK function 179

RATIO function 180

redirect parameter 221

redraw regions (Flash objects) 140
region labels 136

region properties (gadgets) 136
Region property 136

regions (gadgets) 136

removing. See deleting

renaming files 15

rendering
charts 52
images 45
reports 201
Reorder Columns command 59, 66, 199
ReorderColumns feature 199
Repeat Values command 73, 200
repeated values. See duplicate values
__report parameter 213
report components. See report elements
report design files 13, 88
report designs 14, 201
report document files 13, 220, 225
report documents 4, 15
See also reports
report elements 4, 20, 40, 70
report emitters 40
report engine 203
report executable files 225
report files
See also specific type
accessing 224
archiving 201
changing location of 14, 15
deleting 219, 220
exporting and 40, 42, 43
filtering 225
getting information about 220
naming 15
saving cross tabs and 152
saving reports and 13
saving temporary 202
report parameters 11, 88, 226
See also parameters
report viewers 4, 8

See also BIRT Viewer; Interactive Viewer

reporting tasks 8

reports
adding data to 80
aggregating data and 66
changing 13, 20
customizing 6
displaying 4, 10
exporting 40, 43-55, 200
filtering 225
filtering data and 91
generating 203

Index
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reports (continued)
grouping data and 62, 63, 65, 71
hiding data in 71,72, 154
hiding items in 60, 70
limiting data in 88
linking to 10, 13
navigating through 10, 11, 12
opening 13
overwriting 14
previewing 17
printing 16-17, 44, 200
rendering 201
running 89, 221
saving 13
setting page breaks for 58, 74, 204
submitting requests for 221
viewing restrictions for 202
viewing structure of 10
viewing summary data and 154
repositories
accessing items in 224
getting information about 219
REPOSITORY_CACHE_TIMEOUT_SEC
parameter 204
repositoryType parameter
IV servlet 214
requests 203
submitting 221
reserved characters 85
reserved parameters 223
resetFilter parameter 225
resizing
charts 119
columns 58, 59
resources 201
result sets 201
return values 30, 83
RGB images 45
RIGHT function 180
right-click menus. See context menus
roles 196
rotating axis labels 122
ROUND function 181
ROUNDDOWN function 182
rounding 166, 181, 182, 183
ROUNDUP function 183
row areas (cross tabs) 147
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row headings 146
TOWs
aggregating data and 66, 67, 68, 69
binding to charts 201
calculating running totals for 183
counting 189
displaying specific set of 88,91, 92, 97
exporting specific 41
filtering empty or null values in 93
formatting merged columns in 21
grouping data and 63
hiding duplicate values in 72,73
returning first value in 189
returning last value in 189
returning most frequent value in 189
setting page breaks for 74, 204
showing quartile value for 189
viewing cross tabs and 146
rptdesign files. See report design files
rptdocument files. See report document files
rules. See formatting rules
running
Flash objects 140
Java servlets 212
reports 89,221
running totals 183
RUNNINGSUM function 183
run-time data filters 88

S

Save Design command 14, 199
Save dialog box 14, 15
Save Document command 15, 199
SaveDesign feature 199
SaveDocument feature 199
saving

cross tabs 152

report designs 14

report documents 15

reports 13

summary tables 158

temporary files 202
scalable vector graphics 52
scale properties (gadgets) 136
Scale to page size option 17
scaling axes values 122



scatter charts 114
See also charts
scientific data 113, 114
Scientific format 31
script libraries 202
ScrollControl feature 199
scrolling 49, 52, 199
SEARCH function 184
searching text strings 171, 184
seconds
adding to date values 163
calculating number of 169
security 203
security roles 196
Select Data Item dialog 20, 62, 70, 101
semicolon—separated values files 40, 42
series. See data series
Server Print command 199
ServerPrint feature 199
servers 154, 202, 204
extending functionality of 212
serverURL parameter 216, 222
IV servlet 214
servlets 212
Short Date format 33
Short Time format 33
Show Close Value property 135
Show Column command 60, 157
Show Columns command 198
Show Detail command 72, 198
Show Detail Tooltip command 149

Show High and Low Values property 135

Show Labels property 136
Show Legend option 120

Show Open Value property 135
Show Plot value property 135
Show Tick Marks property 137
Show Tick Values property 137
Show Value property 137
Show values property 135, 136
showDocument parameter 225
showExecutables parameter 225
showFolders parameter 225
side-by-side chart subtypes 104
Simplex value 44

single color images 45
skipping axis labels 122

Sort Ascending command 199
Sort Descending command 199
Sort feature 199
sort order 60, 61, 68
sorting data 60-62, 157
sparkline gadgets 131, 135
See also Flash gadgets
special characters. See characters
spreadsheets 49, 203
See also Excel formats
SORT function 185
square root 185
SSV files 40, 42
stack trace 197
stacked chart subtypes 105, 108, 110, 116
staggering axis labels 122
standard deviation 189
standard formats
date-and-time values 32
numeric values and 31
string data and 35
standard meter chart subtype 112
starting
BIRT Viewer 5
Interactive Viewer 6
startUpMessage parameter 224
static text 38
See also labels
statistical data 114
STDDEYV function 189
step values (charts) 122
stock chart subtypes 113
stock charts 113
See also charts
String column format dialog 35
string data types 29
string format symbols 36
string formats 35, 36
string patterns 95, 176, 184
string values 216
strings
aggregating data and 70
comparing substrings in 93, 95, 175
concatenating 83, 191
converting to lowercase 36, 176
converting to uppercase 36, 187
counting characters in 175

Index
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strings (continued)
finding substrings in 171, 184
formatting data and 20, 35
grouping data and 64
removing blank characters in 186
returning length of 175
returning substrings in 174, 180
Struts action mapping 215
subpage parameter 224
substrings
comparing 93, 95,175
extracting 174, 180
finding location of 171, 184
subtotals 155
subtraction 171
SUM function 70, 190
summary data 66, 104, 146, 154
See also aggregate data
calculating percentages of 160
summary reports 71,154
summary tables
adding computed columns to 158
changing 155
creating 154
customizing charts in 158
displaying data and 154
filtering data in 158
formatting data in 156
hiding columns in 157
moving columns in 157
organizing data in 157
saving 158
viewing data in 154
superimposed meter chart subtype 112
SuppressDuplicate feature 200
SVG images 52
Switch View command 126, 200
SwitchView feature 200
syntax errors 85

T

table of contents 10, 64, 200

table view 126

tables
See also summary tables
aggregating data and 66, 67, 68, 70
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changing columns in 7
changing font properties for 22
displaying 126
exporting 40, 48
formatting data in 20, 21
hiding columns in 60
moving columns in 59
removing aggregate data from 70
resizing columns in 58, 59
selecting columns in 20, 23
selecting report elements in 20
tab-separated values files 40, 42
TEMP_FOLDER_LOCATION parameter 204
temperature changes 113
template error pages 219
temporary files 202, 204
text
aligning 22, 23, 149, 156
changing 38
deleting 38
displaying as graphics charts 131
filtering 93, 95
formatting 20, 21, 35-36, 156
hiding 73
plotting 118
restoring alignment for 37, 149
restoring default formats for 37
setting font properties for 21, 148
text attributes 21, 25
text files 40, 42
text strings. See strings
Text wrapping option 49, 52
TextEdit feature 200
thermometer gadgets 130, 137
See also Flash gadgets
thread pool 203
3-D charts 116
tick marks (gadgets) 136, 137
tick properties (gadgets) 137
Tickmarks count property 137
time formats. See date-and-time formats
time values
adding to date values 162, 163
aggregating 70
calculating number of 167, 168, 169
exporting 42
formatting 32-34



grouping 64, 65
restoring default formats for 37
returning current 178, 185
time zones 203, 216
timezone parameter 216
Title property 134
TOC command 10, 200
Toc feature 200
TODAY function 185
Toolbar feature 200
ToolbarHelp feature 200
toolbars 7, 10, 196
Tooltip property 135
tooltips 135, 149
Top N operator 93, 158, 192
Top Percent operator 93, 192
Top/Bottom N command 93
Top/Bottom N dialog 93
Top/BottomN command 200
TopBottomNFilter feature 200
totals 183
See also summary data
returning percentage of 160
trace 197
trailing characters 186
transient files 202, 204
trends 114, 151
TRIM function 186
TRIMLEFT function 186
TRIMRIGHT function 186
truncated strings 216
TSV files 40, 42
tube charts 106
See also charts
Tumble value 44
types. See data types

U

underscore (_) character 95
Unformatted format option 37, 149
unique values 189
See also distinct values
UNSET value 202
unshared cache 202
uploading binary files 212
UPPER function 187

uppercase characters 35, 36, 187
Uppercase format 35
URIs
adding parameters to 216
overview 215
URIs reference 216
URLs 10, 12
user IDs 214
user roles 196, 203
userid parameter 214
users 4
accessing home page 223

V

value axis. See y-axis

value properties (gadgets) 137

value series 104, 118

values
See also data
averaging 189
calculating 66, 70, 78, 154
changing parameter 89
combining 114
comparing 26,92, 94, 115
counting 70, 189
determining deviation in 115
determining rank 179
determining standard deviation for 189
determining variance in 190
determining weighted average for 190
displaying highest or lowest 135, 136
displaying open or close 135
displaying range of 128, 129
displaying set of independent 128
displaying single 128
displaying top or bottom 93
excluding sets of 92, 98
filtering empty or blank 93
formatting Boolean 34
formatting on 23, 25, 26, 29
grouping data and 64
hiding duplicate 72, 73
multiplying 178
prompting for 11, 88
returning difference between 160, 171
returning from expressions 30, 83
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values (continued)
returning largest 189
returning median 189
returning most frequent 189
returning percentages for 160
returning ratio for 180
returning smallest 189
selecting 90, 92
setting at run time 89
showing changes over time 104, 107, 109
showing range of 136
showing relationship between 104, 151
showing relationship to whole 111
showing trends in 114, 151
testing for non-null 178
testing if null 174
testing range of 165
viewing numeric 29
variables 201
VARIANCE function 190
vector graphics 52
version parameter 220
Viewer 212
viewers 4,8
See also BIRT Viewer; Interactive Viewer
viewing
AFP output 47
aggregate data 66, 72, 146, 154
banners 218
calculated values 78, 160
charts 126
columns 60
cross tabs 146, 147
data 58, 60, 80, 104
detail data only 72
distinct values 204
duplicate values 72,73
error messages 221
Excel output 49
filter conditions 97
hidden values 73
legends 120
numeric values 29
PDF output 51
redraw regions 140
report elements 70
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report parameters 226

reports 4,10

specific content 12, 88

specific page 10, 12,13

specific section 10

summary tables 154

table of contents 10, 64, 200

tables 126

tooltips 149, 150
viewing environments 4
viewing parameters. See parameters
viewing restrictions 202
views, switching between 126
visual elements 128

See also Flash charts; Flash gadgets
volume parameter 216

IV servlet 214
VolumeProfile parameter 216

wW

wait parameter 222

web browsers
displaying reports and 12, 202
issuing URIs and 216
opening applications and 203
printing reports and 16, 17
rendering reports and 201
setting cache for 202

web pages
creating banners for 218

web sites 12

web.xml 200

WEEK function 187

weekday formats 188

WEEKDAY function 187

weekdays
adding to date values 84, 161
calculating number of 167
returning number in month 166
returning specific 187

weeks
adding to date values 164
calculating number of 170
returning 187

WEIGHTEDAVE function 190

Width property 135



Word document formats
exporting charts and 127
exporting reports and 43, 53

Word documents 203

workingFolder parameter 219

X

x-axis 118, 122

See also axes values
x-axis labels 121, 122
x-axis titles 121
XHTML formats 127
xls formats 43
xlsx formats 43

Y

y-axis 118,122
See also axes values

y-axis labels 122

y-axis titles 121

YEAR function 188

years
adding to date values 164
calculating number of 171
returning 188

Index
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